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Preface
Preface

This Preface provides supporting information for the Oracle Financial Services Analytical Applications Profitability Pack 
Installation Guide and includes the following topics:

 Summary

 Audience

 Documentation Accessibility

 Related Documents

 Conventions

Summary

You can find the latest copy of this document in OHC library which includes all the recent additions/revisions (if any) done 
till date.

Before you begin the installation, ensure that you have an access to the Oracle Support Portal with the required login 
credentials to quickly notify us of any issues at any stage. You can obtain the login credentials by contacting Oracle 
Support.

Audience

The Oracle Financial Services Analytical Applications (OFSAA) profitability pack Installation and Configuration Guide is 
intended for Administrators, Business User, Strategists, and Data Analyst, who are responsible for installing and 
maintaining the application pack components. 

The document assumes you have experience in installing Enterprise components. Basic knowledge about the OFSAA 
PROFITABILITY pack components, OFSAA Architecture, UNIX commands, Database concepts and Web Server/ Web 
Application Server is recommended.

Following are the expected preparations from the administrator before starting the actual installation:

 Awareness of the OFSAA Tier Architecture. For more information, see the Application Tiers section.

 Decision on the appropriate OFSAA Deployment Option. For more information, see the Recommended Deployment 
Options section.

Related Documents

This section identifies additional documents related to OFSAA Infrastructure. You can access Oracle documentation online 
from Documentation Library (OHC).

 Oracle Financial Services Funds Transfer Pricing Management User Guide

 Oracle Financial Services Profitability Management User Guide

 Oracle Financial Services Enterprise Financial Performance Analytics User Guide

 Oracle Financial Services Institutional Performance Analytics User Guide

 Oracle Financial Services Retail Performance Analytics User Guide
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Conventions and Acronyms

Conventions Description

AIX Advanced Interactive executive

DEFQ Data Entry Forms and Queries

DML Data Manipulation Language

EAR Enterprise Archive

EJB Enterprise JavaBean

ERM Enterprise Resource Management

FTP File Transfer Protocol

GUI Graphical User Interface

HTTPS Hypertext Transfer Protocol Secure

J2C J2EE Connector

J2EE Java 2 Enterprise Edition

JDBC Java Database Connectivity

JDK Java Development Kit

JNDI Java Naming and Directory Interface

JRE Java Runtime Environment

JVM Java Virtual Machine
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About Oracle Financial Services Analytical Applications (OFSAA)
Chapter 1—About OFSAA and OFSAA Application Packs
CHAPTER 1 About OFSAA and OFSAA 
Application Packs

This chapter includes the following topics:

 About Oracle Financial Services Analytical Applications (OFSAA)

 About Oracle Financial Services Analytical Applications (OFSAA) Pack

 About Oracle Financial Services Profitability 8.0.5.0.0 Applications Pack

 About Oracle Financial Services Analytical Applications Infrastructure (OFS AAI)

About Oracle Financial Services Analytical Applications (OFSAA)

In today's turbulent markets, financial institutions require a better understanding of their risk-return, while strengthening 
competitive advantage and enhancing long-term customer value. Oracle Financial Services Analytical Applications 
(OFSAA) enable financial institutions to measure and meet risk adjusted performance objectives, cultivate a risk manage-
ment culture through transparency, lower the costs of compliance and regulation, and improve insight into customer 
behavior. 

OFSAA uses industry-leading analytical methods, shared data model and applications architecture to enable integrated 
risk management, performance management, customer insight, and compliance management. OFSAA actively incorpo-
rates risk into decision making, enables to achieve a consistent view of performance, promote a transparent risk manage-
ment culture, and provide pervasive intelligence.

Oracle Financial Services Analytical Applications delivers a comprehensive, integrated suite of financial services analytical 
applications for both banking and insurance domain.

About Oracle Financial Services Analytical Applications (OFSAA) Pack

OFSAA applications are packaged, and released as Application Packs starting from 8.0 release. An Application Pack is a 
group of OFSAA products packaged together in a single installer and addresses specific functional area via its products that 
are grouped together. Packaging applications in a group ensures simplified installation, maintenance, development and 
integration in an integrated deployment.

The following figure depicts the various application packs that are available across the OFSAA Banking and Insurance 
domains:
Oracle Financial Services Profitability Management Application Pack Installation Guide 3



About Oracle Financial Services Profitability 8.0.5.0.0 Applications Pack
Chapter 1—About OFSAA and OFSAA Application Packs
About Oracle Financial Services Profitability 8.0.5.0.0 Applications Pack

OFS Profitability 8.0.5.0.0 Pack includes the following applications:

 Oracle Financial Services Analytical Applications Infrastructure: Oracle Financial Services Analytical Applications 
Infrastructure (OFS AAI) powers the Oracle Financial Services Analytical Applications family of products to perform the 
processing, categorizing, selection and manipulation of data and information needed to analyze, understand and 
report on specific performance, risk, compliance and customer insight issues by providing a strong foundation for the 
entire family of Oracle Financial Services Analytical Applications across the domains of Risk, Performance, Compliance 
and Customer Insight.
4 Oracle Financial Services Profitability Management Application Pack Installation Guide



About Oracle Financial Services Analytical Applications Infrastructure (OFS AAI)
Chapter 1—About OFSAA and OFSAA Application Packs
 Oracle Financial Services Funds Transfer Pricing Management: It enables the bank to apply various transfer pricing 
methods on products to calculate funds transfer price. It calculates transfer price across all product types varying in 
terms of characteristics like fixed rate or floating rate instruments, bullet or amortizing or fixed tenor or perpetual 
instruments. In addition it also supports the calculation of transfer price at account level or ledger level including 
migration of charge or credit to ledger if required. 

 Oracle Financial Services Profitability Management: It helps Banks and Financial services institutions manage and 
monitor interest rate risk, liquidity risk, foreign currency risk and earnings risk. The application models every loan, 
deposit, investment portfolio individually to help institutions better understand the risks they have assumed and their 
sensitivity to economic conditions.

 Oracle Financial Services Enterprise Financial Performance Analytics: It is based upon a dedicated reporting mart 
built on the new Financial Services Data Model. OFSEFPA leverages several components of OBIEE technology 
including Dashboards and Answers. It includes various Dashboards and Reports for the user to carry out various 
Profitability Management based analytics.

 Oracle Financial Services Institutional Performance Analytics: It provides strategic insights on - Profitability of the 
business and the underlying customers, Product holdings and Relationship depth across the organization, Behavioral 
and Engagement trends of it's target segments - exposures, commitments, line utilization, assets/liabilities, deposits, 
withdrawals, Fees, Income, recent transactions and so on, Efficiency of investments (like marketing, partner 
development), Efficiency of the sales force in terms of ongoing customer revenue generation, cross-sell and up-sell, 
product usage and pipeline.

 Oracle Financial Services Retail Performance Analytics: It focuses on Summary performance of the LOBs and overall 
profitability, Portfolio mix, LOB specific profitability reports to be analyzed against key dimensions like customer 
segments, product family, region, branch, risk scores and so on, Product holdings and Relationship depth across the 
LOBs, Customer Trends across performance drivers like Sales, Balances, Deposits, Product subscriptions (revenue 
services), Credit scores and delinquency bands, losses, and so on, Wallet Share analysis and customer lifetime value, 
Efficiency of investments (like marketing, branch, channel and so on) over time.

About Oracle Financial Services Analytical Applications Infrastructure 
(OFS AAI)

Oracle Financial Services Analytical Applications Infrastructure (OFS AAI) powers the Oracle Financial Services Analytical 
Applications family of products to perform the processing, categorizing, selection and manipulation of data and 
information needed to analyze, understand and report on specific performance, risk, compliance and customer insight 
issues by providing a strong foundation for the entire family of Oracle Financial Services Analytical Applications across the 
domains of Risk, Performance, Compliance and Customer Insight.

Components of OFSAAI

The OFSAA Infrastructure is comprised of a set of frameworks that operates on and with the Oracle Financial Services 
Analytical Applications Data Model and form the array of components within the Infrastructure.

The OFSAA Infrastructure components/ frameworks are installed in two layers; primarily the Metadata server and 
Infrastructure services run on one layer, and the UI and presentation logic runs on the other. The UI and presentation layer 
is deployed on any of the supported J2EE Servers.

The following figure depicts the various frameworks and capabilities that make up the OFSAA Infrastructure:
Oracle Financial Services Profitability Management Application Pack Installation Guide 5



About Oracle Financial Services Analytical Applications Infrastructure (OFS AAI)
Chapter 1—About OFSAA and OFSAA Application Packs
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About Oracle Financial Services Analytical Applications Infrastructure (OFS AAI)
Chapter 1—About OFSAA and OFSAA Application Packs
OFSAA Infrastructure High Availability

The current release of the OFSAA Infrastructure supports only "Single Instance" installation for the Infrastructure 
components. However, the High Availability (HA) for the Database Server and/ or the Web Application Server clustering 
and deployment are supported in this release.

This release supports Active-Passive model of implementation for OFSAAI components. For more information, see 
Configuration for High Availability- Best Practices Guide.
Oracle Financial Services Profitability Management Application Pack Installation Guide 7

http://docs.oracle.com/cd/E61555_01/books/Configuration%20for%20High%20Availability%20%28HA%29%20Best%20Practices%20Guide.pdf


About Oracle Financial Services Analytical Applications Infrastructure (OFS AAI)
Chapter 1—About OFSAA and OFSAA Application Packs
8 Oracle Financial Services Profitability Management Application Pack Installation Guide



Installation Overview
Chapter 2—Understanding OFS Profitability Application Pack Installations
CHAPTER 2 Understanding OFS Profitability 
Application Pack Installations

This chapter includes the following topics:

 Installation Overview

 Hardware and Software Requirements

 Verifying the System Environment

 Understanding Installation Modes

Installation Overview

This release (8.0.5.0.0) of the OFS Profitability Application Pack bundles the upgrade patch set along with the base 
installer. Users/ Administrators who wish to install a new OFS Profitability Application Pack 8.0.5.0.0 instance or upgrade 
an existing OFS Profitability Application Pack 8.0.x instance to 8.0.5.0.0 should download this installer. Figure 1 shows the 
order of procedures you will need to follow to install a new OFS Profitability Pack 8.0.5.0.0 instance. For upgrading a 
current OFS Profitability Application Pack 8.0.x instance to 8.0.5.0.0 release, see Upgrading to OFS Profitability Application 
Pack 8.0.5.0.0.

This section gives an overview of the OFS Profitability Applications Pack Installation. The following figure shows the order 
of procedures you need to follow:
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The following table describes the tasks and their descriptions:

Tasks Details and Documentation

Verify Systems Environment To verify that your system meets the minimum necessary requirements for installing and 
hosting the OFS Profitability Application Pack, see Verifying the System Environment.

Obtain the software To access and download the OFS Profitability Application Pack, see Obtaining the Software.

Configure and Execute the Schema 
Creator Utility

For instructions on creating the database schemas, see Configuring and Executing the 
Schema Creator Utility.

Install OFS Profitability Application 
Pack

For instructions on Installing OFS Profitability Application Pack, see Installing the OFS 
Profitability Applications Pack.

Configure OFS Profitability Setup See Post Installation Configuration.
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Hardware and Software Requirements
Chapter 2—Understanding OFS Profitability Application Pack Installations
Upgrading to OFS Profitability Application Pack 8.0.5.0.0

To upgrade the current OFS Profitability Application Pack 8.0.x instance to 8.0.5.0.0, follow these steps:

1. See the sections Downloading and Copying the OFS Profitability Applications Pack Installer and Copying and 
Extracting the Software.

1. See Upgrading the OFS PFT Application Pack for detailed instructions.

Deployment Topology

The following figure depicts the typical deployment topology implemented for OFSAA Applications.

Hardware and Software Requirements

This section describes the various Operating Systems, Database, Web Server, and Web Application Server versions, and 
other variant details on which this release of the Oracle Financial Services Profitability Application Pack has been qualified. 

Note: OFS Profitability Application Pack installation can be performed on both Virtual and Physical servers.
Oracle Financial Services Profitability Management Application Pack Installation Guide 11



Hardware and Software Requirements
Chapter 2—Understanding OFS Profitability Application Pack Installations
Configurations Supported for Java 7

The following table shows the minimum hardware and software requirements for installing OFS Profitability Application 
Pack (for Java 7).

Requirement Sub-Category Value

Operating System Oracle Linux / Red Hat Enterprise Linux (x86-64) Red Hat Enterprise Linux or Oracle Linux Server 
release 6 update 6 to latest update version

Red Hat Enterprise Linux or Oracle Linux Server 
release 7 update 1 to latest update version

Oracle Solaris (SPARC)/ Solaris x86 Oracle Solaris v5.10 Update 11 and above - 64 bit

Oracle Solaris v5.11 update 1 and above - 64 bit

IBM AIX (PowerPC) AIX 6.1 (TL 09 and above) - 64 bit 

Shell KORN Shell (KSH)

Note:

 If the OS is IBM AIX 6.1 and the file size limit for the AIX user on the target server is too small, configure 
the size parameter setting for "Large File Support". Follow these steps:

Change the file size limit for the user that initiates the transfer on the AIX system. To change the file 
size limit for a particular user, add or edit the fsize attribute for the user in the /etc/security/limits file 
on the AIX system. Change the file size limit to unlimited (fsize = -1) or to a size equal to the size of the 
file being transferred. This may require an restart of the AIX server to pick up the new configuration. 
For more information, see IBM Support.

 If the operating system is RHEL, install the package lsb_release using one of the following commands 
by logging in as root user:

 yum install redhat-lsb-core

 yum install redhat-lsb

The above is required as during the installation process, the following command is executed to get the 
OS version and release:
lsb_release -r

 To install this release on Oracle Solaris OS, refer to the following list for version specific information:

 "Solaris 11 - Upgrade to Oracle Solaris 11.3 with SRU09 or higher. See 
https://docs.oracle.com/cd/E60778_01/html/E60743/gouaw.html#scrolltoc to upgrade to SRU09 
if you have a lower SRU version. Additionally, install the required runtime libraries. For more 
information, see Installing Only the Runtime Libraries on Oracle Solaris 11. 

 "Solaris 10 - Install the required OS patches. For more information, see Installing the Required 
Oracle Solaris 10 Patches. Additionally, install the required runtime libraries. For more information, 
see Installing Only the Runtime Libraries on Oracle Solaris 10.

Note: In an OFSAA instance where multiple OFSAA application packs have been installed/ 
deployed, it is mandatory to upgrade all OFSAA application packs to 8.0.4.0.0 release. You should 
start the upgrade of OFS AAAI<<your pack name>>pack, only after confirming that all of the 
application packs in your OFSAA instance are available for upgrade to 8.0.4.0.0 version. For 
information on availability of the required OFSAA Application Packs, see 2246606.1.

Based on the returned information, the installer copies the appropriate binary and library files into the 
$FIC_DB_HOME/bin and $FIC_DB_HOME/lib folders.

Java Runtime 
Environment

Oracle Linux / Red Hat Enterprise Linux Oracle Java Runtime Environment (JRE) 1.7.x - 64 bit

IBM AIX IBM AIX Runtime, Java Technology JRE 1.7.x - 64 bit
12 Oracle Financial Services Profitability Management Application Pack Installation Guide

https://docs.oracle.com/cd/E60778_01/html/E60743/gouaw.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gozsu.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gimhj.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gimhj.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gouag.html#scrolltoc
https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=358225944000074&id=2246606.1&_afrWindowMode=0&_adf.ctrl-state=8bk9kg1zo_4


Hardware and Software Requirements
Chapter 2—Understanding OFS Profitability Application Pack Installations
Oracle Database 
Server and Client

Oracle Database Server Enterprise Edition 11g 
Release 2 (11.2.0.3.0 +) - 64 bit RAC/ Non-RAC with/ 
without partitioning option

Oracle Database Server Enterprise Edition 12c 
Release 1 (12.1.0.1.0 +)- 64 bit RAC/ Non-RAC with/ 
without partitioning option

Oracle Client 11g Enterprise Edition Release 2 
(11.2.0.3.0+) - 64 bit 

Oracle Client 12c Enterprise Edition Release 1 
(12.1.0.1.0+) - 64 bit

Oracle 11g Enterprise Edition Release 2 (11.2.0.3+) 
JDBC driver (Oracle thin driver)

Oracle 12C Enterprise Edition Release 1 (12.1.0.1+) 
JDBC driver (Oracle thin driver)

Oracle Distribution of R version 3.0.1 (Optional)

Oracle R Enterprise (Server) version 1.4. (Optional)

Note: Ensure that the following patches are applied:

 Oracle Server 12c, v12.1.0.1 - 17082699

 Oracle Server 12c, v12.1.0.2 - 19392604, 19649591

 Also for latest information, see http://support.oracle.com, 12.1.0.2 Bundle Patches for Engineered 
Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1)

 Oracle R Enterprise 1.4 requires Oracle Database Enterprise Edition 11.2.0.3/ 11.2.0.4/ 12.1.0.1.

In Oracle release 12.2, the default value for the SQLNET.ALLOWED_LOGON_VERSION_SERVER parameter is 
"12", i.e. Exclusive Mode. It is recommended to set this parameter as described below. This will relax the 
SQLNET.ALLOWED_LOGON_VERSION_SERVER setting in the sqlnet.ora file to a more permissive 
setting.

Set the following parameters as below:

SQLNET.ALLOWED_LOGON_VERSION_CLIENT = 8

SQLNET.ALLOWED_LOGON_VERSION_SERVER = 8

OLAP Oracle Hyperion Essbase V 11.1.2.1+ (Server and Client) with Oracle 11g 
Database

V 11.1.2.3+ (Server and Client) with Oracle 12c 
Database

Oracle OLAP V 11.2.0.3+ with Oracle 11g Database

V 12.1.0.1+ with Oracle 12c Database

Note:

Oracle Hyperion Essbase & Oracle OLAP is required only if you are using the OLAP feature of OFSAAI. For 
Oracle OLAP, ensure that you have configured the Oracle Database server with OLAP option.

Requirement Sub-Category Value
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Web Server/ Web 
Application Server

Oracle Linux / Red Hat Enterprise Linux 

Oracle Solaris

IBM AIX

Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 
2.2.x/ IBM HTTP Server

Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 
2.2.x/ IBM HTTP Server

 Oracle Weblogic Server 12.1.3+ with jersey 
1.18

 Oracle Weblogic Server 12.2.x (8) with jersey 
2.25

 IBM WebSphere Application Server 
WebSphere 8.5.5.9+

 Apache Tomcat 8.0.46 (64 bit)

Note: Apply the mandatory patch 26803128 for 
Tomcat versions above 8.0.32.

Note:

OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle JRockit is not 
supported.

Desktop 
Requirements

Browser MS Internet Explorer 9, 10 and 11

Oracle Java plug-in 1.7.0+* (64- bit) /Oracle Java 
plug-in 1.8.0+ (64- bit)

Turn off Pop-up blocker settings. For more 
information, see Internet Explorer Settings.

Office Tools MS Office 2007/ 2010/2013

Adobe Acrobat Reader 8 and above

Screen Resolution 1024*768 or 1280*1024

Other Softwares Directory Services OFSAAI is qualified on both OPEN LDAP 2.2.29+ and 
Oracle Internet Directory v 11.1.1.3.0. However, it 
can be integrated with other directory services 
software like MS Active Directory.

Note:

Configuration of Directory services software for OFSAAI installation is optional. For more information on 
configuration, see Infrastructure LDAP Configuration. Open LDAP needs to be installed on MS Windows 
Server machine only.

Requirement Sub-Category Value
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Configurations Supported for Java 8

The following table shows the minimum hardware and software requirements for installing OFS PFT Application Pack (for 
Java 8).

Requirement Sub-Category Value

Operating System Oracle Linux / Red Hat Enterprise Linux (x86-64) Red Hat Enterprise Linux or Oracle Linux Server 
release 6 update 6 to latest update version

Red Hat Enterprise Linux or Oracle Linux Server 
release 7 update 1 to latest update version

Oracle Solaris (SPARC)/ Solaris x86 Oracle Solaris v5.10 Update 11 and above - 64 bit

Oracle Solaris v5.11 update 1 and above - 64 bit

IBM AIX (PowerPC) AIX 6.1 (TL 09 and above) - 64 bit 

Shell KORN Shell (KSH)

Note:

 If the OS is IBM AIX 6.1 and the file size limit for the AIX user on the target server is too small, configure 
the size parameter setting for "Large File Support". Follow these steps:

Change the file size limit for the user that initiates the transfer on the AIX system. To change the file 
size limit for a particular user, add or edit the fsize attribute for the user in the /etc/security/limits file 
on the AIX system. Change the file size limit to unlimited (fsize = -1) or to a size equal to the size of the 
file being transferred. This may require an restart of the AIX server to pick up the new configuration. 
For more information, see IBM Support.

 If the operating system is RHEL, install the package lsb_release using one of the following commands 
by logging in as root user:

 yum install redhat-lsb-core

 yum install redhat-lsb

The above is required as during the installation process, the following command is executed to get the 
OS version and release: 
lsb_release -r 

 To install this release on Oracle Solaris OS, refer to the following list for version specific information:

 "Solaris 11 - Upgrade to Oracle Solaris 11.3 with SRU09 or higher. See 
https://docs.oracle.com/cd/E60778_01/html/E60743/gouaw.html#scrolltoc to upgrade to SRU09 
if you have a lower SRU version. Additionally, install the required runtime libraries. For more 
information, see Installing Only the Runtime Libraries on Oracle Solaris 11. 

 "Solaris 10 - Install the required OS patches. For more information, see Installing the Required 
Oracle Solaris 10 Patches. Additionally, install the required runtime libraries. For more information, 
see Installing Only the Runtime Libraries on Oracle Solaris 10.

Note: In an OFSAA instance where multiple OFSAA application packs have been installed/ 
deployed, it is mandatory to upgrade all OFSAA application packs to 8.0.4.0.0 release. You should 
start the upgrade of OFS AAAI<<your pack name>>pack, only after confirming that all of the 
application packs in your OFSAA instance are available for upgrade to 8.0.4.0.0 version. For 
information on availability of the required OFSAA Application Packs, see 2246606.1.

Based on the returned information, the installer copies the appropriate binary and library files into the 
$FIC_DB_HOME/bin and $FIC_DB_HOME/lib folders.

Java Runtime 
Environment

Oracle Linux / Red Hat Enterprise Linux//IBM AIX/

Oracle Solaris

Oracle Java Runtime Environment (JRE) 1.8.x - 64 bit

IBM AIX IBM AIX Runtime, Java Technology JRE 1.8.x - 64 bit
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Oracle Database 
Server and Client

Oracle Database Server Enterprise Edition 11g 
Release 2 (11.2.0.3.0 +) - 64 bit RAC/ Non-RAC with/ 
without partitioning option

Oracle Database Server Enterprise Edition 12c 
Release 1 (12.1.0.1.0 +)- 64 bit RAC/ Non-RAC with/ 
without partitioning option

Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit

Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit

Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle 
thin driver)

Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle 
thin driver)

 Oracle Distribution of R version 2.15.1, 2.15.2 or 
2.15.3.(Optional)

Oracle R Enterprise (Server) version 1.4. (Optional)

Note: Ensure that the following patches are applied:

 Oracle Server 12c, v12.1.0.1 - 17082699

 Oracle Server 12c, v12.1.0.2 - 19392604, 19649591

 Also for latest information, see http://support.oracle.com, 12.1.0.2 Bundle Patches for Engineered 
Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1)

 Oracle R Enterprise 1.4 requires Oracle Database Enterprise Edition 11.2.0.3/ 11.2.0.4/ 12.1.0.1.

In Oracle release 12.2, the default value for the SQLNET.ALLOWED_LOGON_VERSION_SERVER parameter is 
"12", i.e. Exclusive Mode. It is recommended to set this parameter as described below. This will relax the 
SQLNET.ALLOWED_LOGON_VERSION_SERVER setting in the sqlnet.ora file to a more permissive 
setting.

Set the following parameters as below:

SQLNET.ALLOWED_LOGON_VERSION_CLIENT = 8

SQLNET.ALLOWED_LOGON_VERSION_SERVER = 8

OLAP Oracle Hyperion Essbase V 11.1.2.1+ (Server and Client) with Oracle 11g 
Database

V 11.1.2.3+ (Server and Client) with Oracle 12c 
Database

Oracle OLAP V 11.2.0.3+ with Oracle 11g Database

V 12.1.0.1+ with Oracle 12c Database

Note:

Oracle Hyperion Essbase & Oracle OLAP is required only if you are using the OLAP feature of OFSAAI. For 
Oracle OLAP, ensure that you have configured the Oracle Database server with OLAP option.

Web Server/ Web 
Application Server

Oracle Linux / Red Hat Enterprise Linux /IBM AIX

Oracle Solaris

Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 
2.2.x/ IBM HTTP Server

Requirement Sub-Category Value
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Note: To upgrade an existing OFSAA 8.0.x Java 7 instance to Java 8, see Upgrading an Existing OFSAA 8.0.x 
Java 7 Instance to Java 8.

Server Oracle 11g and 12c Database:

 Oracle WebLogic Server 12.1.3+ (64 bit)

 Apache Tomcat 8.0.46 (64 bit)

Note: Apply the mandatory patch 26803128 for 
Tomcat versions above 8.0.32.

Note:

OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle JRockit is not 
supported.

For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download and install patch 
18729264 from http://support.oracle.com.

Desktop 
Requirements

Operating System MS Windows 7/ Windows 8/ Windows 8.1

Browser MS Internet Explorer 9, 10 and 11

Oracle Java plug-in 1.7.0+* (64- bit)

Turn off Pop-up blocker settings. For more 
information, see Internet Explorer Settings.

Office Tools MS Office 2007/ 2010/2013

Adobe Acrobat Reader 8 and above

Screen Resolution 1024*768 or 1280*1024

Other Software Directory Services OFSAAI is qualified on both OPEN LDAP 2.2.29+ and 
Oracle Internet Directory v 11.1.1.3.0. However, it 
can be integrated with other directory services 
software like MS Active Directory.

Note:

Configuration of Directory services software for OFSAAI installation is optional. For more information on 
configuration, see Infrastructure LDAP Configuration. 

Open LDAP needs to be installed on MS Windows Server machine only.

Requirement Sub-Category Value
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OFS PFT Application Pack recommends the following software combinations for deployment:

Operating System Database
Web Application 
Server Web Server R

Red Hat Enterprise 
Linux or Oracle Linux 
Server release 6 update 
6 to latest update 
version

Red Hat Enterprise 
Linux or Oracle Linux 
Server release 7 update 
1 to latest update 
version

Oracle Database Oracle WebLogic 
Server/ Apache Tomcat 
Server

Oracle HTTP Server/ 
Apache HTTP Server

3.0.1

Oracle Solaris 5.10/ 
5.11

Oracle Database Oracle WebLogic 
Server/ Apache Tomcat 
Server

Oracle HTTP Server/ 
Apache HTTP Server

3.0.1

IBM AIX 6.1 Oracle Database IBM WebSphere 
Application Server/ 
Apache Tomcat Server

IBM HTTP Server/ 
Apache HTTP Server

3.0.1

Verifying the System Environment

To verify if your system environment meets the minimum requirements for the installation, a Pre-Install Check utility 
(Environment Check) is available within the Install Kit archive file. This utility can also be obtained separately by contacting 
Oracle Support.

Though the system environment verification is an integral and automated part of the installation of this software product, 
Oracle strongly recommends running this utility prior to beginning the installation as part of your organization's 
"Installation Readiness Verification Process".

Note: For more details on download and usage of this utility, see Oracle Financial Services Analytical 
Applications Infrastructure Environment Check Utility Guide given in the Related Documents section.

Understanding Installation Modes

The following modes of installation are available for the OFS Profitability Application Pack.

GUI Mode

This mode launches the product installation in a Graphical User Interface (GUI) Mode. You need to enter the required 
information on various panels within the UI in a user interaction format at various stages.

Note: See GUI Mode Installation for details on configuration required for GUI Mode installation.
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SILENT Mode

This mode mandates updating the installation configuration files with required details and performs installation in a 
"SILENT" non user interactive format.

Note: See SILENT Mode Installation for details on configuration required for SILENT Mode installation.
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CHAPTER 3 Preparing for Installation

This chapter provides necessary information to review before installing the OFS Profitability Pack v8.0.5.0.0. 

This chapter includes the following topics:

 Installer and Installation Prerequisites

 Obtaining the Software

 Common Installation Tasks

Installer and Installation Prerequisites

The following table mentions the list of prerequisites required before beginning the installation for OFS Profitability 
Application Pack. The Installer/ Environment Check utility notifies you if any requirements are not met.

Requirement Sub-Category Expected Value

Environment Settings Java Settings PATH in .profile to be set to include the Java Runtime Environment 
absolute path. The path should include Java version (Java 6, Java 7 or 
Java 8) based on the configuration.

Note: Ensure the absolute path to JRE/bin is set at the beginning of PATH 
variable.

For example, PATH=/usr/java/jre1.6/bin:$ORACLE_HOME/bin:$PATH

Ensure no SYMBOLIC links to JAVA installation is being set in the PATH 
variable.

Oracle Database Settings TNS_ADMIN to be set in .profile pointing to appropriate 
tnsnames.ora file

ORACLE_HOME to be set in .profile pointing to appropriate Oracle 
Client installation

PATH in .profile to be set to include appropriate 
$ORACLE_HOME/bin path.

Ensure to add an entry (with SID/ SERVICE NAME) in the 
tnsnames.ora file on the OFSAA server.

Oracle Essbase Settings ARBORPATH, ESSBASEPATH, HYPERION_HOME to be set in the .profile 
pointing to an appropriate Oracle Essbase Client installation.

Note: These settings are required only if you want to use Oracle 
Hyperion Essbase OLAP features.
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OS/ File System Settings File Descriptor Settings Greater than 15000

Total Number of Process 
Settings

Greater than 4096

Port Settings Default port numbers to be enabled on the system are 6500, 6501, 6505, 
6507, 6509, 6510, 6666, 9999, and 10101.

.profile permissions User to have 755 permission on the .profile file.

Installation Directory A directory where the product files will be installed/ copied.

Set 755 permission on this directory. 

This directory needs to be set as FIC_HOME.

Staging Area/ Metadata 
Repository 

A directory to hold the application Metadata artifacts and additionally 
act as staging area for flat files. 

The directory should exist on the same system as the OFSAA Installation. 
This directory can be configured on different mount or under a different 
user profile.

Set 775 permission on this directory.

Download Directory A directory where the product installer files will be downloaded/ copied.

Set 755 permission on this directory.

OS Locale  Linux: en_US.utf8

 AIX: EN_US.UTF-8

 Solaris: en_US.UTF-8

To check the locale installed, execute the following command:

locale -a | grep -i 'en_US.utf'

Database Settings Database Instance 
Settings

NLS_CHARACTERSET to be AL32UTF8

NLS_LENGTH_SEMANTICS to be BYTE

OPEN CURSORS limit to be greater than 1000

Web Application Server WebSphere/ WebLogic/ 
Tomcat

Web Application Server should be installed and profile /domain created.

You will be prompted to enter the WebSphere Profile path or WebLogic 
Domain path or Tomcat Deployment path during OFSAAI installation.

Note: See Configuring Web Server for WebSphere Profile Creation and 
WebLogic Domain Creation.

For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, 
download and install patch 18729264 from 

http://support.oracle.com.

Web Server Apache HTTP Server/ 

Oracle HTTP Server/

IBM HTTP Server

This is an optional requirement.

HTTP Server Installation to be present. 

You will be required to enter the Web Server IP/ Hostname and Port 
details during installation.

Note: See Configuring Web Server for Web Server configuration.

Requirement Sub-Category Expected Value
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Note: Ensure that the tablespace(s) used for the database user(s) is set to AUTOEXTEND ON.

Obtaining the Software

This release of OFS Profitability Application Pack v8.0.5.0.0 is available for download in MOS as Patch 26744949. You need 
to have a valid Oracle account in order to download the software.

Common Installation Tasks

The following are the common pre-installation activities that you need to carry out before installing the OFS Profitability 
Application Pack.

This section includes the following topics:

 Configuration for GUI Mode Installation

 Identifying the Installation, Download and Metadata Repository Directories

 Downloading and Copying the OFS Profitability Applications Pack Installer

 Copying and Extracting the Software

 Setting up the Web Server/ Web Application Server

 Installation of Oracle R Distribution

Configuration for GUI Mode Installation

To install OFS Profitability Application Pack in GUI mode, you need to ensure the below software and configurations are 
available:

 Install and configure any PC X Server software such as Open Text Exceed (formerly Hummingbird Exceed) on the user 
desktop system from which the installation is triggered.

 Configure DISPLAY variable.

 Ensure to set the DISPLAY variable on the system on which the OFSAA will be installed, to point to the user desktop 
system where the PC X Server software has been installed.

Syntax:

export DISPLAY=hostname:n.n1 

where hostname is the IP Address/ Host Name of the user desktop system and n is the sequence number (usually 0).

For example, 10.11.12.13:0.0 or myhostname:0.0

Others Oracle R/ Oracle R 
Enterprise

This is an optional requirement.

For more details, see Configuration for Oracle R distribution and Oracle R 
Enterprise (ORE).

OFS AAI 1-Off Download the consolidated one-off patch for bug number 26589735 

from http://support.oracle.com.

Requirement Sub-Category Expected Value
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Identifying the Installation, Download and Metadata Repository Directories

For installation of any OFSAA Application Pack, the below folders/ directories required to be created.

 OFSAA Download Directory (Optional): Create a download directory and copy the OFSAA Application Pack Installer 
File (Archive). This is the directory where the downloaded installer/ patches can be copied.

 OFSAA Installation Directory (Mandatory): Create an installation directory. This is the directory where the installer 
installs or copies the product files. FIC_HOME variable to be set in the .profile pointing to this OFSAA Installation 
Directory.

 OFSAA Staging/ Metadata Repository Directory (Mandatory): Create a Staging/ Metadata Repository Directory. This 
is the directory where you should copy data loading files, save data extracts and so on. Additionally, this folder also 
maintains the OFSAA Metadata artifacts. This is commonly referred as "FTPSHARE".

Note: Ensure that the user permission is set to 755 on the Installation and Download Directory and the user 
permission is set to 775 on the Staging Directory.

Downloading and Copying the OFS Profitability Applications Pack Installer

To download and copy the OFS Profitability Applications Pack Installer, follow these steps:

 This release of OFS Profitability Application Pack v8.0.5.0.0 is available for download in MOS as Patch 26744949. You 
need to have a valid Oracle account in order to download the software.

 Copy the downloaded installer archive to the Download Directory (in Binary Mode) on the setup identified for OFSAA 
installation.

Copying and Extracting the Software

Once you obtain the installer, copy the installer (in BINARY mode) to the system on which the OFSAA Infrastructure 
components will be installed.

Note: You must be logged in to the UNIX operating system as a non-root user.

1. Download the unzip utility (OS specific) unzip_<os>.Z and copy it in Binary mode to the directory that is included in 
your PATH variable. If you already have the unzip utility to extract the contents of the downloaded archive, skip to the 
next step.

2. Uncompress the unzip installer file using the command:

uncompress unzip_<os>.Z

Note: If you notice an error message "uncompress: not found [No such file or directory]" when the package 
is not installed, contact your UNIX administrator.

3. Give EXECUTE permission to the file using the command:

chmod 751 unzip_<os>

For example, chmod 751 unzip_sparc
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4. Extract the contents of the Oracle Financial Services Advanced Analytical Applications Infrastructure Application Pack 
8.0.5.0.0 to Download Directory using the following command:

unzip OFS_PFT_PACK.zip

Note: DO NOT rename the Application Pack installer folder name on extraction from the archive.

5. Give below permission to the installer folder. Navigate to the Download Directory and execute the command: 

chmod -R 750 OFS_PFT_PACK

Setting up the Web Server/ Web Application Server

For more information to set up the environment based on your selected Web Server/ Web Application Server, see 
Configuring Web Server and Configuring Web Application Server.

Installation of Oracle R Distribution

This is an optional step and required only if you intend to use Oracle R scripting in the Oracle Financial Services Enterprise 
Modeling Application. Follow these steps:

 Install Oracle R Distribution on the Oracle Database server. See Oracle® R Enterprise Installation and Administration 

Guide for Windows, Linux, Solaris and AIX, Release 1.5 at Oracle R Enterprise Documentation Library.

 Oracle R Distribution versions supported- Oracle Distribution of R version 3.2.0.
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CHAPTER 4 Installing OFS Profitability Application 
Pack

This chapter describes the steps to be followed to install the OFS Profitability pack. 

This chapter includes the following sections:

 Schema Creator Utility

 About Schema Creator Utility

 Execution Modes in Schema Creator Utility

 Execution Options in Schema Creator Utility

 Configuring and Executing the Schema Creator Utility

 Prerequisites

 Configuring the Schema Creator Utility

 Executing the Schema Creator Utility

 Installing the OFS Profitability Applications Pack

 GUI Mode Installation

 SILENT Mode Installation

Schema Creator Utility

Creating database users/ schemas is one of the primary steps in the complete OFSAA installation. This release of OFSAA 
provides a utility to quickly get started with the OFSAA 8.0 installation by allowing easier and faster creation of database 
User(s)/ Schema(s), assign the necessary GRANT(s) and so on. Additionally, it also creates the required database objects in 
these schemas. The schema creator utility should be configured and executed mandatorily every time prior to installation 
of any OFSAA Application Pack.

This section includes the following topics:

 About Schema Creator Utility

 Execution Modes in Schema Creator Utility

 Execution Options in Schema Creator Utility

About Schema Creator Utility

The schema creator utility should be configured and executed mandatorily every time prior to installation of any OFSAA 
Application Pack.

The following are the types of schemas that can be configured in the OFSAA:

 CONFIG - Denotes the unique OFSAA setup configuration schema. It contains entities and other objects required for 
OFSAA setup information. 
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Note: There can be only one CONFIG schema per OFSAA instance.

 ATOMIC - Denotes the schema that contains the data model entities. One ATOMIC schema is attached to one 
Information Domain. 

Note: For some application packs, there can be multiple ATOMIC schemas per OFSAA Instance, but the 
Profitability Pack supports only one atomic schema per OFSAA instance.

 SANDBOX - Denotes the schema that contains the data for all Sandbox executions. One SANDBOX schema is attached 
to one Sandbox Information Domain. 

Note: This Schema type is not applicable for OFS Profitability Application Pack. There can be multiple 
SANDBOX schemas per OFSAA Instance and a Sandbox Information Domain can have only one SANDBOX 
schema.

 ADDON - Denotes any additional schema used by the OFSAA Applications. 

Note: This Schema type is not applicable for OFS Profitability Application Pack.

Execution Modes in Schema Creator Utility

The Schema Configuration Utility supports the following modes of execution:

 Online Mode: In the Online mode, the utility connects to the database and executes the DDLs for Users, Objects and 
Grants. If you have the SYSDBA privileges you can execute the Schema Creator Utility in Online mode and thereby 
create the Users, Objects and Grants during the execution process.

Note: To execute the utility in Online mode, you need to connect as "<User> AS SYSDBA".

 Offline Mode: In the Offline mode, the utility generates SQL script with all the required DDLs for Users, Objects and 
Grants. This script needs to be executed by the DBA on the appropriate database identified for OFSAA usage. If you do 
not have the SYSDBA privileges, you can execute the Schema Creator Utility in Offline mode and generate the script 
file that contains the Schemas, Objects and Grants, information. Subsequently, a SYSDBA user can execute the script 
file manually. 

1. To execute the utility in Offline mode, you need to connect as any user with below grants (alternatively, you can also 

connect as a user with SYSDBA privileges):

SELECT ON DBA_ROLES

SELECT ON DBA_USERS

SELECT ON DBA_DIRECTORIES

SELECT ON DBA_TABLESPACES
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CREATE SESSION

For more details, see Executing the Schema Creator Utility in Offline Mode.

2. If there are any errors during the script execution, reconfigure the OFS_PFT_SCHEMA.XML file and execute the utility. 

This generates the scripts with corrected information. For more information, see Configuring 

OFS_PFT_SCHEMA_IN.xml.

Note: Do not modify the OFS_PFT_SCHEMA_OUT.XML file generated after the execution of this utility.

Execution Options in Schema Creator Utility

Depending on the option you choose to run the OFSAA Application Pack Installer, you need to choose the schema creator 
utility execution option. To run the OFSAA Application Pack installer in SILENT mode, it is mandatory to execute the 
schema creator utility with -s option. 

Note: If the schema creator utility is executed without the option -s, it is mandatory to run the OFSAA 
Application Pack Installer in GUI mode.

Configuring and Executing the Schema Creator Utility

This section includes the following topics:

 Prerequisites

 Configuring the Schema Creator Utility

 Executing the Schema Creator Utility

Prerequisites

The following prerequisites must be ensured before configuring the Schema Creator Utility:

 Download and apply the one-off patch for Bug 28149904 from MOS in case there's a pack over pack installation, 
where the pack version that is already installed is lower than version 8.0.5.0.0. For example, install this patch if you 
have to install PFT release 8.0.5.0.0 application using the full installer in a setup that has ALM release 8.0.2.0.0 or 
later. For detailed instructions, see the Readme.txt file packaged along with the patch.

 You must have the Oracle User ID/Password with SYSDBA privileges.

 You must have the JDBC Connection URL for RAC/Non RAC database.

 The HOSTNAME/IP of the server on which OFSAA is getting installed.

 The following configuration is required only if you intend to use Oracle Linux/Red Hat Enterprise Linux v7.x for OFSAAI 
8.0.5.0.0 version.

For Oracle Linux/RHEL 7.x, navigate to OFS_PFT_PACK/bin/ and modify the value for property Linux_VERSION to 
include 7 in the VerInfo.txt file and save the changes.

For example, Linux_VERSION=6,7
Oracle Financial Services Profitability Management Application Pack Installation Guide 29



Configuring and Executing the Schema Creator Utility
Chapter 4—Installing OFS Profitability Application Pack
 For IBM AIX 7.1, navigate to OFS_PFT_PACK/bin/ and modify the value for property AIX_VERSION to include 7.1 in the 
VerInfo.txt file and save the changes.

For example, AIX_VERSION=6.1,7.1

 It is recommended to set the PGA_AGGREGATE_LIMIT database-parameter value sufficiently, when Oracle 12c is 
installed

 You must add a TNS entry before the installation.

Note: The TNS Entry for an atomic schema should be without any special character, i.e '_'. If the atomic 
schema name is like 'DEV_ATOM', the TNS name should be like 'DEVATOM'.

If this release of the OFS PFT Application Pack version 8.0.5.0.0 is being installed on an OFSAA setup where 
the underlying OFSAA Infrastructure (OFS AAI) version is upgraded to version 8.0.1.x.x, download and install 
the patch for schema creator utility (Bug 21133780) by following the instructions in the Readme.txt 
packaged in it prior to executing the utility.

If this release of the OFS PFT Application Pack version 8.0.5.0.0 is being installed on an OFSAA setup where 
the underlying OFSAA Infrastructure (OFS AAI) version is upgraded to version 8.0.2.x.x, download and install 
the patch for schema creator utility (Bug 21657319) by following the instructions in the Readme.txt 
packaged in it prior to executing the utility.

Configuring the Schema Creator Utility

To configure the Schema Creator Utility, follow these steps:

1. Log in to the system as non-root user.

2. Navigate to the following path: OFS_PFT_PACK/schema_creator/conf.

3. Edit the OFS_PFT_SCHEMA_IN.xml file in a text editor.

4. Configure the elements as described in the Configuring OFS_PFT_SCHEMA_IN.xml.

5. Save the OFS_PFT_SCHEMA_IN.xml file.

Note: On successful execution of the utility, the entered password in the OFS_AAAI_SCHEMA_IN.xml file is 
nullified.

Executing the Schema Creator Utility

This section includes the following topics:

 Executing the Schema Creator Utility in Online Mode

 Executing the Schema Creator Utility in Offline Mode

 Executing the Schema Creator Utility with -s option 

 Executing the Schema Creator Utility for Subsequent Application Pack

 Verifying the Log File
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Executing the Schema Creator Utility in Online Mode

In Online Mode, the Schema Creator Utility will create all the Schemas, Schema Objects, Tablespaces, Grants, and Roles in 
the database during the execution process. 

To execute the Schema Creator Utility in Online Mode, follow these steps:

1. Log in to the system as non-root user.

2. Navigate to the following folder path: OFS_PFT_PACK/schema_creator/bin/

3. Execute the following command:

./osc.sh

4. The following message is displayed: You have chosen ONLINE mode. Triggering the utility in ONLINE mode will execute 

the DDLs directly on the Database. Do you wish to proceed? (Y/y or N/n).

 

5. Enter Y/y to proceed.

6. Enter the DB Username with SYSDBA Privileges. 

For example: SYS as SYSDBA.

7. Enter the User Password.

8. The console runs the initial validation checks and then displays the following message: 

You have chosen to install this Application Pack on <Name of the Atomic Schema > ATOMIC schema. Do you want to 
proceed? (Y/N).

You have chosen to install this Application Pack on <Name of the Infodom>. Do you want to proceed? (Y/N).
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9. Enter Y/y to start the schema creation.

Or

Enter N/n if you want to quit executing the schema creation. 

Note: On successful execution of schema creator utility, the console displays the following status message:

Schema Creator executed successfully. Please proceed with the installation.

See log file in OFS_PFT_PACK/schema_creator/logs folder for execution status. If there are any errors, 
contact Oracle Support.

Executing the Schema Creator Utility in Offline Mode

In Offline Mode, the Schema Creator Utility will create an output in SQL file format. This script has to be executed 
manually by logging as database user with SYSDBA privileges. The SQL file will contain the scripts for creation of Schemas, 
Schema Objects, Tablespaces, Grants, and Roles.

Prerequisites:

 Database user with below privileges:

 SELECT ON DBA_ROLES

 SELECT ON DBA_USERS

 SELECT ON DBA_DIRECTORIES

 SELECT ON DBA_TABLESPACES

 CREATE SESSION
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Note: Explicit Grants to the user are required. Grants assigned through Roles are not supported.

To execute the schema creator utility in the offline mode, follow these steps:

1. Log in to the system as non-root user.

2. Navigate to the following path: OFS_PFT_PACK/schema_creator/bin

3. Execute the osc.sh file using the following command:

./osc.sh -o

4. The following message is displayed: 

You have chosen OFFLINE mode. Triggering the utility in OFFLINE mode will generate the script. Do you wish to 
proceed? (Y/y or N/n).

5. Enter Y/y to proceed.

6. Enter the DB Username with SELECT privileges.

7. Enter the User Password.

8. The console runs the initial validation checks and displays the following message:

You have chosen to install this Application Pack on <Name of the Atomic Schema > ATOMIC schema. Do you want to 
proceed? (Y/N).

You have chosen to install this Application Pack on <Name of the Infodom>. Do you want to proceed? (Y/N).
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9. Enter Y/y to start the script generation. 

Or

Enter N/n if you want to quit the script generation.
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Note: On successful execution of schema creator utility, the console displays the following status message:

Schema Creator executed successfully. Please execute 
scratch/ofsaaapp/OFS_PFT_PACK/schema_creator/sysdba_output_scripts.sql before 
proceeding with the installation.

10. Navigate to the directory: OFS_PFT_PACK/schema_creator. 

11. Login to SQLPLUS with a user having SYSDBA Privileges.

12. Execute the sysdba_output_scripts.sql file using the following command:

SQL>@sysdba_output_scripts.sql

Alternatively, you can copy the sysdba_output_scripts.sql file and SQLScripts folder to a remote server and 
execute sysdba_output_scripts.sql file, after providing appropriate execute permissions.

Note: See log sysdba_output_scripts.log file for execution status. If there are any errors, contact 
Oracle Support. This log would be empty if there are no errors in the execution.
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Executing the Schema Creator Utility with -s option

If you want to run the OFSAA Application Pack Installer in SILENT mode, it is mandatory to execute the schema creator 
utility with -s option.

To execute the utility with -s option, follow these steps:

1. Edit the file OFS_PFT_PACK/schema_creator/conf/OFS_PFT_SCHEMA_IN.xml in text editor.

2. Set the value for attribute "INFODOM" of <SCHEMA> tag(s) to specify a specific Information Domain name. By 

default, the value is empty and the utility will derive the Information Domain name. If the attribute value is set, the 

utility/ installer will configure the Information Domain against this <SCHEMA>.

3. Execute the utility with -s option.

For Example:./osc.sh -s.

Note: If the utility is executed without the -s option, it is mandatory to launch the OFSAA Application Pack 
Installer in GUI mode.

To execute the utility in OFFLINE mode with SILENT option, enter following command:
/osc.sh -o -s.

Executing the Schema Creator Utility for Subsequent Application Pack

While executing the schema creator utility for subsequent Application Pack, you can choose to install the pack either on 
the same Information Domain/Atomic Schema or on a new Information Domain/Atomic Schema. You can execute the 
Schema Creator Utility either in Online or Offline Mode.

Note: OFS PFT Application Pack can be installed on any Information Domain/ Atomic schema where any OFS 
Application Packs are installed other than OFS Behavior Detection Application Pack or OFS Compliance 
Regulatory Reporting Application Pack.

To execute the schema creator utility while installing OFS PFT Application Pack over an existing Application Pack, follow 
these steps:

1. Repeat the steps 1 to 9 from the Executing the Schema Creator Utility section.

Note: Ensure to use the same config schema user name as the previous Application Pack.

2. The utility identifies the Application Packs that are already installed on the current OFSAA setup and displays the 

following on console:

 Atomic schema of the Existing Application Pack

 Information Domain Name of the Existing Pack, and the

 List of Installed Application Packs Execute the ./osc.sh file.
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3. Select the Atomic User, on which you want to install the Application Pack.

4. On successful execution or schema creator utility, the following message is displayed: Schemas Creation Completed.

See the log file in OFS_PFT_PACK/schema_creator/logs folder for execution status.

See the log sysdba_output_scripts.log file for execution status, if executed in offline mode. This log would be empty if 
there are no errors in the execution.

If there are any errors, contact Oracle Support.

Verifying the Log File

If schema creation is successful, the console would display an appropriate message. 

If the schema creation runs into errors, see the log files:

<<OFSPFT Installer folder>>/<<OFS_PFT_PACK>>/schema_creator/logs/ and <<OFS_PFT>>_OSC_<timestamp>.log for 
further details.

You may contact Oracle support anytime for assistance.
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Installing the OFS Profitability Applications Pack

Follow the instructions in this section to install the OFS Profitability Applications Pack depending on the mode of 
installation.

This section includes the following topics:

 GUI Mode Installation

 SILENT Mode Installation

 Verifying the Log File

Note: If this release of the OFS Profitability Applications Pack is being installed for Oracle Database Server 
Release 12cR2 that is 12.2.x, then copy the file envCheck.sh before triggering the installation:

From Location - OFS_PFT_PACK/OFS_AAI/bin/envCheck.sh

To Location - OFS_PFT_PACK/OFS_AAAI_PACK/OFS_AAI/bin/envCheck.sh

GUI Mode Installation

Ensure that you have followed the steps as mentioned in the Configuration for GUI Mode Installation section prior to 
proceeding with the next steps.

1. Log in to the system as non-root user.

2. Identify a directory for installation and set the same in the user .profile file as below:

ORACLE_HOME=<oracle_installed_dir>

Export FIC_HOME

3. Execute the user .profile.

4. Navigate to path: OFS_PFT_Pack.

5. Edit the OFS_PFT_PACK/schema_creator/conf/OFS_PFT_SCHEMA_IN.xml file to set the appropriate attribute 

values.

Note: See Configuring OFS_PFT_SCHEMA_IN.xml file for details on configuring this XML file.

6. Execute the schema creator utility.

Note: This step is mandatory and should be executed before every OFSAA Application Pack installation. See 
Executing the Schema Creator Utility for more details.

7. Navigate to the path: OFS_PFT_PACK/bin.

8. To install OFS PFT Application Pack on:

 For Java 6 and 7: Proceed with step 9.
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 For Java 8: Edit the VerInfo.txt file to modify the value for property JAVA_VERSION to 1.8. Save the changes and 
proceed with step 9.

9. Execute ./setup.sh GUI in the console. 

Note: Refer to the console for any errors during Pre-install checks.

Figure 1. Validating the Installation
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Figure 2. License Agreement

10. Select I accept the terms if the License Agreement option.

11. Click Next to display the The Application Pack details.

12. Select the product to enable for which you have already obtained license.

13. Click Next to display the License Agreement page.
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14. Select I accept the terms if the License Agreement option.

15. Click Next.

16. Click Next to display the Manage Information Domain page.
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17. Edit the Information Domain Name if it is a new Information domain and you wish to change the name of the 

information domain name. 

The Information Domain Name is not editable in case of subsequent Application Pack installation on the same 
Information Domain.

Permissible length is 10 characters and only alphanumeric characters allowed. No special characters allowed.

18. Click Next to display the following window.
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19. Click Next to display the User Installation Directory window.

 

20. Enter the installation directory path. This is the directory you have set in the user .profile file in step 2.

21. Click Next to display the OFSAA Infrastructure Server Details window.

22. Enter the IP address or hostname of the OFSAAI server and Database server.

23. Click Next to display the Web Application Server window.
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24. Select the appropriate Web Application server type. The options are Tomcat, WebSphere, and WebLogic.

25. Click Next. Based on the selection, corresponding screens are displayed.

For Tomcat: The Absolute Tomcat Path window is displayed.

 Enter the Tomcat installation path (till /webapps) where OFSAAI will be deployed. 

For WebSphere: The WebSphere Setup Details window is displayed.
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 Enter the installation path (up to the host name directory) of the WebSphere. The format is WebSphere path 
<WebSphere profile directory>/installedApps/ <NodeCellName>. 

For WebLogic: The Weblogic Home window is displayed.

 Enter the WebLogic home directory path.

 Enter the path of the Weblogic domain home directory.

26. Click Next to display the OLAP Details window.

Enter 1 if you want to configure OFSAAI OLAP feature. By default, value 0 is displayed.

27. Click Next to display the Web Server Details window.
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 Select the Enable HTTPS check box to configure HTTPS.

 Enter Web Server (HTTP Server) Port, Web App Server (HTTP Server) IP address, context name for deployment 
and the local path to any folder on the Web Application Server (Tomcat/ Websphere/ Weblogic).

28. Click Next to display the Database Details window.

29. Enter Oracle SID/Service Name, JDBC URL, Configuration Schema User ID and Password, and Absolute Driver Path.
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Note: Absolute Driver Path can be the path where Oracle DB client is installed or JDBC driver is installed. 
For example, /scratch/oracle/app/oracle/product/11.2.0/client_1/jdbc/lib

30. Click Next to display the Ports Configuration window.

Enter Java Port, Native Port, Agent Port, ICC Server Port, and ICC Native Port. You can proceed with the default port 
values configured.

31. Click Next to display the Ports Configuration window.
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Enter OLAP Port, Message Server Port, Router Port, and AM Port.

32. Click Next and then select the File Transfer protocol.

Note: Ensure the system on which the OFSAA Infrastructure is being installed, has either FTP/ SFTP enabled.

Enter the port to be used for file transfer.
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33. Click Next to display the OFSAAI FTP/SFTP Details window.

34. Enter the path of the ftpshare directory and the User Id and password for OFSAAI Server.

Note: The transfer of data (files) between the OFSAAI Server and the Web Application Server happens over 
FTP/ SFTP. Ensure the necessary host configurations are made for a successful handshake.

35. Click Next to display the Pre-Installation Summary window.
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36. Click Next to display the Pre Installation Summary window.

37. Click Install to display the Installing OFSAA Infrastructure window.

Anytime during the installation you can click Cancel to stop the installation. Once completed, the Installation 
Summary screen is displayed.
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The Summary screen displays the number of Fatal Errors, Errors, Debug Statements, Information, and Warnings along 
with the location of log files.

38. Click Next to display the Installation Complete window.
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Note: If the installation is successful with some warnings, you can navigate to the installation log for more 
details and address them.

39. Click Done. The following message is displayed: 

Please wait, pack_install is being configured for your system. This may take a moment.

40. After the pack installation is complete, the Solution Setup - Introduction window will be displayed.

41. Click Next to display the Log mode window. Select the Log Mode.
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42. Click Next to display the Segment creation window. Enter the log paths.

43. Click on Next to display the Pre-Infodom Creation Summary window.
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44. Click Next to display the Infodom creation window.

Note: Permissible length for information domain is maximum 10 characters and only alphanumeric 
characters allowed. No special characters allowed.

45. After creation of infodom, the Tablespace specification window will be displayed.
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46. Click Next to display the Model Upload window.

47. Select Yes and click Next to display the Model Type window.

48. Select Released Data Model and click Next. Model will get copied into ftpshare.

49. After Model is copied to ftpshare, the Model Review Window will be displayed.
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Note: If Heap Memory Warning is displayed, then click on Back, and update your .profile entry with 
required heap memory size.

 Open a new session in Putty.

 Shutdown Reveleus server using $FIC_HOME/ficapp/common/FICServer/bin/ reveleusshutdown.sh.

 Update the X_ARGS_APP entry in .profile following example.

Example:

X_ARGS_APP="-Xms2g -Xmx18g -XX:+UseAdaptiveSizePolicy -XX:MaxPermSize=1024M 
-XX:+UseParallelOldGC  -XX:+DisableExplicitGC"

 Run .profile.

 Start Reveleus using $FIC_HOME/ficapp/common/FICServer/bin/ reveleusstartup.sh.

 Proceed for model Upload by clicking on Next.
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Pack-on-pack installation for Profitability pack, execute $FIC_HOME/scripts/atomic/create/indexes.sql as a post 
data model upload step.

The data model is getting uploaded. 

50. Click Next to display Oracle Business Intelligence Configuration screen.

The Pre-Setup Information screen requests for setup information. 

The following panel seeks input from the user on whether to create new ETL application/source pair or use an existing 
one. 
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Choose a desired option.

51. Click Next to continue.

52. Select New Application source and click Next. Staging details will be displayed:

53. After Creation, click Next to display the Installation Details Review window.
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54. Click Install. A Pop window will ask for the confirmation.

55. Click Yes to begin the installation. The installation progress will be in the Installation Progress window.
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56. After Installation completion, Installation Completion window will be displayed.

57. Click Done. The Panel will go back to Main App Pack Installation window and the Installation Summary window will 

be displayed.

58. Click Next to display the Installation Complete window.
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59. Click Done. 

Note: The installation process continues on the console. Do not close the console until the installation 
process is complete.

Post Install Health checks are displayed:
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60. Install the following mandatory one-off patches for the applications mentioned:

 PFT application: 28146189

 FTP application: 28091067.

After you apply the above patch for FTP application, apply the following patches:

 28403034

 28617711

 28721483

 28859373

Refer to the Readme files available with the patches for further the installation instructions.

Note: Verify and apply any recent fixes for respective applications.

61. Perform steps mentioned in the Post Installation Configuration section.
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SILENT Mode Installation

Note: For Schema Creator Utility steps, see Executing the Schema Creator Utility.

1. Log in to the system as non-root user.

2. Identify a directory for installation and set the same in the user .profile file as below:

FIC_HOME=< OFSAA Installation Directory > export FIC_HOME

3. Execute the user .profile.

4. Pre-Installation XML/ File Populations:

Before Proceeding to SILENT Installer, we need to populate following files with pre-defined values.

 OFSAAI_InstallConfig.xml (Location: OFS_PFT_PACK/OFS_AAI/conf). For more information, see Configuring 
OFSAAI_InstallConfig.xml File.

Note: If value for HTTPS_ENABLE is set to 1, ensure you have a valid certificate available from a trusted CA 
and the same is configured on your web application server.

 SILENT.props File. (Location: OFS_PFT_PACK/OFS_PFT/conf)

Note: The file name will be SILENT.template in the installer and it has to be renamed as SILENT.props.

Important: Do not install the new applications in the same segment if the pre-installed applications use run 
management.

Property Name Description of Property Permissible Values Comments

UPLOAD_MODEL whether you want to perform 
Model Upload

0 = No

1 = yes

Mandatory

MODEL_TYPE Released data model or 
Customized data model

0 = released

1 = customized

# Mandatory only in the case 
of uploading the data model

DATAMODEL the path for the customized 
data model

Not Applicable # Mandatory only in the case  
of uploading the customized 
data model

# Option selected for 
MODEL_TYPE=1

DM_DIRECTORY the file name for the 
customized data model

Not Applicable # Mandatory only in the case  
of uploading the customized 
data model

# Option selected for 
MODEL_TYPE=1
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Configuring Application Pack XML Files

OFS_PFT_PACK.xml

The OFS_PFT_PACK.xml file holds details on the various products that are packaged together in Profitability Application 
Pack.

This section details the various tags/ parameters available in the file and the values that need to be updated. Prior to 
installing the Profitability Application Pack in SILENT mode, it is mandatory to update this file.

Note: If you are installing in the GUI mode, then this file need not be updated.

Installation

1. Navigate to the following folder path: OFS_PFT_Pack/bin/.

Note: For Java 8: Edit the VerInfo.txt file in the path /OFS_PFT_PACK/OFS_AAI/bin/ to modify the value 
for property JAVA_VERSION to 1.8, and save the changes.

2. Execute the setup.sh file using the following command:

./setup.sh SILENT

3. The installer will proceed with Pre-Installation Checks.

4. On Successful completion of Pre-Installation checks it will prompt for the Password of FTP/SFTP. Please enter 

Infrastructure FTP/SFTP Password:
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5. Enter the Password and Proceed. The process displays the OFSAA License. Enter: Y and Proceed.

6. First AAI will be Installed.
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7. After AAI is installed, the PFT Pack installation begins.

Note: Data Model Upload may take several hours to get complete. You can check the Logs in 
/OFS_PFT_PACK/OFS_PFT/logs.

8. Do not close the console until the installation is complete.
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9. Install the following mandatory one-off patches for the applications mentioned:

 PFT application: 28146189

 FTP application: 28091067.

After you apply the above patch for FTP application, apply the following patches:

 28403034

 28617711

 28721483

 28859373

Refer to the Readme files available with the patches for further the installation instructions.
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Note: Verify and apply any recent fixes for respective applications.

10. Perform the steps mentioned in Post Installation Configuration section.
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Verifying the Log File

See the following logs files for more information: 

 See the OFS_PFT_installation.log and Pack_Install.log located at OFS_PFT_PACK/logs/ folder for OFS 
Profitability Application Pack installation log file.

 See the log file(s) located at OFS_PFT_PACK/OFS_AAI/logs/ folder for Infrastructure installation log.

 See the OFSAAInfrastucture_Install.log located at $FIC_HOME folder for Infrastructure installation log.
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CHAPTER 5 Upgrading the OFS PFT Application 
Pack

This chapter provides necessary information to upgrade the Profitability Application Pack.

This chapter includes the following topics:

 Upgrading the OFS PFT Application Pack

Upgrading the OFS PFT Application Pack

Refer to the following instructions to download, extract, install, and configure this release.

1. Download the OFS PFT Application Pack v8.0.5.0.0 archive file and copy it to your OFSAA server in Binary mode.

Note: The archive files are different for every operating system like AIX, Solaris, and RHEL/Oracle Linux.

2. Log in to the OFSAA Server.

3. Shut down all the OFSAAI Services. For more information, see the Start/Stop Infrastructure Services section in 

Start/Stop OFSAA Infrastructure Services.

4. Execute the following command:

chmod -R 750 $FIC_HOME

5. If you have Unzip utility, skip to the next step. Download the Unzip utility (OS specific) and copy it in Binary mode to 

the directory that is included in your PATH variable, typically $HOME path or directory in which you have copied the 

8.0.5.0.0 installer.

 Uncompress the unzip installer file using the command:

uncompress unzip_<os>.Z

Note: If you notice an error message "uncompress: not found [No such file or directory]" when the package 
is not installed, contact your UNIX administrator.

 Give EXECUTE permission to the file using the command:

chmod 751 OFS_PFT_80500_<OperatingSystem>.zip

6. Extract the contents of the OFS PFT Application Pack 8.0.5.0.0 in Download Directory installer archive file using the 

following command:

unzip_<os> <name of the file to be unzipped>

7. Give EXECUTE permission to the archive file. Navigate to the path OFS_PFT_80500_<OperatingSystem>.zip and 

execute the command:

chmod -R 750 OFS_PFT_80500_<OperatingSystem>
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8. Rename the SILENT.template file in the installer as SILENT.props. Configure Silent.Props file for following 

parameters:

9. Execute setup.sh file using the following command from the OFS_PFT/bin directory:

./setup.sh SLIENT

Verify if the release is applied successfully by checking the log file generated in the installation folder. You can ignore 
ORA-00001, ORA-00955, ORA-02260, and ORA-01430 errors in the log file. Also, you can ignore any unique constraint 
errors. If there are any other errors, contact Oracle Support.

10. Install the following mandatory one-off patches for the applications mentioned:

 PFT application: 28146189

 FTP application: 28091067.

After you apply the above patch for FTP application, apply the following patches:

 28403034

 28617711

 28721483

 28859373

Refer to the Readme files available with the patches for further the installation instructions.

Note: Verify and apply any recent fixes for respective applications.

Property Name Description of Property Permissible values Comments

UPLOAD_MODEL whether you want to perform 
Model Upload

0: No

1: Yes

Mandatory

Select "1" to perform the 
Model Upload.

Select "0" to skip Model 
Upload.

MODEL_TYPE Released data model or 
Customized data model

0 = released

1 = customized

# Mandatory only in the case 
of uploading the data model

If UPLOAD_MODEL option is 
selected as "1", then you can 
choose to upload Released 
Model (0) or customized 
Model (1).

DATAMODEL the path for the customized 
data model

Not Applicable # Mandatory only in the case 
of uploading the customized 
data model

# Option selected for 
MODEL_TYPE=1

DM_DIRECTORY the file name for the 
customized data model

Not Applicable # Mandatory only in the case 
of uploading the customized 
data model

# Option selected for 
MODEL_TYPE=1
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11. For more information on securing your OFSAA Infrastructure, See to the Security Guide in OHC Library.

12. Add umask 0027 in the .profile of the UNIX account which manages the WEB server to ensure restricted access 

permissions.

13. Restart all the OFSAAI services. For more information, see the Start/Stop Infrastructure Services section in Start/Stop 

OFSAA Infrastructure Services.

14. Generate the application EAR/WAR file and redeploy the application onto your configured web application server. For 

more information on generating and deploying EAR / WAR file, see Creating and Deploying EAR/WAR File.
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CHAPTER 6 Post Installation Configuration

After successfully installing the Oracle Financial Services Advanced Analytical Applications Infrastructure Application Pack, 
follow the post installation steps mentioned below.

This chapter includes the following topics:

 Configure excludeURLList.cfg file

 Configure Resource Reference

 Start/Stop OFSAA Infrastructure Services

 Add TNS entries in TNSNAMES.ORA file

 Configuring Web Server

 Configuring Work Manager in Web Application Servers

 Creating and Deploying EAR/WAR File

 Access the OFSAA Application

 OFSAA Landing Page

 User Group Mapping

 Create and Deploy the Application Pack Web Archive

 Patching Your OFS Profitability Pack Installation

Note: Ensure that to clear the application cache prior to the deployment of Application Pack Web Archive. 
This is applicable to all Web Servers (WebSphere, WebLogic, Tomcat). For more information, See Clearing 
Application Cache section.
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Configure excludeURLList.cfg file

To configure the excludeURLList.cfg file, follow the below steps:

1. Locate the web server deployed area webroot/conf/excludeURLList.cfg file.

2. Modify the following entries:

 [SQLIA]./dataIntegrator/ to [ALL]./dataIntegrator/

 [SQLIA]./ETLExtractionServlet to [ALL]./ETLExtractionServlet

3. Save the changes and restart the web server.

4. Re-save the definition.

Configure Resource Reference

Configure the resource reference in the Web Application Server configured for OFSAA Applications. See Configuring 
Resource Reference Web Application Servers for details on configuring the resource reference in WebSphere, WebLogic, 
and Tomcat Application Servers. 

Start/Stop OFSAA Infrastructure Services

Start the OFSAA Infrastructure Services prior to deployment or accessing the OFSAA Applications.

This chapter details on how to start and stop OFSAA Infrastructure services. This chapter includes the following sections:

 Starting Infrastructure Services

 Starting Web Application Servers

Starting Infrastructure Services

Once the installation of Infrastructure has been completed successfully and the post-installation steps are completed, the 
servers must be started. Log on to each machine and run the .profile file. All servers mentioned must be started from the 
same shell encoding. The servers mentioned below are dependent on each other. It is mandatory to maintain the order in 
which the servers are started. Allow each of the servers to initialize completely before starting the next server.

1. On the machine in which Infrastructure Application components have been installed, navigate to 

$FIC_APP_HOME/common/FICServer/bin and execute the following command to start the Infrastructure Server.

./startofsaai.sh

Note: You can also start the Infrastructure Server by executing the command "nohup ./ startofsaai.sh &". 
Starting the process using "nohup" and "&" will return the command prompt without having to wait till the 
process completes. However, this command cannot be used when you are starting the server for the first 
time or starting after changing user password in the configuration database schema.You can also start the 
Infrastructure Server by executing the command "nohup ./ startofsaai.sh &". Starting the process using 
"nohup" and "&" will return the command prompt without having to wait till the process completes. 
However, this command cannot be used when you are starting the server after changing user password in 
the Configuration database schema.

2. Start ICC server:
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 On the machine in which Infrastructure default Application components have been installed, navigate to 
$FIC_HOME/ficapp/icc/bin

 Execute the command:

./iccserver.sh

Note: Only Infrastructure Default Application Server would hold ICC component.

3. Stopping Infrastructure Services:

 On the machine on which Infrastructure Database components have been installed, navigate to 
$FIC_DB_HOME/bin and execute the command to start "Agent server":

./agentstartup.sh

Or

 Start Back-end services using the command:

nohup ./agentstartup.sh &

Note: This agent internally starts the Router, Message Server, OLAP data server and AM services.

Starting Web Application Servers

Start the Web Application Server depending on the type from the following table.

Start up Option Description

Starting WebSphere profile On the machine in which Web sphere is installed, navigate to [Webshpere_Install_Directory] 
/AppServer/<profiles>/<profile name>/bin and execute the command:

./startServer.sh server1

Starting WebLogic Domain On the machine in which WebLogic is installed navigate to <WebLogic Installation 
directory>/user_projects/domains/<domain name>/bin and execute the command: 
startWebLogic.sh -d64

Note: If WebLogic is already running, access the WebLogic Admin Console. Stop and start the 
application <context name>.ear.

Starting Tomcat Application On the machine in which Tomcat is installed, navigate to <Tomcat_Install_ Directory>/bin and 
execute the command: 

./catalina.sh run
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Stopping Infrastructure Services

To stop Infrastructure services:

1. On the machine in which Infrastructure Application components have been installed, navigate to 

$FIC_APP_HOME/common/FICServer/bin and execute the command:

./stopofsaai.sh

2. To stop ICC server, on the machine in which Infrastructure default Application components have been installed, 

navigate to $FIC_HOME/ficapp/icc/bin and execute the command:

./iccservershutdown.sh

Note: Only Infrastructure Default Application Server would hold ICC component.

3. To stop Back-end server, on the machine in which Infrastructure database components have been installed, navigate 

to $FIC_DB_HOME/bin and execute the command:

./agentshutdown.sh

Add TNS entries in TNSNAMES.ORA file

Add TNS entries in the tnsnames.ora file, for every schema created for the Application Pack:

To find the tnsname for the entries, follow these steps:

1. Login to the application using System Administrator privileges.

2. Navigate to System Configuration & Identity Management tab.

3. Click Administration and Configuration >> System Configuration >> Database Details.

4. Expand the drop-down list for Name to get the list of TNS entry names.

Alternatively, you can connect to the CONFIG schema and execute the below query:

select dbname from db_master where dbname !='CONFIG'

Configuring Web Server

This section includes the following topics:

 Configuring Web Server

 Configuring Web Application Server

Configuring Web Server

This step assumes an installation of a Web Server exists as per the prerequisites.

Refer the product specific Installation Guide/ Configuration Guide to install/ configure the Web Server. If an installation 
already exists, skip and proceed to the next step.
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Note: Make a note of the IP Address/ Host-name and Port of the web server. This information is required 
during the installation process.

See Oracle Financial Services Analytical Applications Infrastructure Security Guide for additional information 
on securely configuring your Web Server.

Ensure to enable sticky session/ affinity session configuration on the web server. See the respective product 
specific Configuration Guide for more details. Additionally, you also need to enable the sticky session/ 
affinity session configuration at Load Balancer level if you have configured a Load Balancer in front of the 
web server(s).

Configuring Web Application Server

This step assumes an installation of a web application server exists as per the prerequisites. To configure the Web 
Application Server for OFSAA Deployment refer the sections below. 

This section includes the following topics:

 Configuring WebSphere Application Server for Application Deployment

 Configuring WebLogic for Application Deployment

 Configuring Apache Tomcat Server for Application Deployment

Note: Make a note of the IP Address/ Host-name and Port of the web application server. This information is 
required during the installation process (required if Web Server is not configured).

Add umask 0027 in the .profile of the UNIX account which manages the WEB server to ensure restricted 
access permissions.

See the Oracle Financial Services Analytical Applications Infrastructure Security Guide for additional 
information on securely configuring your Web Server.

Configuring WebSphere Application Server for Application Deployment

You can deploy multiple OFSAA applications on different profiles of a WebSphere application server. To create multiple 
WebSphere "Profiles" in a stand-alone server, use the command line option as explained below. A profile is the set of files 
that define the runtime environment. At least one profile must exist to run WebSphere Application Server.

This section includes the following topics:

 Creating a New Profile in WebSphere

 Managing IBM WebSphere SDK Java Technology Edition Versions

 Managing Applications in WebSphere

 Configuring WebSphere Application Server to Use a Load Balancer or Proxy Server

 Deleting WebSphere Profiles

 WebSphere HTTPS Configuration

 WebSphere Memory Settings
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Creating a New Profile in WebSphere

The Profile is created in WebSphere through command line using the manageprofiles.sh which resides in <WebSphere 
Install directory>/AppServer/bin folder.

The command to create a profile without admin security through command line is as follows:

"manageprofiles.sh -create -profileName <profile> -profilePath <profile_path> 
-templatePath <template_path> -nodeName <node_name> -cellName <cell_name> -hostName 
<host_name>"

Example:

$usr/home>./manageprofiles.sh -create -profileName mockaix 
-profilePath/websphere/webs64/Appserver/profiles/mockaix 
-templatePath/websphere/webs64/Appserver/profileTemplates/default -nodeName 
ipa020dorNode04 - cellName ipa020dorNode04Cell -hostName ipa020dor

The command to create a profile with admin security through command line is as follows:

"manageprofiles.sh -create -profileName <profile> -profilePath <profile_path> 
-templatePath <template_path> -nodeName <node_name> -cellName <cell_name> -hostName 
<host_name> -enableAdminSecurity true -adminUserName <Admin User Name> -adminPassword < 
Admin User Password> -samplespassword <sample User Password>"

Example:

$usr/home>./manageprofiles.sh -create -profileName mockaix 
-profilePath/websphere/webs64/Appserver/profiles/mockaix 
-templatePath/websphere/webs64/Appserver/profileTemplates/default -nodeName 
ipa020dorNode04 -cellName ipa020dorNode04Cell -hostName ipa020dor -enableAdminSecurity 
true -adminUserName ofsaai -adminPassword ofsaai -samplespassword ofsaai"

Note: While using the manageprofiles.sh command to create a New Profile in WebSphere, you can also use 
"-validatePorts" to validate if the specified ports are not reserved or in use. Additionally, you can specify 
new ports with "-startingPort <base port>" which specifies the starting port number to generate and assign 
all ports for the profile. For more information on using these ports, see WebSphere manageprofiles 
command.

Managing IBM WebSphere SDK Java Technology Edition Versions

By default, WebSphere Application Server V8.5.5.X uses the Java 6.0 SDK. You must upgrade to Java 7.X SDK or JAVA 8.X 
SDK.

Prerequisites: Install the IBM WebSphere SDK Java Technology Edition Versions 1.7.X_64 or 1.8.X_64.

Perform the following steps to upgrade to Java 7.X SDK or JAVA 8.X SDK:

1. Enter the WebSphere URL in the format http://HOST_NAME:PORT_NUMBER/ibm/console (use https if SSL is 

enabled.). For example, http://192.168.1.0:9000/ibm/console.

2. Login with your administrator user ID and password.

3. From the LHS menu, click Servers to expand and view the menu.

4. Click Server Types to expand the menu further and then click WebSphere Enterprise Application Servers to view the 

Application servers window.
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5. On Application servers window, click the required Application Server link. For example, server1 in the following 

illustration:

6. Click Java SDKs link from Server Infrastructure to view the list of Java SDKs.
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7. Select either 1.7_64 or 1.8_64 based on the JVM version with which you plan to install OFSAA or have installed with.

8. Click Make Default button and save to master repository.

9. Restart the WebSphere Application Server to apply the changes to the IBM application profile.

Managing Applications in WebSphere

To manage the installed applications in WebSphere, do the following:

1. Open the administrator console using the following URL:

http://<ipaddress>:<Administrative Console Port>/ibm/console

Example: http://10.111.222.333:9003/ibm/console (https if SSL is enabled)

Note: Administrative Console Port value is available in serverindex.xml file within <WebSphere Profile 
Directory>/config/cells/<Node Cell>/nodes/<Node Name> directory.

The Integrated Solutions Console Login window is displayed.

Figure 2: Integrated Solutions Console Login

2. Log on with the User ID provided with the admin rights.

3. From the LHS menu, expand the Applications > Application Type> WebSphere Enterprise Applications.

The Enterprise Applications screen is displayed.
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Figure 3: Enterprise Applications

4. This Enterprise Applications screen helps you to:

 Install new application

 Un-install existing applications

 Start or Stop the installed applications

Configuring WebSphere Application Server to Use a Load Balancer or Proxy Server

The configuration prevents the process server from redirecting to an internal port when using a load balancer or proxy 
server.

The following steps describe the configuration:

1. Enter the WebSphere URL in the format

http://HOST_NAME:PORT_NUMBER/ibm/console (use https if SSL is enabled.).

For example, http://192.168.1.0:9000/ibm/console.

2. Login with your administrator user ID and password.

3. From the LHS menu, click Servers to expand and view the menu.

4. Click Server Types to expand the menu further and then click WebSphere Enterprise Application Servers to view the 

Application servers window.

5. On Application servers window, click the required Application Server link. For example, server1 in the following 

illustration:
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6. Click Web Container Settings > Custom Properties.

7. Add the following properties:

 Name: trusthostheaderport

Value: true

 Name: com.ibm.ws.webcontainer.extractHostHeaderPort

Value: true

8. Restart the WebSphere Application Server to apply the changes.

Deleting WebSphere Profiles

To delete a WebSphere profile, do the following:

1. Select the check box adjacent to the required application and click Stop.

2. Stop the WebSphere profile to be deleted.

3. Navigate to WebSphere directory:

<WebSphere_Installation_Directory>/AppServer/bin/

4. Execute the command:

manageprofiles.sh -delete -profileName <profile_name>

5. Delete profile folder.

Example: <WebSphere_Installation_Directory>/AppServer/profiles/<profile_name>

6. Execute the command:

manageprofiles.sh -validateAndUpdateRegistry

WebSphere HTTPS Configuration

Following are the steps for configuring an HTTPS Transport on WebSphere:

1. Create a profile using the Profile Creation Wizard in WebSphere.
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2. Note down the https port specified during this process and use the same as servlet port or web server port during 

OFSAAI installation.

To enable https configuration on Infrastructure, assign value 1 to "HTTPS_ENABLE" in OFSAAI_InstallConfig.xml for 
SILENT mode OFSAAI installation. 

WebSphere Memory Settings

To configure the WebSphere Memory Settings:

1. Navigate to Websphere applications server > Application servers > server1 > Process definition > Java Virtual 

Machine.

2. Change the memory setting for Java Heap:

Initial heap size = 512

Maximum heap size = 3072

Configuring WebLogic for Application Deployment

You can deploy multiple Infrastructure applications on different domains of a stand-alone WebLogic application server. To 
create multiple WebLogic "Domains" in a stand-alone server you can use the Domain Creation wizard. A domain is the set 
of files that define the runtime environment. At least one domain must exist to run WebLogic Application Server.

Note: For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download and install patch 
18729264.

This section includes the following topics:

 Creating Domain in WebLogic Server

 Delete Domain in WebLogic

 WebLogic Memory Settings

Creating Domain in WebLogic Server

To create a new domain using Configuration Wizard in WebLogic, do the following:

1. Navigate to the directory <WLS_HOME>/wlserver/common/bin and execute the command:

./config.sh

The Welcome window of the Configuration Wizard is displayed.
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Figure 4: Welcome

2. Select Create a new WebLogic domain option and click Next.

The Select Domain Source window is displayed.

Figure 5: Select Domain Source

3. Select the Generate a domain configured automatically to support the following products option and click Next. 
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The Specify Domain Name and Location window is displayed.

Figure 6: Specify Domain Name and Location

4. Enter the Domain Name and . Click Browse to navigate and specify the location. Click Next.

The Configure Administrator Username and Password window is displayed.

Figure 7: Configure Administrator Username and Password

5. Enter the User name and User password to be assigned to the Administrator. Ensure that the password is of minimum 

8 characters in length.

6. Re-enter the password for confirmation and add a brief Description. Click Next.

The Configure Server Start Mode and JDK window is displayed.
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Figure 8: Configure Server Start Mode and JDK

7. Select the following options:

In the WebLogic Domain Startup Mode section, select the required mode (Development Mode or Production Mode).

In the JDK Selection section, select Other JDK. Click Browse and navigate to the JDK location. Click Next.

The Select Optional Configuration window is displayed.
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Figure 9: Select Optional Configuration

8. Select Administration Server. A WebLogic Server domain must have an Administration Server. You can also select 

Manages Servers, Clusters and Machines and RDBMS Security Store if required. Click Next.

The Configure the Administration Server window is displayed.

Figure 10 Configure the Administration Server

9. Enter Administration Server details such as the Name, Listen address, Listen Port, SSL listen port, and SSL enabled (for 

secure login using https) check box. Click Next.

The Configuration Summary window is displayed.

Note: Make a note of the Listen Port or SSL Listen Port value (ex: 7007), since the same has to be re-entered 
in the Servlet port field during Infrastructure installation.
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Figure 11: Configure Server Start Mode and JDK

10. Verify the configuration details of the WebLogic domain and click Create. 

11. The Creating Domain window is displayed with the status indication of the domain creation process.

Figure 12: Configure Server Start Mode and JDK
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12. Click Done when complete. The domain server is created enabling the deployment of multiple Infrastructure 

applications on a single WebLogic.

Note: Note down the HTTPS port specified during this process and use the same as servlet port or web 
server port during OFSAAI Installation.

To enable https configuration on Infrastructure, assign value 1 to "HTTPS_ENABLE" in 
OFSAAI_InstallConfig.xml for silent mode OFSAAI installation

13. Add a Java option entry -DUseSunHttpHandler=true in WLS_HOME/bin/ "setDomainEnv.sh" file 

(Required only if self signed certificate is used).

Delete Domain in WebLogic

1. Navigate to the following directory:

<WebLogic Installation directory>/user_projects/domains/<domain name>/bin

2. Execute stopWebLogic.sh to stop the Weblogic domain.

3. Delete the Weblogic domain.

WebLogic Memory Settings

To configure the WebLogic Memory Settings:

1. Change the memory setting for Java Heap to -Xms512m -Xmx3072m in setDomainEnv.sh file, which resides in the 

folder <DOMAIN_HOME>/bin and in CommEnv.sh file which resides in the folder common/bin.

2. Edit this file for customizing memory settings and garbage collector settings depending on the available hardware 

configuration.

Example 1:

if [ "${JAVA_VENDOR}" = "Sun" ] ; then

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_64BIT

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_32BIT

else

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_64BIT

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_32BIT

Example 2:

JAVA_VM=

MEM_ARGS="-Xms256m -Xmx1024m"
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Updating Atomic Schema Data Source in Web Logic

To Disable the Wrap Data Types for the Atomic schema data source in Weblogic 12.2, execute the following steps:

1. In the Change Center of the Administration Console, click Lock & Edit.

2. In the Domain Structure tree, expand Services, then select Data Sources.

3. On the Summary of Data Sources page, click the data source name.

4. Select the Configuration: Connection Pool tab.

5. Scroll down and click Advanced to show the advanced connection pool options.

6. In Wrap Data Types, deselect the checkbox to disable wrapping.

7. Click Save.

8. To activate these changes, in the Change Center of the Administration Console, click Activate Changes.

9. Redeploy the Data Source and restart all the services.
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Configuring Apache Tomcat Server for Application Deployment

This section is applicable only when the Web Application Server type is Tomcat.

This section includes the following topics:

 Tomcat User Administration

 Configure Tomcat to use JAVA 64 bit Executables

 Configure Servlet Port

 SSL Port Configuration

 Apache Tomcat Memory Settings

 Uninstalling WAR Files in Tomcat

 Configuration for Axis API

 Additional Configurations for Tomcat

Tomcat User Administration

The Tomcat administration and manager application does not provide a default login. You are required to edit 
"$CATALINA_HOME/conf/tomcat-users.xml" as instructed below.

This file contains an XML tag <user> for each individual user, which will display the user name and password used by 
admin to log on to Tomcat, and the role names to which the admin user is associated with. For example, <user 
name="admin" password="admin" roles="standard-manager " />

1. Add the manager role to any one of the existing user name/ password combination as shown in the example above.

2. Use the same user-name/ password to which the manager role has been assigned to access the Tomcat Application 

Manager.

3. If the Tomcat server is already running, it requires a re-start after the above configuration is done.

Configure Tomcat to use JAVA 64 bit Executables

1. Navigate to the "$CATALINA_HOME/bin" folder.

2. Edit the setclasspath.sh as explained below:

3. Replace the following block of text:

# Set standard commands for invoking Java.

_RUNJAVA="$JRE_HOME"/bin/java

if [ "$os400" != "true" ]; then

_RUNJDB="$JAVA_HOME"/bin/jdb

With:

# Set standard commands for invoking Java.

_RUNJAVA="$JAVA_BIN"/java

if [ "$os400" != "true" ]; then

_RUNJDB="$JAVA_BIN"/jdb

4. If the Tomcat server is already running, it requires a re-start after the above configuration is done.
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Note: In case tomcat is installed under different Unix profile, set JAVA_BIN environment variable    in 
.profile to include the Java Runtime Environment absolute path.

For example:

export JAVA_BIN /usr/java6_64/jre/bin
export JAVA_BIN = /usr/java6_64/jre/bin//sparcv9 for Solaris Sparc.

Configure Servlet Port

The default servlet port configured for the Tomcat installation is 8080. Ignore this section if you need to use the default 
port.

If you need to use a different port number, you must first configure the port in the "server.xml" in the "conf" directory 
of Tomcat Installation directory. The following steps guide you through the configuration process:

1. Navigate to $CATALINA_HOME/conf. Open server.xml and locate the tag:

"Define a non-SSL HTTP/1.1 Connector on port 8080 " 

2. Against this tag, a parameter is specified 'Connector port = "8080" '. Edit this value to the new port number that will 

be used during the installation process. 

3. Save your changes in "server.xml".

Note: Make a note of the servlet port configured. This information is required during the installation of 
OFSAA Application Pack.

SSL Port Configuration

If you need to configure and access your OFSAA setup for HTTPS access, ensure that the following connect tag under 
"Define a SSL HTTP/1/1 Connector on port 8443" in "<Tomcat_installation_folder>/conf/server.xml" file is 
uncommented for SSL Configuration. (By default, it is commented).

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"

maxThreads="150" scheme="https" secure="true"

clientAuth="false" sslProtocol="TLS"

Note: Make a note of the servlet port configured. This information would be required during the 
installation of OFSAA Application Pack. To enable https configuration on Infrastructure, assign value 1 to 
"HTTPS_ENABLE" in OFSAAI_InstallConfig.xml for SILENT mode OFSAAI installation.

For more information related to SSL Configuration on Tomcat, see http://tomcat.apache.org/.
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Apache Tomcat Memory Settings

To configure the Apache Tomcat Memory Settings:

1. Locate the file catalina.sh which resides in the folder <CATALINA_HOME>/bin.

2. Edit this file for customizing the memory settings and garbage collector settings depending on the available hardware 

configuration.

3. Add the memory setting for Java Heap to -Xms512m -Xmx1024m.

Example:

if [ -z "$LOGGING_MANAGER" ]; then

JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m

-Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager"

else

JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m $LOGGING_MANAGER"

Fi

Uninstalling WAR Files in Tomcat

To uninstall WAR files in tomcat, see Uninstalling WAR Files in Tomcat.

Configuration for Axis API

This step is optional and required only if the web application server used in Apache Tomcat. If you use any other web 
application server, skip and proceed to next step.

Copy the jaxrpc.jar from the <OFSAA Installation Directory>/axis-1_4/webapps/axis/WEB-INF/lib and place it in under 
<Tomcat Installation Directory>/lib and restart the Tomcat Server.

Additional Configurations for Tomcat

To stop generating static content with one print statement per input line, you need to configure the web.xml file.

To configure web.xml file, perform the following steps:

1. Navigate to tomcat/conf folder.

2. Edit web.xml file as explained below:

Set the mapped file parameter to False in the servlet tag mentioned with

<servlet-name>jsp</servlet-name>.

<init-param>

<param-name>mappedfile</param-name>

<param-value>false</param-value>

</init-param>
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Configuring Work Manager in Web Application Servers

Process Modelling framework requires creation of Work Manager and mapping it to OFSAA instance. This configuration is 
required for WebSphere and WebLogic Web Application Server types.

This section covers the following topics:

 Configuring Work Manager in WebSphere Application Server

 Configuring Work Manager in WebLogic Application Server

Configuring Work Manager in WebSphere Application Server

This section is applicable only when the Web Application Server type is WebSphere.

This section covers the following topics:

 Creating Work Manager

 Mapping Work Manager to OFSAA WebSphere Instance

Creating Work Manager

1. Open the WebSphere admin console in the browser window: http://<ipaddress>:<administrative console 

port>/ibm/console. (https if SSL is enabled). The Login window is displayed.

2. Login with the user id that has admin rights. 
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3. From the LHS menu, expand Resources > Asynchronous beans and select Work Managers.

4. Select the required Scope from the drop-down list. 

For example, Node=whf00aqnNode01, Server=server1.

5. Click New in the Preferences section.
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6. Enter the Name as 'wm' and JNDI name as 'wm/WorkManager ' in the respective fields. 

7. Enter the Thread pool properties.

8. Click Apply.
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9. Click Save. 

After creating work manager successfully, you have to map it to OFSAA instance.
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Mapping Work Manager to OFSAA WebSphere Instance

1. From the LHS menu, expand Applications > Application Types and select WebSphere enterprise applications.

2. Click OFSAAI instance hyperlink.
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3. Click Resource references link under References section.
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4. Click Browse corresponding to the Work Manager Resource Reference. The available resources are displayed.

5. Select the newly created Work Manager ('wm') and click Apply.

6. Select the Work Manager ('wm/WorkManager') and click OK.
104 Oracle Financial Services Profitability Management Application Pack Installation Guide



Configuring Work Manager in Web Application Servers
Chapter 6—Post Installation Configuration
7. Click Save.
Oracle Financial Services Profitability Management Application Pack Installation Guide 105



Configuring Work Manager in Web Application Servers
Chapter 6—Post Installation Configuration
Configuring Work Manager in WebLogic Application Server

This section is applicable only when the Web Application Server type is WebLogic.

1. Open the WebLogic admin console in the browser window: http://<ipaddress>:<administrative console 

port>/console. (https if SSL is enabled). The Welcome window is displayed.

2. Login with the user id that has admin rights. 

3. From the Domain Structure menu in the LHS, expand Environment and select Work Managers. The Summary of Work 

Managers window is displayed.

4. Click New to create a new work manager component.
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5. Select Work Manager and click Next. 

6. Enter the Name as 'wm/WorkManager'.

7. Click Next.
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8. Select the required deployment target and click Finish.
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Creating and Deploying EAR/WAR File

This section includes the following topics:

 Creating EAR/WAR File

 Deploying EAR/WAR File

Creating EAR/WAR File

To create EAR/WAR File, follow these steps:

1. Navigate to the $FIC_WEB_HOME directory on the OFSAA Installed server.

2. Execute  ./ant.sh to trigger the creation of EAR/ WAR file. 

3. On completion of the EAR files creation, the "BUILD SUCCESSFUL" and "Time taken" message is displayed and you will 

be returned to the prompt.

4. The EAR/ WAR file - <contextname>.ear/ .war - is created. 

Note: The <contextname> is the name given during installation.
This process overwrites any existing version of EAR file that exists in the path.
In case of OFSAA configured onTomcat installation, <contextname>.war will be created.
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Deploying EAR/WAR File

This section includes the following topics:

 Deploying EAR/WAR Files for WebSphere

 Deploying EAR / WAR File for WebLogic

 Deploying WAR Files on Tomcat

Note: Ensure to clear the application cache prior to the deployment of Application Pack Web Archive. This 
is applicable to all Web Servers (WebSphere, WebLogic, and Tomcat). For more information, see Clearing 
Application Cache section.

Deploying EAR/WAR Files for WebSphere

To deploy WebSphere EAR/WAR File, follow these steps:

1. Start WebSphere Profile by navigating to the path 

"/<Websphere_Installation_Directory>/IBM/WebSphere/AppServer/profiles/<Profile_Name>/bin/" and execute the 

command:

./startServer.sh server1

2. Open the WebSphere admin console in the browser window:

http://<ipaddress>:<administrative console port>/ibm/console. (https if SSL is enabled). The Login 
window is displayed.

Figure 1: Login Window

3. Enter the user credentials with admin privileges and click Log In.

4. From the LHS menu, select Applications and click New Application to display the New Application window.
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Figure 2: New Application

5. Click New Enterprise Application to display the Preparing for the application installation window.

Figure 3: Preparing for the application installation

6. Select Remote File System and click Browse. Select the EAR file generated for OFSAA to upload and install. Click Next. 

Figure 4: Installation Options

7. Select the Fast Path option and click Next to display the Install New Application window.
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Figure 5: Install New Application

8. Enter the required information and click Next to display the Map Modules to Servers window.
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Figure 6: Map Modules to Servers

9. Select the Web Application and click Next to display the Map Resource References to Resources window.

Figure 7: Map Resource References to Resources

10. Map each resource defined in the application to a resource JNDI name defined earlier.

11. Click Modify Resource Authentication Method and specify the authentication method created earlier.

You can specify "config" for FICMASTER resource or "atomic" for atomic resource as the authentication method.

12. Select the OFSAAI Web Application check box and click Next to display the Map Virtual hosts for Web Modules 

window.
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Figure 8: Map Virtual host for Web Modules

13. Select the Web Application check box and click Next to display the Summary page.

Figure 9: Summary

14. Click Finish and deploy the Infrastructure Application on WebSphere.
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15. On successful installation, a message is displayed. Click Save and save the master file configuration. The details are 

displayed in the Master File Configuration window.

To start the application:

1. Expand Applications > Application Type > WebSphere enterprise applications to display the Enterprise Applications 

window.

Figure 10: Enterprise Applications

2. Select the installed application and click Start.

Note: <profile name> is the profile name given while creating the WebSphere profile. 
<cell name> is the cell name given during profile creation. 
<contextname> is the context name given during installation.

Deploying EAR / WAR File for WebLogic

Following are the steps for deploying Infrastructure application that would be created during installation:

1. Navigate to the path <WebLogic Installation directory>/user_projects/domains/<domain name>/bin in the machine in 

which WebLogic is installed.

2. Start WebLogic by executing the command:

./startWebLogic.sh -d64 file

3. Open the URL in the browser window: http://<ipaddress>:<admin server port>/console. (https if SSL is 

enabled). The Sign in window of the WebLogic Server Administration Console is displayed.

Note: Ensure that you have started Infrastructure Server by executing "./reveleusstartup.sh" as 
mentioned in Start Infrastructure section.

4. Log on to the WebLogic Server by entering the user credentials having privileges to deploy the EAR file.

5. From the Domain Structure LHS menu, click Deployments to display the Summary of Deployments window.
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Figure 11: Summary of Deployments

6. Click Install to display the Install Application Assistant window.

7. Select the Exploded EAR directory after browsing to the directory where it is saved and click Next.

Explode EAR File

To explode EAR, follow the below steps:

1. Create the "applications" folder under domain name. For example:

/Bea/user_projects/domains/ <Domain _name>/applications.

2. Create <context_name>.ear folder under "applications" folder. 

3. Copy the <$FIC_WEB_HOME/<context_name>.ear file to 

<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_name>.ear

4. Explode the <context_name>.ear file by executing the command:

jar -xvf <context_name>.ear

5. Delete the <context>.ear and <context>.war files (recently created) 

<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_name>.ear

6. Create a directory <context_name>.war under 

<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_name>.ear

7. Copy <$FIC_WEB_HOME/<context_name>.war file to 

<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_name>.ear/<
context_name>.war

8. Explode the <context_name>.war file by executing the following command to get the directory structure:

jar -xvf <context_name>.war
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Install Application

To install the Application:

1. Open the Install Application Assistant.

Figure 12: Install Application Assistant

2. Click Next.

Figure 13: Install Application Assistant

3. From the Choose targeting style section, select the Install this deployment as an application option and click Next to 

display the Optional Settings window.
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Figure 14: Optional Settings

4. Enter a Name for the deployment if required.

5. Under the Security section, select the DD only option to specify that only roles and policies that are defined in the 

deployment descriptors should be used.

6. Select the I will make the deployment available from the following location option under the Source accessibility 

section.

7. Click Next to continue and display the Deployment Summary window.
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Figure 15: Deployment Summary

8. Select the option Yes, take me to the deployment's configuration screen option and click Finish to display the 

Settings for <Deployment Name> window.
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Figure 16: Settings for <Deployment Name>

9. Review the general configuration details of the deployment. You can also update the configuration of the deployment 

in this window. In the Overview tab you can view the complete deployment configuration.

10. Click Save to update the changes, if any.

11. From the LHS menu, click Deployments to display the Summary of Deployments window.
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Figure 17: Summary of Deployments

12. Select the newly deployed Infrastructure application and click Start > Servicing all requests. Ensure that the 

Infrastructure server is up and running.

Figure 18: Summary of Deployments

13. The State of the deployed application is displayed as Active if started successfully.

Deploying WAR Files on Tomcat

Before deploying the WAR files, ensure that the previously deployed applications of Infrastructure are uninstalled. See 
Uninstalling Previously Deployed WAR Files in Tomcat for the procedure to uninstall the previously deployed Infrastructure 
war files.

On the machine that hosts Tomcat, follow the below steps outlined to deploy Infrastructure application:

1. Copy the <context-name>.war from $FIC_WEB_HOME/<context-name.war> to <Tomcat Installation 

Directory>/webapps/ directory. 
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2. Click Manager App. The Connect to dialog box is displayed.

3. Enter the User Id and Password that has admin rights and click OK. (For user creation in tomcat, see Tomcat User 

Administration. The Tomcat Web Application Manager window is displayed with the list of all the applications 

deployed.
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4. In the Deploy section, enter the Context Path provided during the installation as "/<context-name>".

5. Enter the path where the <context-name>.war file resides (by default 

"$FIC_WEB_HOME/<context-name.war>") in the WAR or Directory URL field and click Deploy.

6. On successful application deployment, a confirmation message is displayed. Start the Tomcat server. For more 

information, see Starting Infrastructure Services.

This appendix gives details about the steps to be performed to access OFSAA Application.

Access the OFSAA Application

1. From a your desktop, open the browser and enter the URL in below format:

<scheme>://<IP address/ hostname>:<port>/<context-name>/login.jsp

For example: https://111.222.333.444:5555/ofsaa/login.jsp

The OFSAA login window is displayed as below:

Figure: OFSAA Login Window

2. With installation of every OFSAA Application Pack, there are two seeded user profiles configured in the system:

 SYSADMN - System Administrator

 SYSAUTH - System Authorizer

Note: For SYSADMN and SYSAUTH, the default password is password0.
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3. Login to the application using the "SYSADMN" User ID. (Note that, there is no "I" in the SYSADMN login USER ID). 

Enter the password that was provided during installation. On the first login, you will be prompted to change the 

password.

OFSAA Landing Page

This section includes the following topics:

 OFSAA Landing Page for Profitability Administrator

 Enabling a Product within an Application Pack

OFSAA Landing Page for Profitability Administrator

On successful authentication, the OFSAA Landing Page is displayed. This is a common landing page for all users until a 
preferred application landing page is set by the user in his preferences. 

The landing page includes multiple tabs and each tab has specific links to OFSAA Infrastructure and/or Application 
modules. The tabs and links are displayed based on the OFSAA Application accessed and the access roles mapped to the 
logged in user.

Each tab contains LHS Menu and RHS Menu. The LHS Menu holds link(s) to modules in a tree structure. The RHS Menu 
holds link(s) to modules in a navigational panel format.

The following tabs are available in the Landing Page:

 Applications tab

 Object Administration tab

 System Configuration and Identity Management tab

Applications tab

This tab lists the various OFSAA Applications that are installed in the OFSAA setup. The Select Application drop-down list 
displays the OFSAA Applications, based on the logged in user and mapped OFSAA Application User Group(s). Links to 
related modules within Applications and Infrastructure are grouped appropriately to maintain a unified experience.
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Object Administration tab

This tab lists the various OFSAA Information Domains created in the OFSAA setup. The Select Information Domain 
drop-down list displays the OFSAA Information Domains based on the logged in user and mapped OFSAA Application User 
Group(s). Links to modules that enable object traceability and migration of objects are grouped in this tab.

System Configuration & Identity Management tab

This tab lists the OFSAA Infrastructure System Configuration and Identity Management modules. These modules work 
across Applications/ Information Domains and hence there are no Application and Information Domain drop-down lists in 
this tab. Links to modules that allow the maintenance of setup installation and identity management tasks are grouped 
together in this tab.

Note: The navigation path differs from Application to Application. That is, based on the selected 
Application, the navigation varies.

For more details on how to operate on each tab, see OFSAAI User Guide available in OHC.

Enabling a Product within an Application Pack

You can also enable a product/ application within an application pack post installation at any point of time.

To enable a product through the application UI, follow these steps:

1. Login to the application as SYSADMN user or any user with System Administrator privileges.

2. Navigate to System Configurations & Identity Management tab, expand Administration and Configuration and 

select System Configuration.

3. Click Manage OFSAA Product License(s) to display the Manage OFSAA Product License(s) window is displayed.

4. Select an Application pack to view the products in it. The products are displayed in the Products in the Application 

Pack grid.
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5. Select the check box to enable a product within the Application Pack which is not enabled during installation.

6. Click VIEW LICENSE AGREEMENT to view the license information. The License Agreement section is displayed.

7. Select the option I ACCEPT THE LICENSE AGREEMENT and click ENABLE. A pop-up message confirmation is displayed 

showing that the product is enabled for the pack.

Note: To use the newly enabled product, you need to map your application users to the appropriate 
product specific User_Group(s) and subsequently, authorize the actions by logging in as System Authorizer.

For more information, see Mapping/Unmapping Users section in the Oracle Financial Services Analytical 
Applications Infrastructure User Guide 8.0. To identify the newly enabled product specific UserGroups/ 
Application Pack specific User_Groups, see the respective Application Pack specific Installation and 
Configuration Guide/ User Manual.
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User Group Mapping

Application specific User Group mappings:

 PFT: 

 Profitability Application Administrator 

 Profitability Application Analyst 

 Profitability Application Auditor 

 FTP:

 Fund Transfer Pricing Application Administrator 

 Fund Transfer Pricing Application Analyst 

 Fund Transfer Pricing Application Auditor

 IPA:

 IPA Administrator

 IPA BI Analyst

 IPA Data Analyst

 RPA:

 RPA Administrator

 RPA BI Analyst

 RPA Data Analyst

 EFPA:

 EFPA Administrator

 EFPA BI Analyst

 EFPA Data Analyst

Create and Deploy the Application Pack Web Archive

On successful installation of the OFSAA Application Pack, the web archive file is automatically generated. However, you 
need to deploy the generated web archive file on the Web Application Server. 

For identifying the location of the generated web archive file and for generating and deploying the web archive file at any 
time later, see Creating and Deploying EAR/WAR File.

Note: See the Oracle Financial Services Forms Manager User Guide for instructions on Creating and 
Deploying the Forms Manager Web Archive.
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Patching Your OFS Profitability Pack Installation

Oracle strongly recommends installing the latest available patch set so as to be up to date with the various releases of the 
OFSAA Infrastructure product.

See http://support.oracle.com for more information on latest releases.
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CHAPTER 7 RPD/ Catalog Deployment, D3 and 
Map View Configuration for OBIEE 
11g

This appendix covers the following sections:

 Deploying Profitability Pack Dashboards and Analytics

 Deploying D3 on OBIEE 11g Server

 Mapview Configuration

 HTML5 Compliance of OBIEE Reports in IE11
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Deploying Profitability Pack Dashboards and Analytics

This section covers the following topics:

 Installing OBIEE Server

 Installing OBIEE Windows Administration Client

 Deploying Profitability Pack Report Analytics

 Deploying EFPA/ IPA/ RPA Application Report Analytics

Installing OBIEE Server

To install Oracle Business Intelligence Enterprise Edition (OBIEE) server, see the Oracle Fusion Middle ware Installation 
Guide for Oracle Business Intelligence11g Release 1 (11.1.1.9.5). After installing Oracle Business Intelligence Enterprise 
Edition (OBIEE) server, get the Enterprise Manager URL, username, password, and OBIEE installed directory from the 
System Administrator.

Note: From the OFS PFT Release 8.0.3.0.0 onwards, the OBIEE version 11.1.1.7.1 will not have support and 
enhancements. All the existing reports work same as the previous versions, but the new developments will 
not function in 11.1.1.7.1 version of OBIEE.

Installing OBIEE Windows Administration Client

To install OBIEE repository administration client for Windows machine, see the Oracle® Fusion Middle ware Installation 
Guide for Oracle Business Intelligence11g Release 1 (11.1.1.9.0).

Deploying Profitability Pack Report Analytics

To deploy Analytic Reports, follow these steps:

1. Stop Oracle Process Manager and Notification Server (OPMN) services by executing the following command:

<OBIEE Installed Directory>/instances/instance1/bin./opmnctl stopall

2. Copy OFS_PFT_PACK.rpd from $FIC_HOME/OFSPFTPACKBI/OBIEE/11.1.1.9.5/ of Web layer to the Windows 

machine.

Note: It is recommended to merge the rpd files by keeping OFS_PFT_PACK.rpd as the base, in order to 
avoid merge errors.

In case of upgrade, the $FIC_HOME/OFSPFTPACKBI folder will have two folders namely, 
$FIC_HOME/OFSPFTPACKBI/OBIEE and $FIC_HOME/OFSPFTPACKBI/OBIEE11G. You can ignore the 
$FIC_HOME/OFSPFTPACKBI/OBIEE11G folder.

3. To configure connection pool of repository, follow these steps:

a. Open the repository using OBIEE Windows administration client.
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Figure 1: OBIEE Windows Administration Client to Open Repository

Figure 2: OBIEE Windows Administration Client to Select Repository from Windows Machine
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b. Enter default repository password as Admin123.

c. In the physical section, expand ‘Customer Insight Database' folder.

Figure 5: OBIEE Windows Administration Client to Open Connection Pool Window

d. Double-click Customer Insight Connection Pool to open the Connection Pool Properties window.

e. Enter the following in Data Source Name text box of Connection Pool Properties window after modifying

<Database Server Host Name> and <Database Name>

(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=<Database Server 
HostName>)(PORT=1521))(CONNECT_DATA=(SERVER=DEDICATED)(SERVICE_NAME=<Database 
Name>)))

f. Enter atomic schema user in User name text box.

g. Enter atomic schema user password in Password text box.

h. Click OK.
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Figure 6: OBIEE Windows Administration Client to modify Connection Pool variables

i. Double-click 'Customer Insight Connection Pool (Init Block)' to open the Connection Pool window.

j. Enter the following in Data Source Name text box of Connection Pool Properties window after modifying

<Database Server Host Name> and <Database Name>

(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=<Database Server 
HostName>)(PORT=1521))(CONNECT_DATA=(SERVER=DEDICATED)(SERVICE_NAME=<Database 
Name>))

k. Enter atomic schema user in User name text box.

l. Enter atomic schema password in Password text box.

m. Click OK.

4. To configure connection pool for EFPA, modify 'OFSEFPA Connection Pool' and 'OFSEFPA Init Block' connection pool 

and set the property which is inside of 'EFPA' folder in the physical section.

5. Click File menu and then click Save.

6. Click Yes on the pop-up message Do you want to check global consistency?

7. Click OK, on the pop-up message Consistency check didn't find any errors, warning or best practices violations.
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Note: Warnings on consistency check can be ignored.

List of Warning Messages:

Business Model Financial Reporting:

[39090] Logical column "Financial Reporting"."Dim - Reporting Period"."Month" has invalid Sort Order column 
'Month Sort'. 

Business Model Management Reporting:

[39090] Logical column "Management Reporting"."Dim - Reporting Period"."Year" has invalid Sort Order column 'Year 
Calendar'.

GLOBAL:

[39092] Presentation level "Retail Performance".."Branch"."Branch Hierarchy"."Region" is first under presentation 
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Retail Performance".."Time"."Time Hierarchy"."Year" is first under presentation hierarchy, 
but logical level it is associated with is not grand total level.

[39092] Presentation level "Retail Performance".."Product"."Product Hierarchy"."Leve20" is first under presentation 
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Income Statement".."Reporting Period"."Time_Hierarchy_Month"."Month" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Income Statement".."Reporting Period"."Time Hierarchy Year_Month"."Year" is first 
under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Ratios".."Reporting Period"."Time_Hierarchy_Month"."Month" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Reporting".."Reporting Period"."Time Hierarchy Month"."Month" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Reporting".."Reporting Period"."Time Hierarchy Year_Month"."Year" is first 
under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet".."Reporting Period"."Time_Hierarchy_Month"."Month" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Reporting".."Reporting Period"."Time Hierarchy"."Year" is first under

presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Institutional Performance".."Time"."Time Hierarchy"."Year" is first under presentation 
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Ratios".."Reporting Period"."Time Hierarchy"."Year" is first under presentation 
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Income Statement".."Reporting Period"."Time Hierarchy"."Year" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet".."Reporting Period"."Time Hierarchy"."Year" is first under presentation 
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Account"."Account"."Gen2,Account" is first under presentation 
hierarchy, but logical level it is associated with is not grand total level.
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[39092] Presentation level "Balance Sheet Planning".."Period"."Period"."Gen2,Period" is first under presentation 
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Years"."Years"."Gen2,Years" is first under presentation 
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Scenario"."Scenario"."Gen2,Scenario" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Entity"."Entity"."Gen2,Entity" is first under presentation 
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Version"."Version"."Gen2,Version" is first under presentation 
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Strategy"."Strategy"."Gen2,Strategy" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Chart of Account"."Chart of Account"."Gen2,Chart of Account" 
is first under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."AttributeValue"."AttributeValue"."Gen2,AttributeValue" is first 
under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Currency"."Currency"."Gen2,Currency" is first under

presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Intercompany Entity Flag"."Intercompany Entity

Flag"."Gen2,Intercompany Entity Flag" is first under presentation hierarchy, but logical level it is associated with is not 
grand total level.

[39092] Presentation level "Balance Sheet Planning".."AssetClass"."AssetClass"."Gen2,AssetClass" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."COA type"."COA type"."Gen2,COA type" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet

Planning".."DelinquenciesExp"."DelinquenciesExp"."Gen2,DelinquenciesExp" is first under presentation hierarchy, 
but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Fee Classification"."Fee Classification"."Gen2,Fee

Classification" is first under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Intercompany COA Flag"."Intercompany COA

Flag"."Gen2,Intercompany COA Flag" is first under presentation hierarchy, but logical level it is associated with is not 
grand total level.

[39092] Presentation level "Balance Sheet Planning".."Sample COA"."Sample COA"."Gen2,Sample COA" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."curr_attrib"."curr_attrib"."Gen2,curr_attrib" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level

[39092] Presentation level "Institutional Performance".."Segment"."Segment Hierarchy"."Type" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.
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Deploying EFPA/ IPA/ RPA Application Report Analytics

Use the following procedure to deploy the EFPA/ IPA/ RPA applications report analytics:

Note: Ensure that Oracle Business Intelligence 11.1.1.9.5 is available.

1. Deploy RPD and webcat file(s).

a. Login to OBIEE - Enterprise Manager URL (http://<ip address>:<port>/em).

 Click on hyperlink 'coreapplication' from 'Business Intelligence' tab on left hand side.

 Under 'coreapplication', select the tab 'Deployment' and in that select sub-tab 'Repository'.

 Click 'Lock and Edit Configuration' button located below title 'coreapplication'. Following screen is displayed.
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b. RPD Deployment: Select 'Browse' button available under 'Upload BI Server Repository' section and select 
OFS_PFT_PACK.rpd file from the local folder. Enter default Repository password Admin123.

c. Web catalog Deployment: Open the analytics OBIEE URL-(http://<ipaddress>:<port>/analytics) and login with the 
credentials.

d. Click "Catalog" link available on the top right corner.

e. Click "Shared Folders" and then "Un-Archive".

f. Browse the path where "OFS_PFT_PACK.catalog" is copied in the local folder. Select the file and click "Open". 
Then click "OK".
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g. Click "Dashboard" and click on any of the reports to ensure that all the reports are available.

2. Restart all services in OBIEE "Enterprise Manager".

3. If you are doing any changes online, then configure ODBC data source to connect to Oracle BI Server as follows:

a. Go To Control Panel > Administrative Tools > Data Sources (ODBC).

b. Select the 'System DSN' tab and click 'Add' Button.

c. Select a driver specific to (Oracle BI Server 11g) and click 'Finish' Button.

d. Enter 'Name' and 'Server' details (Specify the Host Name or IP Address of the BI Server and click 'Next').

e. Enter Oracle BI Server login id and password (Enter User Name and Password created at the time of OBIEE 
installation). Click 'Next'.

f. Click 'Finish'.

4. If RPD deployment is done on Essbase, then modify ESSBASE connection pool and set the properties.
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Deploying D3 on OBIEE 11g Server

This section provides detailed steps to install and configure D3, a visualization framework, which is used in few reports of 
IPA and RPA.

To deploy the D3 on OBIEE 11g server, do the following:

1. Download d3.zip of version 3.5.16 and place it in your local folder.

2. Unzip the d3 folder and move this to analyticsRes in your entitlement server. 

Note: To view the Customer Group Structure report, copy the hashMap.js file from 
$FIC_HOME/OFSPFTPACKBI/OBIEE/ and place it in to the d3 folder under analyticsRes and restart the 
application from the folder.

In case of upgrade, the $FIC_HOME/OFSPFTPACKBI folder will have two folders namely, 
$FIC_HOME/OFSPFTPACKBI/OBIEE and $FIC_HOME/OFSPFTPACKBI/OBIEE11G. You can ignore the 
$FIC_HOME/OFSPFTPACKBI/OBIEE11G folder.

3. Copy the WEB_INF directory from analyticsRes into d3 folder.
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4. Login to web logic server, go to Deployments in your domain structure, click the Lock & Edit button, and then select 

Install. 

5. Once you click on Install button, it will take you to the screen shot below where you will paste the full path to the d3 

directory, check the check box next to d3 (open directory) and click Next.
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6. On the next screen, you'll choose Install this deployment as an application and click Next.

7. On the next screen, select "I will make the deployment accessible from the following location" and click Finish.
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8. On this screen, you will have to click on Activate Changes.

9. After activating the changes, the application will now be in a Prepared state, as in the screen shot below. You will have 

to stop the application by checking the check box next to it and selecting Force Stop Now from the Stop menu.
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10. You can start the application by checking the check box next to it and selecting Servicing all requests from the Start 

menu.

11. The application will now change to an Active state and ready to use.
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Mapview Configuration

This section provides information on prerequisites, creating the mapviewer NAVTEQ data source, configuration edits and 
server starting which is required for viewing map based reports of IPA and RPA.

Note: This is just a sample configuration working on sample data provided by NAVTEQ.

This section covers the following topics:

 Prerequisites

 Creating the Mapviewer NAVTEQ Data source

 Loading FSI_LOCATION_MAP_COORD for viewing NAVTEQ Maps

Prerequisites

NAVTEQ database dump can be imported only into an Oracle 11g database. If you have no other option than using a 10g 
version, contact OBIEE/Mapviewer Product Management.

Creating the Mapviewer NAVTEQ Data source

Ensure that you have a connection to 11g Oracle database from the machine where your OBIEE platform is installed.

Create a NAVTEQ schema within that database for holding the NAVTEQ spatial data.

To create NAVTEQ schema, perform the steps as explained in the following section.

Downloading the Mapviewer NAVTEQ Database Dump

To download the Mapviewer NAVTEQ Database Dump, follow these steps:

1. Access the NAVTEQ Data Bundle for OBIEE from the ‘OBIEE 11.1.1.3 - Sample Application’:

http://www.oracle.com/technetwork/middleware/bi-foundation/obieesamplesarchive-2026956.html 

2. Download and unzip the SampleApp_Navteq_dmp.zip file that contains an Oracle Database export file named:

obiee_navteq.dmp

Creating NAVTEQ User

To create a NAVTEQ user, follow these steps:

1. Start a SQL*Plus session to the Oracle Database as a user with system or DBA privileges.

2. Run the following script:

create user obiee_navteq identified by obiee_navteq default tablespace users quota 
unlimited on users;

grant "connect" to obiee_navteq;

grant "resource" to obiee_navteq;

3. Once the script is executed, verify whether you can connect to the newly created user.
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Note: The OBIEE_NAVTEQ user creation script defaults with the password obiee_navteq (same as user 
name) within the script. It is recommended that you keep this value unchanged to simplify configuration.

Importing the database dmp file

4. Import the Oracle Database export file - obiee_navteq.dmp into the obiee_navteq schema using the following import 

command, from the command line (Command Prompt in Windows):

c:\> imp obiee_navteq/obiee_navteq@connectString file=obiee_navteq.dmp FULL=Y

5. ConnectString is the connection string to your Oracle Database 11g where the user obiee_navteq was created in the 

step mentioned earlier. Wait for the import process to complete, once successfully completed, login on your DB as 

obiee_navteq/obiee_navteq and validate that you can view the schema tables and some data.

Inserting Extra Spatial Metadata

6. Start a SQL*Plus session to the Oracle Database and connect as user obiee_navteq. 

For example: c:\>sqlplus obiee_navteq/obiee_navteq@connectString

7. Run the following script:

INSERT INTO user_sdo_maps SELECT * FROM my_maps;

INSERT INTO user_sdo_themes SELECT * FROM my_themes;

INSERT INTO user_sdo_styles SELECT * FROM my_styles;

INSERT INTO user_sdo_cached_maps SELECT * FROM my_tile_cache;

Commit;

MapViewerConfig.xml Edits

1. Open the Mapviewer console using the following URL:

http://<ip address>:<port>/mapviewer

2. Click Admin.

3. Login with the username/password that you provided while installing the product.

4. Click Configuration. This opens the mapViewerConfig.xml on your setup.

5. Make the following updates to the xml file.

<security_config> (Optional)

In the <security_config> property of this file, make the following changes:

a. Change the <proxy_enabled_hosts> property to the following: Substitute the hostname, IP address and port 

to the correct values on your setup.

<proxy_enabled_hosts>

http://<ip address>:<port>/mapviewer

http://<ip address>:<port>/, http://<ip address>:<port>/

http://<ip address>:<port>/mapviewer

    </proxy_enabled_hosts>

b. Substitute any entries with these tags with the following property entries:

<disable_direct_info_request> true </disable_direct_info_request>

<disable_info_request> true </disable_info_request>
Oracle Financial Services Profitability Management Application Pack Installation Guide 145



Mapview Configuration
Chapter 7—RPD/ Catalog Deployment, D3 and Map View Configuration for OBIEE 11g
<disable_csf>true</disable_csf>

<enforce_security_role> true </enforce_security_role>

Predefined Data Sources

1. At the end of the file, in the section named Predefined Data Source, add the following data source entry.

2. Replace the IP address, SID, and port to the correct values of the database where the obiee_navteq schema has been 

created in the above steps.

<map_data_source name="OBIEE_NAVTEQ_SAMPLE"

jdbc_host="10.229.147.238" (use your db ip)

jdbc_sid="orcl" (use your db sid)

jdbc_port="1521" (use your db port)

jdbc_user="obiee_navteq"

jdbc_password="!obiee_navteq" (use your selected password if different from OOB)

jdbc_mode="thin"

number_of_mappers="3"

allow_jdbc_theme_based_foi="false" />

Note: Ensure that all tags have been closed correctly and also the above data source is not within the 
comments section (ensure that it is outside the comments section which is represented by <!-- .. -->).

3. Click Save and Restart button at the bottom of the file.

4. Once configuration.xml file is restarted, click Data Sources.

5. Verify whether you can view OBIEE_NAVTEQ_SAMPLE as an entry in data sources.

6. Select the radio button OBIEE_NAVTEQ_SAMPLE.

7. Login to Analytic screen > Administration.

8. Click Manage map Data.

9. Click Import Layer and then choose OBIEE_COUNTRY. 

10. Choose Preview MAP as OBIEE_WORLD_MAP_FAST.

11. Same for OBIEE STATE.

12. Select Background Maps.

13. Use import Background maps and chosen OBIEE_WORLD_MAP_FAST.

14. Edit the same, add layer OBIEE COUNTRY and then OBIEE STATE. While choosing, chose the location 

OBIEE_WORLD_MAP for higher Zoom value.

15. Select the zoom level for country 0 and for country 2...15.

16. Navigate back to Layers tab.

17. Edit OBIEE COUNTRY and OBIEE STATE by adding BI Key Columns:

For Country:

a. Choose Institutional Performance>Geography>Country Description.

b. Choose Institutional Performance>Branch>Branch Country Description.

c. Choose Retail Performance>Geography>Country Description.
146 Oracle Financial Services Profitability Management Application Pack Installation Guide



HTML5 Compliance of OBIEE Reports in IE11
Chapter 7—RPD/ Catalog Deployment, D3 and Map View Configuration for OBIEE 11g
For State:

a. Choose Institutional Performance>Geography>State Description.

b. Choose Institutional Performance>Branch>Branch State Description.

c. Choose Retail Performance>Geography>State Description.

Loading FSI_LOCATION_MAP_COORD for viewing NAVTEQ Maps

For NAVTEQ Maps to work, it requires the location data in our atomic schema to be in sync with the map Metadata in 
NAVTEQ schema. This is achieved through a new table FSI_LOCATION_MAP_COORD, the load process of which is 
described as follows.

Populate FSI_LOCATION_MAP_COORD based on DIM_LOCATION data itself, but description and codes should come from 
tables OBIEE_COUNTRY, OBIEE_STATE, OBIEE_CITY (from the DB schema configured for Maps, 'OBIEE_NAVTEQ', for 
example in this case) respectively for Country, State and City, and n_location_skey should be the corresponding 
n_location_skey from DIM_LOCATION.

For Instance, let us consider the following data from DIM_LOCATION.

N_LOCATION_SKEY 1

V_LOCATION_CODE HAW

V_COUNTRY_CODE USA

V_COUNTRY_DESC United States

V_STATE_CODE HI

V_STATE_DESC Hawaii

V_CITY_CODE CITI1

V_CITY_DESC Honolulu

V_ZIP_CODE 96813

Now, to populate the following columns in FSI_LOCATION_MAP_COORD:

n_location_skey = 1

v_country_code = OBIEE_COUNTRY.ISO_COUNTRY_CODE USA

v_country_code_map = OBIEE_COUNTRY.ISO_COUNTRY_CODE USA

v_country_desc = OBIEE_COUNTRY.NAME United States

v_state_code = OBIEE_STATE.ISO_CTRY_CD_STATE_ABBRV USA_HI

v_state_code_map = OBIEE_STATE.ISO_CTRY_CD_STATE_ABBRV USA_HI

v_state_desc = OBIEE_STATE.STATE_NAME HAWAII

v_city_code = OBIEE_CITY.CTRY_CD3_STATE_ABBRV_CITY USA_HI_Honolulu

v_city_code_map = OBIEE_CITY.CTRY_CD3_STATE_ABBRV_CITY USA_HI_Honolulu

v_city_desc = OBIEE_CITY.CITY_NAME HONOLULU

v_zip_code = 96813

HTML5 Compliance of OBIEE Reports in IE11

Perform the following steps in order to verify the HTML5 compliance of OBIEE reports in IE11:

1. Remove the compatibility settings for analytics.
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2. Change the instanceconfig.xml file to make all the chart views to be shown in HTML5 by default.

You can find the instanceconfig.xml file in the following location:

OBIEE_HOME/instances/instance1/config/OracleBIPresentationServicesComponent/coreapplication_obips1

<Charts>

<DefaultWebImageType>html5</DefaultWebImageType>

</Charts>

3. Enable Mapviewer and D3 reports (to ensure that these reports show up as is).

4. Verify all the BI reports by removing the default chart view setting (to ensure that these reports show up as usual 

irrespective of HTML5 or flash web Image formats).

Details on OBIEE11.1.9.5

In a browser that does not support the html5 format, the image renders in the flash format instead (which is also 
interactive).
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CHAPTER 8 RPD/ Catalog Deployment, D3 and 
Map Configuration for OBIEE12c

This chapter covers the following sections:

 Deploying Profitability Pack Dashboards and Analytics

 Deploying D3 on OBIEE 12c Server

 Mapview Configuration for OBIEE 12C
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Deploying Profitability Pack Dashboards and Analytics

This chapter covers the following sections:

 Installing OBIEE Server

 Installing OBIEE Windows Administration Client

 Deploying Profitability Pack Report Analytics

 Deploying EFPA/ IPA/ RPA Application Report Analytics

Installing OBIEE Server

To install Oracle Business Intelligence Enterprise Edition (OBIEE) server, see the Oracle Fusion Middle ware Installation 
Guide for Oracle Business Intelligence Release 12.2.1.2.0. After installing Oracle Business Intelligence Enterprise Edition 
(OBIEE) server, get the Enterprise Manager URL, username, password, and OBIEE installed directory from the System 
Administrator.

Note: Once the OBIEE server is installed, it should be upgraded to the version as mentioned in the 
Environment section.

Installing OBIEE Windows Administration Client

To install OBIEE repository administration client for Windows machine, see the Oracle® Fusion Middle ware Installation 
Guide for Oracle Business Intelligence Release 12.2.1.2.0.

Deploying Profitability Pack Report Analytics

To deploy Analytic Reports, follow these steps:

1. Copy OFS_PFT_PACK.rpd from $FIC_HOME/OFSPFTPACKBI/OBIEE/12.2.1.2.0/ of Web layer to the Windows 

machine.

Note: It is recommended to merge the rpd files by keeping OFS_PFT_PACK.rpd as the base, in order to 
avoid merge errors.

In case of upgrade, the $FIC_HOME/OFSPFTPACKBI folder will have two folders namely, 
$FIC_HOME/OFSPFTPACKBI/OBIEE and $FIC_HOME/OFSPFTPACKBI/OBIEE12C. You can ignore the 
$FIC_HOME/OFSPFTPACKBI/OBIEE12C folder.

2. To configure connection pool of repository, follow these steps:

a. Open the repository using OBIEE Windows administration client. 
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Figure 1: OBIEE Windows Administration Client to Open Repository

Figure 2: OBIEE Windows Administration Client to Select Repository from Windows Machine

b. Enter default repository password as Admin123.
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c. In the physical section, expand ‘Customer Insight Database’ folder.

Figure 5: OBIEE Windows Administration Client to Open Connection Pool Window

d. Double-click Customer Insight Connection Pool to open the Connection Pool Properties window.

e. Enter the following in Data Source Name text box of Connection Pool Properties window after modifying

<Database Server Host Name> and <Database Name>

(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=<Database Server Host 
Name>)(PORT=1521))(CONNECT_DATA=(SERVER=DEDICATED)(SERVICE_NAME=<Database Name>)))

f. Enter atomic schema user in User name text box.

g. Enter atomic schema user password in Password text box.

h. Click OK.
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Figure 6: OBIEE Windows Administration Client to modify Connection Pool variables

i. Double-click 'Customer Insight Connection Pool (Init Block)' to open the Connection Pool window.

j. Enter the following in Data Source Name text box of Connection Pool Properties window after modifying

<Database Server Host Name> and <Database Name>

DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=<Database Server Host 
Name>)(PORT=1521))(CONNECT_DATA=(SERVER=DEDICATED)(SERVICE_NAME=<Database Name>)))

k. Enter atomic schema user in User name text box.

l. Enter atomic schema password in Password text box.

m. Click OK.

n. To configure connection pool for EFPA, modify 'OFSEFPA Connection Pool' and 'OFSEFPA Init Block' connection 
pool and set the property which is inside of 'EFPA' folder in the physical section.

3. Click File menu and then click Save.

4. Click Yes on the pop-up message Do you want to check global consistency?

5. Click OK, on the pop-up message Consistency check didn't find any errors, warning or best practices violations.
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Note: Warnings on consistency check can be ignored.

List of Warning Messages:

GLOBAL:

[39092] Presentation level "Retail Performance".."Branch"."Branch Hierarchy"."Region" is first under presentation 
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Retail Performance".."Time"."Time Hierarchy"."Year" is first under presentation hierarchy, 
but logical level it is associated with is not grand total level.

[39092] Presentation level "Retail Performance".."Product"."Product Hierarchy"."Leve20" is first under presentation 
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Income Statement".."Reporting Period"."Time_Hierarchy_Month"."Month" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Income Statement".."Reporting Period"."Time Hierarchy Year_Month"."Year" is first 
under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Ratios".."Reporting Period"."Time_Hierarchy_Month"."Month" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Reporting".."Reporting Period"."Time Hierarchy Month"."Month" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Reporting".."Reporting Period"."Time Hierarchy Year_Month"."Year" is first 
under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet".."Reporting Period"."Time_Hierarchy_Month"."Month" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Reporting".."Reporting Period"."Time Hierarchy"."Year" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Institutional Performance".."Time"."Time Hierarchy"."Year" is first under presentation 
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Ratios".."Reporting Period"."Time Hierarchy"."Year" is first under presentation 
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Income Statement".."Reporting Period"."Time Hierarchy"."Year" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet".."Reporting Period"."Time Hierarchy"."Year" is first under presentation 
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Account"."Account"."Gen2,Account" is first under presentation 
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Period"."Period"."Gen2,Period" is first under presentation 
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Years"."Years"."Gen2,Years" is first under presentation 
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Scenario"."Scenario"."Gen2,Scenario" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Entity"."Entity"."Gen2,Entity" is first under presentation 
hierarchy, but logical level it is associated with is not grand total level.
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[39092] Presentation level "Balance Sheet Planning".."Version"."Version"."Gen2,Version" is first under presentation 
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Strategy"."Strategy"."Gen2,Strategy" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Chart of Account"."Chart of Account"."Gen2,Chart of Account" 
is first under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."AttributeValue"."AttributeValue"."Gen2,AttributeValue" is first 
under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Currency"."Currency"."Gen2,Currency" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Intercompany Entity Flag"."Intercompany Entity 
Flag"."Gen2,Intercompany Entity Flag" is first under presentation hierarchy, but logical level it is associated with is not 
grand total level.

[39092] Presentation level "Balance Sheet Planning".."AssetClass"."AssetClass"."Gen2,AssetClass" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."COA type"."COA type"."Gen2,COA type" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet 
Planning".."DelinquenciesExp"."DelinquenciesExp"."Gen2,DelinquenciesExp" is first under presentation hierarchy, 
but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Fee Classification"."Fee Classification"."Gen2,Fee 
Classification" is first under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Intercompany COA Flag"."Intercompany COA 
Flag"."Gen2,Intercompany COA Flag" is first under presentation hierarchy, but logical level it is associated with is not 
grand total level.

[39092] Presentation level "Balance Sheet Planning".."Sample COA"."Sample COA"."Gen2,Sample COA" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."curr_attrib"."curr_attrib"."Gen2,curr_attrib" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Institutional Performance".."Segment"."Segment Hierarchy"."Type" is first under 
presentation hierarchy, but logical level it is associated with is not grand total level.

[39051] Application Role "BIAdministrator" is not defined in the Enterprise Manager.

[39051] Application Role "BIAuthor" is not defined in the Enterprise Manager.

[39051] Application Role "Relationship Manager" is not defined in the Enterprise Manager.

[39051] Application Role "Sales Representative" is not defined in the Enterprise Manager.

[39051] Application Role "Business Analyst" is not defined in the Enterprise Manager.
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Deploying EFPA/ IPA/ RPA Application Report Analytics

Use the following procedure to deploy the EFPA/ IPA/ RPA applications report analytics:

Note: Ensure that Oracle Business Intelligence 12.2.1.2.0 is available.

1. Deploy RPD and webcat file(s).

a. Go to Oracle home and create a folder under below mentioned path and move the OFS_PFT_PACK.rpd (with the 

Connection Pool details) from local to this newly created folder (for example: PFT_RPD)

$ORACLE_HOME/user_projects/domains/bi

b. Go to the location of datamodel.sh . that is $ORACLE_HOME/ user_projects/domains/bi/bitools/bin/

c. Execute the following command:

./datamodel.sh uploadrpd -I rpdLocationPath -SI ssi -U username -P password

Replace rpdLocationPath with where you placed the rpd (for example: 
$ORACLE_HOME/user_projects/domains/bi/ PFT_RPD/OFS_PFT_PACK.rpd), username/ password with the 
analytics username and password.

d. Web catalog Deployment:

 Copy OFS_PFT_PACK.catalog from $FIC_HOME/OFSPFTPACKBI/OBIEE/12.2.1.2/ and paste in a local 
folder.

Open the analytics OBIEE URL-(http://<ipaddress>:<port>/analytics) and login with the credentials.

e. Click "Catalog" link available on the top right corner.

f. Click "Shared Folders" and then "Un-Archive".
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g. Browse the path where "OFS_PFT_PACK.catalog" is copied in the local folder. Select the file and click "Open". 
Then click "OK".

h. Click "Dashboard" and click on any of the reports to ensure that all the reports are available.
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2. Restart all services in OBIEE "Enterprise Manager" This is optional.

3. If you are doing any changes online, then configure ODBC data source to connect to Oracle BI Server as follows:

a. Go To Control Panel > Administrative Tools > Data Sources (ODBC).

b. Select the 'System DSN' tab and click 'Add' Button.

c. Select a driver specific to (Oracle BI Server 12c) and click 'Finish' Button.

d. Enter 'Name' and 'Server' details (Specify the Host Name or IP Address of the BI Server and click 'Next').

e. Enter Oracle BI Server login id and password (Enter User Name and Password created at the time of OBIEE 
installation). Click 'Next'.

f. Click 'Finish'.

4. If RPD deployment is done on Essbase, then modify ESSBASE connection pool and set the properties.
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Deploying D3 on OBIEE 12c Server

This section provides detailed steps to install and configure D3, a visualization framework, which is used in few reports of 
IPA and RPA.

To deploy the D3 OBIEE 12c server, do the following:

1. Download d3.zip of version 3.5.16 and place it in your local folder.

2. Create analyticsRes folder under below mentioned path:

$ORACLE_HOME /user_projects/domains/

3. Unzip the d3 folder and move this to analyticsRes in your entitlement server.

Note: To view the Customer Group Structure report, copy the hashMap.js file from 
$FIC_HOME/OFSPFTPACKBI/OBIEE/ and place it in to the d3 folder under analyticsRes and restart the 
application from the folder.

In case of upgrade, the $FIC_HOME/OFSPFTPACKBI folder will have two folders namely, 
$FIC_HOME/OFSPFTPACKBI/OBIEE and $FIC_HOME/OFSPFTPACKBI/OBIEE12C. You can ignore the 
$FIC_HOME/OFSPFTPACKBI/OBIEE12C folder.

4. Create WEB-INF folder inside d3 folder and place a web.xml file with the content as given below:

<?xml version="1.0" encoding="UTF-8"?>

<web-app xmlns="http://java.sun.com/xml/ns/javaee"

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xsi:schemaLocation="http://java.sun.com/xml/ns/javaee/web-app_2_5.xsd"

version="2.5">

   <mime-mapping>

      <extension>xsd</extension>

      <mime-type>text/xml</mime-type>

</mime-mapping>

<mime-mapping>

      <extension>xml</extension>

      <mime-type>text/xml</mime-type>

</mime-mapping>

<mime-mapping>
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<extension>js</extension>

<mime-type>text/javascript</mime-type>

</mime-mapping>

<mime-mapping>

<extension>css</extension>

<mime-type>text/css</mime-type>

</mime-mapping>

<mime-mapping>

<extension>png</extension>

<mime-type>image/png</mime-type>

</mime-mapping>

<mime-mapping>

<extension>swf</extension>

<mime-type>application/x-shockwave-flash</mime-type>

   </mime-mapping>

</web-app>
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5. Login to web logic server, go to Deployments in your domain structure, and then select Install. 

6. Once you click on Install button, it will take you to the screen shot below where you will paste the full path to the d3 

directory, check the check box next to d3 (open directory) and click Next.
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7. On the next screen, you'll choose Install this deployment as an application and click Next.

8. On the next screen, click bi_cluster, and then select ‘All servers in the cluster’ radio button.
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9. On the next screen, select "I will make the deployment accessible from the following location" and click Finish.
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10. On this screen, you will have to click on Activate Changes.

11. After activating the changes, the application will now be in a Prepared state, as in the screen shot below. Click on 

Control tab. The screen displays all the installed applications. You will have to stop the application by checking the 

check box next to it and selecting Force Stop Now from the Stop menu.
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12. You can start the application by checking the check box next to it and selecting Servicing all requests from the Start 

menu.

13. The application will now change to an Active state and ready to use.
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Mapview Configuration for OBIEE 12C

This section provides information on prerequisites, creating the mapviewer mvdemo2 data source, configuration edits and 
server starting.

Note: This is just a sample configuration working on sample data provided by mvdemo2.

This section covers the following topics:

 Prerequisites

 Creating the Mapviewer mvdemo2 Data source

 Loading FSI_LOCATION_MAP_COORD for viewing mvdemo2 Maps

Prerequisites

The mvdemo2 database dump can be imported only into an Oracle 12c database. If you have no other option than using a 
11g version, contact OBIEE/Mapviewer Product Management.

Creating the Mapviewer mvdemo2 Data source

Ensure that you have a connection to 12c Oracle database from the machine where your OBIEE platform is installed.

Create a mvdemo2 schema within that database for holding the mvdemo2 spatial data.

To create mvdemo2 schema, perform the steps as explained in the following section.

Downloading the Mapviewer mvdemo Database Dump

To download the Mapviewer mvdemo2 Database Dump, follow these steps:

1. Download MVDEMO Sample Data Set from the following location:

http://www.oracle.com/technetwork/middleware/mapviewer/downloads/index.html

2. Download and unzip the mvdemo_naturalearth.zip file that contains an Oracle Database export file named:

mvdemo_naturalearth.dmp

Creating mvdemo2 User

To create a mvdemo2 user, follow these steps:

1. Start a SQL*Plus session to the Oracle Database as a user with system or DBA privileges.

2. Run the following script:

create user mvdemo2 identified by mvdemo2 default tablespace users quota unlimited on 
users;

grant "connect" to mvdemo2;

grant "resource" to mvdemo2;

3. Once the script is executed, verify whether you can connect to the newly created user.
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Note: The mvdemo2 user creation script defaults with the password mvdemo2 (same as user name) within 
the script. It is recommended that you keep this value unchanged to simplify configuration.

Importing the database dmp file

4. Import the Oracle Database export file - mvdemo_naturalearth.dmp into the mvdemo2 schema using the following 

import command, from the command line (Command Prompt in Windows):

c:\> imp mvdemo2/mvdemo2@connectString file=mvdemo_naturalearth.dmp FULL=Y

5. ConnectString is the connection string to your Oracle Database 12c where the user mvdemo2 was created in the step 

mentioned earlier. Wait for the import process to complete, once successfully completed, login on your DB as 

mvdemo2/mvdemo2 and validate that you can view the schema tables and some data.

Inserting Extra Spatial Metadata

6. Start a SQL*Plus session to the Oracle Database and connect as user mvdemo2. 

For example: c:\>sqlplus mvdemo2/mvdemo2@connectString

7. Run the following script:

insert into user_sdo_styles select * from styles;

insert into user_sdo_themes select * from themes;

insert into user_sdo_maps select * from basemaps;

insert into user_sdo_cached_maps select * from tilelayers;

commit;

MapViewerConfig.xml Edits

1. Open the Mapviewer console using the following URL:

http://<ip address>:<port>/mapviewer

2. Click Admin.

3. Login with the username/password that you provided while installing the product.

4. Click Configuration. This opens the mapViewerConfig.xml on your setup.

5. In the section named Predefined Data Source, add the following data source entry:

Replace the IP address, SID, and port to the correct values of the database where the mvdemo2 schema has been 
created in the above steps.

<map_data_source name="mvdemo2"

jdbc_host="10.229.147.238" (use your db ip)

jdbc_sid="orcl" (use your db sid)

jdbc_port="1521" (use your db port)

jdbc_user="mvdemo2"

jdbc_password="!mvdemo2" (use your selected password if different from OOB)

jdbc_mode="thin"

number_of_mappers="3"

allow_jdbc_theme_based_foi="false"

editable="false"

/>
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Note: Ensure that all tags have been closed correctly and also the above data source is not within the 
comments section (ensure that it is outside the comments section which is represented by <!-- .. -->).

6. Below the Predefined Data Source, under the catalog data source section, replace OracleMaps with mvdemo2 as 

shown below:

<map_data_source name="mvdemo2"

catalog_dir="../catalogs/oraclemaps_pub"

number_of_mappers="8"

allow_jdbc_theme_based_foi="false"

editable="false"

/>

7. In the section named Map Data Server configs, replace OracleMaps with mvdemo2 as follows:

<mds_config>

<data_source name="mvdemo2">

       <allow_predefined_themes>true</allow_predefined_themes>

       <allow_dynamic_themes>true</allow_dynamic_themes>  

    </data_source>

<!--

    <data_source name="mvdemo">

       <allow_predefined_themes>true</allow_predefined_themes>

       <allow_dynamic_themes>true</allow_dynamic_themes>

<allow>

        <theme>THEME_DEMO_ST*</theme>

        <theme>theme_demo_cities</theme>

      </allow>

<deny>

         <theme>M_ADMIN_AREA1_S01</theme>

      </deny>

</data_source>

  -->

</mds_config>

8. Click Save and Restart button at the bottom of the file.

9. Once configuration.xml file is restarted, click Data Sources.

10. Verify whether you can view mvdemo2 as an entry in data sources.

11. Login to Analytic screen > Administration.

12. Click Manage map Data.

13. Click Import Layer and then choose World_Countries.

14. Choose Preview MAP as ORACLE_MAPS.

15. Same for World_States_Provinces.

16. Choose Preview MAP as ORACLE_MAPS.
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17. Select Background Maps.

18. Use import Background maps and chosen ORACLE_MAPS.

19. Edit the same, add layer World_Countries and then World_States_Provinces. While choosing, chose the location 

ORACLE_MAPS for higher Zoom value.

20. Select the zoom level for country 0 and for country 2...15.

21. Navigate back to Layers tab.

22. Edit World_Countries (select Name as the Layer Key) and World_States_Provinces (select State Province Name as the 

Layer Key) by adding BI Key Columns :

For Country:

a. Choose Institutional Performance > Geography > Country Description.

b. Choose Institutional Performance > Branch > Branch Country Description.

c. Choose Retail Performance > Geography > Country Description.

For State:

a. Choose Institutional Performance > Geography > State Description.

b. Choose Institutional Performance > Branch > Branch State Description.

c. Choose Retail Performance > Geography > State Description.

Loading FSI_LOCATION_MAP_COORD for viewing mvdemo2 Maps

For mvdemo2 Maps to work, it requires the location data in our atomic schema to be in sync with the map Metadata in 
mvdemo2 schema. This is achieved through a new table FSI_LOCATION_MAP_COORD, the load process of which is 
described as follows.

Populate FSI_LOCATION_MAP_COORD based on DIM_LOCATION data itself, but description and codes should come from 
tables OBIEE_COUNTRY, OBIEE_STATE, OBIEE_CITY (from the DB schema configured for Maps, 'mvdemo2', for example 
in this case) respectively for Country, State and City, and n_location_skey should be the corresponding 
n_location_skey from DIM_LOCATION.

For Instance, let us consider the following data from DIM_LOCATION.

N_LOCATION_SKEY 1

V_LOCATION_CODE HAW

V_COUNTRY_CODE USA

V_COUNTRY_DESC United States

V_STATE_CODE HI

V_STATE_DESC Hawaii

V_CITY_CODE CITI1

V_CITY_DESC Honolulu

V_ZIP_CODE 96813

Now, to populate the following columns in FSI_LOCATION_MAP_COORD:

n_location_skey = 1

v_country_code = OBIEE_COUNTRY.ISO_COUNTRY_CODE USA

v_country_code_map = OBIEE_COUNTRY.ISO_COUNTRY_CODE USA

v_country_desc = OBIEE_COUNTRY.NAME United States
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v_state_code = OBIEE_STATE.ISO_CTRY_CD_STATE_ABBRV USA_HI

v_state_code_map = OBIEE_STATE.ISO_CTRY_CD_STATE_ABBRV USA_HI

v_state_desc = OBIEE_STATE.STATE_NAME HAWAII

v_city_code = OBIEE_CITY.CTRY_CD3_STATE_ABBRV_CITY USA_HI_Honolulu

v_city_code_map = OBIEE_CITY.CTRY_CD3_STATE_ABBRV_CITY USA_HI_Honolulu

v_city_desc = OBIEE_CITY.CITY_NAME HONOLULU

v_zip_code = 96813
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CHAPTER 9 FAQs and Error Dictionary

This section of the document consists of resolution to the frequently asked questions and error codes noticed during 
OFSAAI installation.

 Frequently Asked Questions

 Forms Framework FAQs

 Error Dictionary

OFSAAI installer performs all the prerequisite validation check during installation. Any errors encountered in the process is 
displayed with an appropriate Error Code. You can see the Error Dictionary to find the exact cause and resolution to rectify 
the error.
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Frequently Asked Questions

You can refer to the Frequently Asked Questions which has been developed with the interest to help you resolve some of 
the OFSAAI Installation and configuration issues. This intends to share the knowledge of problem resolution to a few of the 
known issues. This is not an official support document and just attempts to share the knowledge of problem resolution to 
a few of the known issues. 

This section includes the following topics:

 OFSAAI FAQs

 Application Pack 8.0.5.0.0 FAQs

OFSAAI FAQs

What are the different components that get installed during OFSAAI?

The different components of OFSAAI are illustrated in Figure 1-2, "Components of OFSAAI".

What are the different modes of OFSAAI installation?

OFSAAI can be installed in two modes, Silent Mode, and GUI mode.

Can the OFSAA Infrastructure components be installed on multi-tier?

No. OFSAA Infrastructure components (ficapp, ficweb, ficdb) cannot be installed on multi-tier. By default, they will be 
installed on single-tier. However, OFSAA Infrastructure can be deployed within the n-Tier architecture where the 
Database, Web Server and Web Application Server is installed on separate tiers.

Is JDK (Java Development Kit) required during installation of OFSAA? Can it be uninstalled after OFSAA installation?

JDK is not required during installation of OFSAA and only a run time is needed for details. Refer to Hardware and 
Software Requirements, Java Runtime Environment section.

Is JRE required during installation of OFSAA? Can it be uninstalled after OFSAAI installation?

Only JRE (Java Runtime Environment) is required during installation of OFSAA and cannot be uninstalled as the JRE is 
used by the OFSAA system to work.

How do I know what is the Operating system, web servers and other software versions that OFSAA supports?

Refer to OFSAA Technology Stack Matrices.

What are the different files required to install OFSAAI?

To install OFSAAI, the following files are required:

 setup.sh.

 envCheck.sh

 preinstallcheck.sh

 VerInfo.txt

 OFSAAInfrastructure.bin

 validatedXMLinputs.jar

 MyResources_en_US.properties

 log4j.xml

 OFSAAI_PostInstallConfig.xml

 OFSAAI_InstallConfig.xml
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 privileges_config_user.sql

 privileges_atomic_user.sql

 XML_Utility.jar

What should I do if I get the following error message during installation, "Execute Permission denied"?

Please check whether all the files provided for OFSAAI installation has execute permissions. 

To give execute permissions, navigate to the path OFSAAI_80000 and execute the command:

chmod 755

"Graphical installers are not."

If error resembles "Graphical installers are not supported by the VM. The console mode will be used instead..." then 
check whether any of the X-windows software has been installed.

Example: Hummingbird Exceed is started and configured to Graphical mode installation.

Note: Type 'xclock' from prompt and this should display clock in graphical mode.

"No Java virtual machine could be…"

If the error message reads "No Java virtual machine could be found from your PATH environment variable. You must 
install a VM prior to running this program", then

 Check whether "java path" is set in PATH variable. See the Table 3-1, "Prerequisite Information" section in this 
document.

 Check whether sufficient temporary space is available.

 Ensure that the movement of OFSAAI Installer text files to the target system is done in the Text mode so that 
setup.sh file does not contain control line feed characters (^M).

What should I do if I get the following error message during installation, "OracleDriver Files Not Found, Please Choose the 
Right Path To Continue"?

Check whether the provided path for Oracle Driver files is correct and whether the user has permissions to access the 
files.

What should I do if I get the following error message during installation, "User must have CREATE TABLE, CREATE VIEW, 
CREATE TRIGGER, CREATE INDEX, CREATE SEQUENCE, CREATE PROCEDURE" even though the oracle schema user created 
has the mentioned privileges?

OFSAAI installer validates the database details provided during installation, so ensure:

 Whether the oracle schema user has the required set of privileges for successful installation.

 Whether the oracle schema user has been created with quota privileges on tablespace to create database 
objects.

See the Table 3-1, " Prerequisite Information" section in this document.

Installation of OFSAAI was completed successfully! What next?

Post the successful completion of OFSAAI installation, one has to perform the Post Installation steps. See Chapter 5, 
"Post Installation Configuration". 
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What is to be done when OFSAAI Installation is unsuccessful?

OFSAAI installer generates log file OFSAAInfrastructure_Install.log in the Infrastructure Installation 
Directory. There is also another log file created in the path configured in Log4j.xml. The logs of any of these reported, 
Warnings/Non Fatal Errors/Fatal Errors/Exceptions should be brought to the notice of the OFSAAI Customer Support. 
It is recommended not to proceed, until the reported problems are adequately addressed.

How do I completely uninstall OFSAAI?

OFSAAI can be completely uninstalled by performing the steps provided in Uninstalling OFSAA Installation in the OFS 
AAAI Installation and Configuration Guide Release 8.0.5.0.0.

Can OFSAAI config and atomic schemas be on different databases?

OFSAAI requires both config and atomic schemas to be present on the same database instance.

How to grant privileges if a new information domain is created?

If you are creating a new information domain, provide a set of privileges (database permissions) to the new Atomic 
schema.

 Log into the database as sys and connect as sysdba user.

 Execute the file privileges_config_user.sql available under $FIC_HOME directory

 Enter the database schema for which you want to grant privileges.

When should I run the MLS utility?

See the Multiple Language Support (MLS) Utility section in OFSAAI Administration Guide available on OHC.

Does OFSAAI support Oracle Linux versions other than 5.5?

OFSAAI supports the Oracle Linux versions from 5.5 up to 5.10 and also from 6.0 and above.

What should I do if I get the following error message on the UNIX System terminal while executing ./setup.sh, "Insert New 
Media. Please insert Disk1 or type its location"?

1.Login as root user on the Unix machine where OFSAAI is getting installed.

23.Navigate to the path /etc/security/. 

24.Edit the file limits.conf to add/edit a row for the UNIX user installing OFSAA:

<Unix User> soft nofile 9216

25.After saving the changes, log in as UNIX user with which OFSAAI is getting installed and execute the command:

ulimit -n

The command should return the value 9216.

How does one verify if the system environment is ready for OFSAAI installation?

To verify the system environment meets the minimum requirements for the installation, a Pre-Install Check utility is 
available within the Install Kit archive file. This utility can also be obtained separately by contacting Oracle Support.

See Verifying System Environment section for additional information. 

How do I know if the installation is completed successfully?

The OFSAA Infrastructure installation performs a post install health check automatically on successful installation of 
the product. To rerun the post install verification at a later time, perform the following steps:

1.Navigate to the path $FIC_HOME (Product Installation Directory).

26.Execute the command:
174 Oracle Financial Services Profitability Management Application Pack Installation Guide

https://docs.oracle.com/cd/E60202_01/pfthomepage.htm


Frequently Asked Questions
Chapter 9—FAQs and Error Dictionary
./piverify.sh

What should one do if the installation in GUI mode is not invoked?

There are set of configuration steps required to be performed during the installation in GUI mode. Verify whether the 
steps mentioned under Configuration for GUI Mode Installation section are done correctly. 

What should one do if there are any exceptions or errors in installation and how to proceed?

1.Please backup the installation logs.

27.Share the backup logs with Oracle support.

What should I do if I get the following error message during OFSAAI installation on Solaris 11 system?

"Error: OFSAAI-1108

ORA-00604: error occurred at recursive SQL level 1

ORA-01882: timezone region not found"

Or

"Time zone cannot be set as null or 'localtime' "

This happens if the time zone is not set, that is NULL or it is set as 'localtime'. Set the environment variable TZ to a 
valid time zone region in the .profile file. For example:

TZ=Asia/Calcutta

export TZ

What should I do if the installation process is abruptly terminated or aborted?

If the installation is abruptly terminated, then the installation process will be incomplete. To recover from this, follow 
the below steps:

1.Drop the DB objects in the config schema created by OFSAAI installation.

28.Open the .profile file and remove the entries made by the OFSAAI installation which are made between the 
comment statements, #Beginning of entries by OFSAA Infrastructure installation and #End of entries by OFSAA 
Infrastructure installation.

29.Delete the OFSAA install directory created by the OFSAAI installer.

30.Perform the OFSAAI installation again. 

Does OFSAA support any other web server types, other than the ones stated in tech matrix and installation guide?

No, all the supported softwares and versions are stated in the OFSAA Technology Stack Matrices.

What should one do if the database connection from connection pool throws an error 

"java.sql.SQLRecoverableException: IO Error: Connection reset"?

This happens while running several database intensive tasks in parallel. To correct this error, add the line 
securerandom.source=file:/dev/./urandom in the java.security configuration file available in 
$JAVA_HOME/jre/lib/security/ path.

Note: This needs to be configured on all the machines or VMs where the OFSAAI components are installed.

If the issue is not resolved even with the above settings, check the MTU (Maximum Transmission Unit) settings on the 
Linux box. For details on MTU settings and updating them, contact your system Administrator.
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What should I do when I get syntax errors/file not found error messages while invoking setup.sh file from my install 
archive?

This could mostly happen:

 When installer was not unzipped correctly or corrupted during unzip.

 setup.sh file which resides within the install archive was not transferred in ASCII or text mode, which could 
have corrupted the file.

To correct this, follow the steps:

1.Copy the installer (in BINARY mode) to the system on which the OFSAA Infrastructure components will be installed.

31.Unzip the installer using the command:

unzip <OFSAAI_Installer>.zip

32.The corrupted setup.sh file would have introduced certain ^M characters into the file. You can remove ^M 
characters from setup.sh file by following the below steps: 

 Login to the server where the installer is copied. 

 Navigate to the directory OFSAAI_80000.

 Open the setup.sh file in the vi editor using the command: vi setup.sh.

 Inside vi editor in Esc mode, type: %s/^M//g

Note: To enter ^M, hold the CTRL key then press V and M in succession.

 Save the setup.sh file by typing: wq! 

Does OFSAA support Oracle DB 11g Standard edition?

The OCI client and the jdbc driver does not change depending on whether it is a standard or enterprise edition. So, 
OFSAAI will work with standard edition as well.

We do not recommend standard edition because it will not scale and does not support partition pack, database 
security vault, or advanced analytics.

What should I do if I get the following error message while executing ./reveleusstartup.sh file on the UNIX System terminal 
"./reveleusstartup.sh: /java: Execute permission denied"?

 Ensure JAVA_BIN environment variable path is set on the "UNIX user" terminal from where the 
reveleusstartup.sh file is invoked.

 Ensure the .profile where the environment/ path settings are made has been executed successfully.

What happens when the OFSAAI Application Server does not proceed even after providing the system password?

Ensure that, the System Password provided when prompted should match with the "Oracle Configuration password" 
provided during installation. Also check whether the connection to the "configuration schema" can be established 
through sqlplus.
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Although the OFSAAI installation has completed successfully, when OFSAAI servers are started, and the application URL is 
accessed, it gives an error message "the page cannot be found or displayed" or "Could not retrieve list of languages from 
Server. Please contact the system administrator". What should one do?

Ensure OFSAAI servers have been started and are running successfully. On the server start up parameters options, see 
the Starting Infrastructure Services section.

For more details on the issue, refer on to the Revappserver log in $FIC_APP_ HOME/common/FICServer/logs directory 
or the Web Server log files.

Is it necessary to provide the specified grants to the Oracle schema user before installation? If yes, can it be revoked after 
completion of installation?

The "Oracle schema" user requires the necessary grants specified before, during, and after the installation process. 
Grants provided should never be revoked as the application makes use of these grants all the time.

Can we have distributed OFSAAI Application Server for load balancing?

OFSAAI Application server can be scaled out/distributed across different JVM's (machines) based on the various 
services and Information Domains, in other words, Load balancing could be achieved with distribution of services.

Why do we need Ftpshare? Why is it needed on all the layers? Can we have ftpshare on another machine other than the 
machines where OFSAAI is installed?

Ftpshare is a Metadata Repository directory. All the Metadata related files used in Infrastructure are stored in the 
ftpshare directory. The ftpshare contains folders for each Information Domain, with each Information Domain folders 
holding Erwin, log, and scripts folder. The transfer of data among the Web, Application, and Database servers in 
Infrastructure takes place through FTP/SFTP.

You need to configure FTP/SFTP and enable communication between the servers by providing App server's FTP/SFTP 
credentials to the Web server and DB server users.

Yes, we can have ftpshare on another machine other than the machines where OFSAAI is installed.

Is it mandatory to provide the ftp/sftp password? 

Yes, OFSAAI needs credentials of the user which has complete permissions on ftpshare directory, and should be able 
to independently login to the UNIX server.

What are the permissions required for ftpshare and when should I give them?

It is recommended to provide permissions on ftpshare in case of installations done across different machines or VMs 
(multi-tier installation).

In case of single tier installation, 770 permissions can be provided if the UNIX users of OFSAAI and web server belong 
to the same UNIX group.

And on any new file that is created in the 'ftpshare' folder of any installation layer should be granted specific/explicit 
permission.

Port Change utility could be used to have the Port number modified, which are currently being used by the 
Infrastructure application. For more information, see Configure Infrastructure Ports section.

Are there any in-built system administration users within OFSAAI Application?

The three in-built system administration users are provided to configure and setup OFSAAI.

 SYSADMN 

 SYSAUTH

 GUEST 
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Does OFSAAI Application support both FTP and SFTP?

OFSAAI supports both FTP and SFTP configuration.

Is it necessary to enable the FTP/SFTP services to use the OFSAAI?

Yes, enabling of FTP/SFTP services and its ports is a prerequisite step towards using the OFSAAI.

OFSAAI Configuration: Unable to save the server details?

Ensure the input User ID, Password, and Share Name are correct.

 Ensure FTP/SFTP services are enabled.

 Have a test FTP/SFTP connection made and confirm if they are successful.

What should I do if I get the following message while creating Information Domain, "Please create a database and then 
create the information domain"?

Information Domain is mapped to only one Database; and thus before the creation of Information Domain, at least 
one database details would need to exist.

What should I do if I get the following message during startup of back-end engine message server, "ConnectToDatabase: 
FatalError, could not connect to the DB server"?

 Verify whether connection to the "configuration schema" can be established through sqlplus.

 Verify "configuration schema" password is modified post installation.

 Ensure oracle database alias name created for oracle instance and oracle service name are same.

 On a multi tier Installation mode, ensure TNSNAME and SID are the same in both the Application and Database 
Layers.

What should I do if I get the following message during the startup of back-end engine message server, "Fatal Error, failed to 
get user ID from LibSmsConnect"?

Ensure Reveleus.sec file exist under the $FIC_HOME/conf directory where the Database components are installed.

Does OFSAAI Application support LDAP authentication?

OFSAAI supports LDAP configuration and authentication.

Does OFSAAI support multiple languages?

Yes, OFSAAI supports multiple languages.

Does OFSAAI provide any data back-up features?

OFSAAI does not have built-in back up facility. External Storage Infrastructure is recommended for back-up.

What kind of security features does the OFSAAI provides?

OFSAAI provides security at:

 Segment Level - Users can access only the segment they are mapped to.

 Application Level - Users can perform an operation only if mapped to appropriate role and functions.

Does OFSAAI have the ability to enforce periodic password change?

OFSAAI provides configurable parameters to define number of days after which the user password would expire and 
then the user is forced to change the password after expiration period.
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What is the password policy followed in OFSAAI?

OFSAAI enforces a minimum password length with a combination of Upper and Lower case characters and 
alpha-numeric strings.

Which version of Erwin Data Modeller does OFSAAI support?

The references to Data Modeler ERwin versions 70, 71, 72, 90, 92 and 96 are provided for the AAI framework to 
support these for backward compatibility. However, the data model-slices shipped with OFS AAAI 8.0.5.0.0 
application packs are compatible with Erwin versions 9.5, 9.6, and 9.7.

Does OFSAAI provide the mechanism to upload Business Data model?

OFSAAI provides two mechanisms for business data model upload:

 Easy to use GUI based Model upload mechanism to upload the Business Data Model through Unified Metadata 
Manager --> Import Model.

 OFSAAI also provides a model upload utility "upload.sh" for uploading the business data model through the 
command line parameter by executing this shell script file under the path 
<FIC_HOME>/ficapp/common/FICServer/bin.

See the section Run Model Upload Utility of the Oracle Financial Services Analytical Applications Infrastructure User 
Guide on OHC for details. 

How do I apply incremental change to the existing model when the Business Data model undergoes a change?

Modified data model can be uploaded into the system and OFSAAI has the ability to compare the changes within the 
data model with respect to the one already present in the system and enables propagation of incremental changes in 
a consistent manner.

What are the different types of uploading a business data Model? 

OFSAAI supports uploading of business data model from client desktop and also by picking up the data model from 
the server location.

Can the OFSAAI "Configuration Schema" password be modified post installation?

The OFSAAI "configuration schema" password can be modified post installation. OFSAAI application stores the 
password in the database and few configuration files, thus any changes to the "configuration schema" password 
would necessitate updating in these. Contact OFSAAI support for more details.

Can the OFSAAI "Atomic Schema" password be modified?

The OFSAAI "Atomic Schema" password can be modified. OFSAAI application stores the atomic schema password in 
the database and few configuration files, thus any change to the atomic schema password would necessitate updating 
the password.

To change the Atomic Schema password, follow the steps:

 Login to OFSAA.

 Navigate to System Configuration > Database Details window. Select the appropriate connection, provide the 
modified password and save.

 Navigate to Unified Metadata Manager > Technical Metadata> Data Integrator > Define Sources window. Update 
the appropriate Source details.

If you are using Apache Tomcat as Web server: 

 Update the <Context> -> Resource tag details in server.xml file from the $CATALINA_HOME/conf folder. (In case 
of Tomcat only Atomic <Resource> will exist). 

 Login to the WebSphere Administration Console from the left side menu.
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 Navigate to Resources >JDBC >Data Sources. A list of data sources will be populated on the right side.

 Select the appropriate Data Source and edit the connection details. (In this case, both Config and Atomic data 
sources need to be modified).

If you are using WebLogic as Web server: 

 Login to the WebLogic Administration Console from the left side menu.

 Under Domain Structure list box, expand the appropriate Domain and navigate to Services > JDBC >Data Sources. 
A list of data sources will be populated on the right side.

 Select the appropriate Data Source and edit the connection details. (In this case, both Config and Atomic data 
sources need to be modified).

Restart the OFSAAI services

Note: If the modified passwords are not updated, OFSAAI logs displays the message ORA-28000: the 
account is locked.

Does the upload of Business Data model depend on Java Memory?

Business data model upload through OFSAAI depends on the Java memory settings on the client and server machines. 
Java memory setting varies with the data model size and the available RAM. Contact OFSAAI support for more details.

Why do the Business Metadata Management screens (Business Processors screen) in User Interface, takes longer time to 
load than other screens?

The Log file in DynamicServices.xml which resides in $FIC_HOME/conf is continuously being updated/refreshed to 
cache Metadata. This can be observed when you are starting reveleusstartup.sh and if any of the log file (Ex: 
SMSService.log) in DynamicServices.xml is being continuously refreshed for longer time.

By default, the Metadata Log file cache size is set to 1000. If the log is being updated beyond this limit, retrospectively 
the preceding entries are overwritten. For example, the 1001th entry is overwritten by deleting the first entry. This 
results in the application screen taking a longer time to load.

Increase the cache size limit in Dynamicservices.xml located at <FIC_HOME>/conf, depending on the currently logged 
count for the specific Metadata.

 Generate the Log report by executing the below query in config schema.

select count(1), t.metadata_name, m.dsn_id

from metadata_master m, metadata_type_master t 

where m.metadata_type = t.metadata_type

group by t.metadata_name, m.dsn_id

 The above query returns a list of codes with their respective Metadata count. You can see 
"metadata_type_master" table to identify the Metadata name.

 View the log report to identify the Metadata which is being updated/refreshed beyond the specified cache size 
limit. Accordingly increase the cache size limit in Dynamicservices.xml depending on the currently logged count 
for the specific Metadata.

For example, if the "MEASURE_CACHE_SIZE" is set to 1000 and total measure reported in log is 1022, increase the 
limit to 2000 (approximately).

 Restart Reveleus/OFSAAI servers (Web and APP) and check the issue.
What should I do if I get OutOfMemoryError while deploying EAR file in WebSphere application server?

The Java memory needs to be increased in ejbdeploy.sh file which is present under <WebSphere Install 
directory>/AppServer/deploytool/itp. For example, 
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$JAVA_CMD \

-Xbootclasspath/a:$ejbd_bootpath \ 

Xms256m -Xmx1024m \

What configurations should I ensure if my data model size is greater than 2GB?

In order to upload data model of size greater than 2GB in OFSAAI Unified Metadata Manager- Import Model, you need 
to configure the required model size in struts.xml file available in the path 
$FIC_WEB_HOME/webroot/WEB-INF/classes.

Note: The size requirements have to be always specified in bytes.

For example, if you need to configure for model size of 2.5GB, then you can approximately set the max size to 3GB 
(3221225472 bytes) as indicated below, in order to avoid size constraints during model upload.

<constant name="struts.multipart.maxSize" value="3221225472"/>

After configuring struts.xml file, generate the application EAR/WAR file and redeploy the application onto your 
configured web application server. For more information on generating and deploying EAR / WAR file, see Creating 
EAR/WAR File and Deploying EAR/WAR File sections.

What should I do if my Hierarchy filter is not reflecting correctly after I make changes to the underlying Hierarchy?

In some cases, the Hierarchy Filters do not save the edits correctly if the underlying Hierarchy has been changed. This 
can occur in hierarchy maintenance, where you have moved a member to another hierarchy branch, and that 
member was explicitly selected in the Filter and is now a child of a node which is already selected in the Filter.

See the Support Note for the workaround.

How do you turn off unused information domains (infodoms) from cache?

Follow the below steps to turn off unused infodoms from cache:

Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation. 

 In the DynamicServices.xml file, identify the section for <Service code="20">. 

 Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1). 

 Repeat the same in the WEB layer too. Generate the application EAR/WAR file and redeploy the application onto 
your configured web application server. For more information on generating and deploying EAR / WAR file, see 
Configuring Web Application Servers.

 Restart the OFSAAI Services (APP and WEB). For more information, see Start/Stop OFSAA Infrastructure Services.

Note: This setting will cache the Infodom Metadata only for the infodoms that get accessed upon user 
login. Infodoms which do not get accessed, will not be cached.

Sample code is pasted below: 

<SERVICE CODE="20" 

CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD" 

SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10"> 

<PARAMETERS> 

<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" /> 
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<PARAMETER NAME="BACKUP_XML" VALUE="1" /> 

<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" /> 

<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" /> 

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" /> 

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" /> 

<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" /> 

</PARAMETERS> 

</SERVICE>

Can I install an Application Pack on an existing Atomic schema/ Information Domain created manually?

No, you cannot install an Application Pack on existing Atomic schema/Information Domain created manually. 
Application Packs can be installed only on Atomic Schemas/Information Domain created using schema creator utility 
and/ or the Application Pack installer.

What should I do if I get the following exception while trying to view the model outputs in Model Outputs screen, "Excep-
tion ->Local Path/STAGE/Output file name (No such file or directory)"?

Ensure you have created a folder "STAGE" under the path mentioned as "Local Path" in the web server details screen. 
This folder needs to be created under the local path on every node, in case of web application server clustering.

What should I do if I get the following exception during OFSAA services startup, "Exception in thread "main" 
java.lang.UnsatisfiedLinkError: net (Not a directory)"?

Ensure the JRE referred in .profile is not a symbolic link. Correct the path reference to point to a physical JRE installed.
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What is the optimized memory settings required for "New" model upload?

The following table lists the optimized memory settings required for "New" model upload.

Upload Options Size of Data Model XML File
X_ARGS_APP ENV Variable in OFSAAI 
APP Layer

Pick from Server 106 MB “-Xms1024m -Xmx1024m

36 MB “-Xms2048m -Xmx2048m

815 MB “-Xms4096m -Xmx4096m

1243 MB “-Xms6144m -Xmx6144m

Model Upload Utility 106 MB “-Xms1024m -Xmx1024m"-Xms2048m 
-Xmx2048m

336 MB “-Xms4096m -Xmx4096m

815 MB “-Xms4096m -Xmx4096m

1243 MB “-Xms6144m -Xmx6144m

Save New Erwin File In Server 106 MB “-Xms1024m -Xmx1024m

336 MB “-Xms2048m -Xmx2048m

“-Xms4096m -Xmx4096m

“-Xms6144m -Xmx6144m

What is the resolution if I get the error - ORA 01792 maximum number of columns in a table or view is 1000 during T2T exe-
cution?

You should apply the below patch set from Oracle. Applicable only for 12c.

https://support.oracle.com/epmos/faces/DocumentDisplay?id=1937782.1 

I did not enable OFS Inline Processing Engine Application license during the installation. However, I have enabled it post 
installation, using the Manage OFSAA Product License(s) in the Admin UI. Are there any other additional configurations 
that I need to do?

Yes. Follow the instructions explained in the OFS Inline Processing Engine Configuration Guide available on OHC.

I get an error when I try to build an Oracle OLAP cube. What should I do? 

Execute the below grant on the appropriate ATOMIC schema 

grant olap_user to &database_username

How do you turn off unused Information Domains (Infodoms) from caching?

Follow these steps to turn off unused infodoms from caching:

 Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation.

 In the DynamicServices.xml file, identify the section for <Service code="20">. 

 Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1). 

 Repeat the same in the WEB layer too. Generate the application EAR/WAR file and redeploy the application onto 
your configured web application server. For more information on generating and deploying EAR / WAR file, see 
Creating EAR/WAR File and Deploying EAR/WAR File sections.

 Restart the OFSAAI Services (APP and WEB). For more information, see the Start/Stop OFSAA Infrastructure 
Services section.
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Note: This setting will cache the Infodom Metadata only for the infodoms that get accessed upon user 
login. Infodoms which do not get accessed, will not be cached. 

Sample code is pasted below: 

<SERVICE CODE="20" 

CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD" 

SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10"> 

<PARAMETERS> 

<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" /> 

<PARAMETER NAME="BACKUP_XML" VALUE="1" /> 

<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" /> 

<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" /> 

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" /> 

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" />

<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" /> 

<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" /> 

</PARAMETERS> 

</SERVICE>

“While creating an Excel Mapping, after specifying the excel worksheet, the target table, and mapping each column in the 
worksheet to a target table, I click SAVE and nothing happens. But when I click CANCEL, a message pops up informing me 
that all changes will be discarded", what is to be done.

Check if the excel mapping creation is done using I.E 8 with JRE 1.4 plug in enabled on machine. If so, upgrade the JRE 
plug in to 1.7+.

Can Multiple OFSAA Infrastructure instances share the same config schema?

No, only one OFSAA environment can be installed using one config schema.

Can Atomic schema be shared?

Yes, it can be shared between two OFSAA instances.
While setting a firewall, which ports should be opened for communication between the Web Server (Apache HTTP Server/ 
Oracle HTTP Server/ IBM HTTP Server) and the Web Application Server (WebSphere/ WebLogic/ Tomcat) for OFSAAI to 
operate properly?
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The OFSAA Servlet port which is same as Web server port should be open. Also the web application port should be 
open.

Can I modify the NLS_LENGTH_SEMANTICS to BYTE from CHAR for the Database where older versions of OFSAA is 
Installed?

Yes, NLS_LENGTH_SEMANTICS can be modified to BYTE from CHAR if you are not intending to use multi language 
support.

Can I install already installed application in a different infodom?

No, it is not possible to install the same application in two different infodoms.

How can I configure the OFSAA application for High Availability?

OFSAA can have active-passive high availability. For more details, see the Configuration for High Availability- Best 
Practices Guide.

I want to configure OFSAA for High Availability that is WebLogic cluster on which OFSAA.ear is deployed and cluster OFSAAI 
processes (such as Reveleus etc) are running. Is this a supported configuration?

High Availability is available for WebLogic cluster and DB level as active-active, but is not available on the application 
side. OFSAA can have active-passive high availability. For more details, see Configuring OFSAA in Clustered 
Environment Guide.

During OFSAA installation should I provide web application server's IP /Hostname and port or web server's IP/Hostname 
and port, if the Apache HTTP Server/ Oracle HTTP Server/ IBM HTTP Server are configured?

If the web server is configured, you should enter the Web Server IP Address/Hostname and Port details during OFSAA 
installation. Here the Servlet port should be same as the Web Server port.

If Web Server is not configured, the Web Application Server's IP Address/ Hostname and Port is required during the 
installation process. Here the Servlet port should be same as the Web application Server port.

Is "ReveleusAdminConsoleAgent" applicable for OFSAAI 8.0.5.0.0 and higher versions?

No, ReveleusAdminConsoleAgent is not applicable starting OFSAAI 7.3.3.0.0. There is a change in the way 
agentservers are managed through AGENTSTARTUP.SH & AGENTSHUTDOWN.SH.

What should I do when the message server process does not open and I get the following error message, "CI18NPro-
vider::CI18NProvider, Error, unable to connect to the config database"?

This error is displayed due to the following reasons:

 The Config Schema password is already expired.

 If the config schema password is going to expire soon and the message like "ORA-28002: the password will expire 
within 6 days" displays while connecting to config schema through sqlplus.

 The Config schema password is Modified.

To resolve the error, re-set the config schema password to the old password. Else, if the config schema password is 
modified to something else then follow the below steps:

 Delete the $FIC_HOME/conf/Reveleus.SEC file.

 Shutdown the OFSAAI App service: cd $FIC_APP_HOME/common/FICServer/bin ./stopofsaai.sh

 Shutdown the OFSAAI App service: cd $FIC_APP_HOME/common/FICServer/bin ./stopofsaai.sh

 Start the Infrastructure Server in foreground directly on the server or through XWindows software using the 
command: ./startofsaai.sh
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 Enter System Password.

 Enter the new Config schema password. The service starts and initializes if it is able to successfully connect to the 
DB and generates the Reveleus.SEC file.

 Post successful startup of the service, if required, the Infrastructure server may be shut down and restarted in the 
background using nohup mode.

What is the mechanism of Log File sizing and backup?

OFSAAI Log files created under $FIC_APP_HOME/common/FICServer/logs & 
<OFSAAI_DEPLOYED_AREA>/<CONTEXT.war>/logs is configurable in RevLog4jConfig.xml.

The default size of the log files (MaxFileSize) is set to max 5000kb & number of max backup log files 
(MaxBackupIndex) retained is set to 5, both of which are configurable. Increasing these parameters to a higher value 
should depend on the server HW configurations and may reduce the performance.

To configure the Logs file size on OFSAA Application server, follow these steps:

 Navigate to $FIC_HOME/conf where OFSAA is installed.

 Edit the following parameters in the file RevLog4jConfig.xml

<param name="file" : Enter the path where the Logs are to be generated.

<param name="MaxFileSize" : Provide the required file size.

<param name="MaxBackupIndex" : Provide the required number of backup files to be created.

Example:

<appender name="REVSERVERAPPENDER" class="org.apache.log4j.RollingFileAppender">

<param name="file" value="$FIC_HOME/ficapp/common/FICServer/logs/RevAppserver.log"/>

<param name="Append" value="true" />

<param name="MaxFileSize" value="5000kb" />

<param name="MaxBackupIndex" value="5" />

<layout class="org.apache.log4j.PatternLayout">

<param name="ConversionPattern" value="[REVELEUSLOG] %m%n"/>

</layout>

</appender>

To configure the Deployed area logs file, follow these steps:

 Navigate to <EAR/WAR Deploy area>/conf folder.

 Repeat step 2 from the above section.

Can we modify the Log file path?

Yes, Log file path is configurable, it can be configured in RevLog4jConfig.xml.default log file path (file) is set by the 
installer. This can be configured to another path.
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Can I point the environment with HTTP enabled to HTTPS after installation and vice versa?

Follow these steps:

 Create SSL related certificates and import to respective servers.

 Enable SSL on a desired Port (example 9443) on your existing and already deployed web application servers.

 Replace the protocol as https and new ssl port (FIC_SERVLET_PORT) configured and in all the URLs specified on 
below files:

$FIC_HOME/ficapp/common/FICServer/conf/FICWeb.cfg and 
$FIC_HOME/ficweb/webroot/conf/FICWeb.cfg

$FIC_HOME/ficapp/icc/conf/WSMREService.properties

$FIC_HOME/ficweb/webroot/conf/ModelExecution.properties

$FIC_HOME/ficdb/conf/MDBPublishExecution.properties

$FIC_HOME/ficdb/conf/ObjAppMap.properties

$FIC_HOME/utility/Migration/conf/WSMigration.properties

$FIC_HOME/utility/WSExecution/conf/WSExecution.properties

$FIC_HOME/EXEWebService/WebSphere/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.wsdl

$FIC_HOME/EXEWebService/Tomcat/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.wsdl

$FIC_HOME/EXEWebService/weblogic/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.wsdl

 Replace XML attribute/Node values as specified on below files:

$FIC_HOME/ficweb/webroot/WEB-INF/web.xml

FIC_WEBSERVER_PORT=9443

FIC_WEBPROTOCOL=https

$FIC_HOME/conf/LookUpServices.xml and 
$FIC_HOME/ficweb/webroot/conf/LookUpServices.xml

PORT="9443" PROTOCOL="https:"

 Login to config schema and execute below SQL command to replace protocol and SSL port.

SQL> update configuration cn set cn.paramvalue='9443' where 
cn.paramname='SERVLET_ENGINE_PORT';

SQL> update configuration cn set 
cn.paramvalue=replace(cn.paramvalue,'http:','https:') where 
cn.paramname='FormsManagerCacheReload';

SQL> update web_server_info ws set ws.servletport='9443',ws.servletprotocol='https';

 Create EAR/WAR file and Re-Deploy.
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What should I do if the sliced data model upload takes a long time to complete?

If the Metadata cache size is set to a lower value than the actual count of each Metadata type (hierarchy, dataset, 
dimension etc), then it gets into performance degrade issues. We have to increase the cache size for each Metadata 
type according to the count in the environment.

Following are the parameters in DynamicServices.xml to be configured depends on the Metadata count in your 
environment.

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000"/>

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000"/>

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000"/>

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="3000"/>

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000"/>

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000"/>

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000"/>

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000"/>

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000"/>

Metadata count can be derived based on the following queries:

select count(1) from metadata_master where metadata_version=0 --- for all metadata

select count(1) from metadata_master where metadata_version=0 and metadata_type=1 --- 
for measure

select count(1) from metadata_master where metadata_version=0 and metadata_type=2 --- 
for Dimension

select count(1) from metadata_master where metadata_version=0 and metadata_type=3 --- 
for HCY

select count(1) from metadata_master where metadata_version=0 and metadata_type=4 --- 
for DATASET

select count(1) from metadata_master where metadata_version=0 and metadata_type=59 
--- for BP's

select count(1) from metadata_master where metadata_version=0 and metadata_type=54 
--- for Alias

select count(1) from metadata_master where metadata_version=0 and metadata_type=5 --- 
for CUBES

select count(1) from metadata_master where metadata_version=0 and metadata_type=856 
--- for Derived Entity

For LDAP authentication, which server connects with the LDAP server, the Application server (where ofsaai is installed), or 
Web Application server (where EAR is deployed)?

For LDAP authentication, the Application server (ficapp) connects with the LDAP server.

The LDAP server in the setup listens on secure protocol ldaps (port 636). I have the root certificate of the LDAP server for 
SSL, and would like to know where to offload this certificate?

You need to import the certificate into the JDK/JVM used by Reveleus server in ficapp layer.
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How to relocate FTPSHARE folder?

You can run the PortC.jar utility. For more details, refer Changing IP/ Host-name, Ports, Deployed Paths of the 
OFSAA Instance section in the OFSAAI Admin Guide available on OHC.

What should I do when an entity containing many attributes (>100 columns) is selected as Source entity and the Data Map-
ping (T2T definition) save operation takes longer than expected with the hourglass in the UI continuously rotating?

The workaround is:

 Locate the web server deployed area webroot/conf/excludeURLList.cfg file.

 Modify the following entries:

[SQLIA]./dataIntegrator/ to [ALL]./dataIntegrator/

[SQLIA]./ETLExtractionServlet to [ALL]./ETLExtractionServlet

 Save the changes and restart the web server.

 Re-save the definition.

Application Pack 8.0.5.0.0 FAQs

What is an Application pack?

An Application Pack is suite of products. For more information, see About Oracle Financial Services Advanced 
Analytical Applications (OFSAA) Application Packs.

Can I get a standalone installer for OFSAAI 8.0?

No. AAI is part of every application pack and installs automatically.

How does OFSAA 8.0 Application pack relate to OFSAA 7.x series?

8.0 is a new major release consolidating all products from OFSAA product suite.

Can existing OFSAA 7.x customers upgrade to OFSAA 8.0 Application Pack? 

There is no upgrade path available. However, we will have migration kit / path for every product to 8.0 application 
pack. Further details will be available with Oracle Support.

Does OFSAA 8.0 Application pack UPGRADE's automatically existing environments?

No. Refer Point 5. OFSAA 8.0 application pack has to be installed in an new environment and subsequently migration 
path / migration kit needs to be run to migrate from 7.x to 8.0. Please note we will have migration path only from the 
previously released version of OFSAA products.

Where can I download OFSAA 8.0 Application Pack?

You can download the OFSAAI 8.0 Application Pack from Oracle Software Delivery Cloud (OSDC).

What are the minimum system and software requirements for OFSAA 8.0 Application Pack?

See the installation guide section Hardware and Software Requirements section.

Is my environment compatible with OFSAA 8.0 Application Pack? 

Environment Check utility performs the task. It is part of install and can also be run separately.

Does OFSAA 8.0 Application Pack is support all Operating systems?

LINUX, AIX, SOLARIS 10, 11. See the Technology Matrix for the technology matrix that OFSAA suite products are/ will 
be qualified on.
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How can I install OFSAA 8.0 Application Pack?

See the Oracle Financial Services Advanced Analytical Infrastructure Installation and Configuration Guide published in 
OHC for the application pack installers.

Does this installation require any Third party Software?

Oracle Financial Services Advanced Analytical Infrastructure Installation And Configuration Guide published in OHC 
lists the third party software that needs to be installed.

What languages are supported during OFSAA 8.0 Application Pack installation?

US English is the language supported.

What mode of installations OFSAA Application Pack supports? [i.e., Silent, GUI]

OFSAA Application Packs supports both, GUI and Silent Mode.

Does OFSAA 8.0 Application Pack support Multi tier Installations?

OFSAA 8.0 does single tier installation. For more information see the OFSAAI FAQs section.

Does this Application Pack validate all Prerequisites required for this installation i.e., Memory, Disk Space etc.?

Yes. The prerequisite checks are done by the respective application pack installer. 

What happens if it aborts during installation of any application with in Application pack?

You must restore the system and re-trigger the installation.

Does this Application pack 'Rolls Back' if any of application installation fails due to errors?

Rollback of installation is not supported.

Does the Application pack installs all applications bundled?

All application pack file system files are installed but there is an option to enable the licensed products.

How can I re-install any of the Application Pack?

You can re-trigger if there is a failure.

Does Application pack allow enabling / disabling any of the applications installed?

Yes. You cannot disable once the product is enabled in an environment.

I have installed one application in an Application pack and can I install any of new applications within the Application pack 
later point of time?

No, installation of additional applications is not required. If you wish to add an application later, you can enable the 
application at that time.

How many OFSAA Infrastructures can be installed in a single server?

There is no issue in installing separate OFSAAI installations, each with their own PFT/FTP installations and separate 
associated database instances and separate Web Server installations on the same server as long as adequate memory 
is allocated for each instance and as long as each OFSAAI installation is installed using a separate UNIX user and 
profile. Care should be taken if running multiple OFSAAI installations on a single server. Adequate memory will be 
required for each installation as several OFSAAI processes (model upload, DEFQ services, etc) take significant amounts 
of memory. So it depends on your server memory.
190 Oracle Financial Services Profitability Management Application Pack Installation Guide

https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm


Frequently Asked Questions
Chapter 9—FAQs and Error Dictionary
Is it possible to Install OFSAA 8.0 Application pack on any one of the existing 'Infodom' where another OFSAA 8.0 
application is installed?

Yes. However, the Behavioral Detection Application Pack and Compliance Regulatory Reporting Application Pack are 
the exceptions. They need to be installed in a different INFODOM.

Can I select an Infodom in Application pack during installation?

Yes. You can select or change the required infodom. 

Can I install all Application Packs in a 'Single Infodom'?

Yes. But Behavioral Detection Application Pack and Compliance Regulatory Reporting Application Pack are the 
exceptions. They need to be installed in a different INFODOM.

Is it possible to install applications on different Infodom within the Application pack? (That is if you want to install LRM & 
MR in two infodoms)

Applications within application pack have to be installed in the same information domain in the same environment.

How many Infodoms can be created over a single OFSAA Infrastructure of 8.0.1.0.0?

You can install only one infodom during installation. But after installation, you can create multiple infodoms.

Does 'Data Model' bundled is Application pack Specific or Specific to individual application?

A merged data model for all applications within the application pack is bundled and uploaded.

Is it possible to install OFS Enterprise Modeling in later point of time?

OFS Enterprise Modeling is a separate product and can be enabled as an option later from any application pack that 
bundles Enterprise Modeling.

Does Application pack create sandbox automatically for the required applications?

Yes, Sandbox creation is part of application install process.

Are upgrade Kits available for individual applications or the complete Application Pack?

Maintenance Level (ML) Release / Minor Release upgrades are available across all applications.

Can I upgrade AAI only?

Yes, you can upgrade AAI alone.

Can I upgrade one application within the Application Pack? (For example, I want to upgrade LRM in the Treasury Applica-
tion pack, but not MR.)

No. Not possible Upgrade is applied across packs.

Is it possible to uninstall any Application from the Application pack?

No, it is not possible to uninstall any Application from the Application Pack.

Can I uninstall entire Application Pack?

No, you cannot uninstall the Application Pack.

Is it possible to uninstall only application and retain AAI in the installed environment?

No, you cannot uninstall only the application and retain AAI in the installed environment.
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Can I uninstall entire Application Pack?

No, you cannot uninstall the Application Pack.

Is it possible to uninstall only application and retain AAI in the installed environment?

No, you cannot uninstall only the application and retain AAI in the installed environment.

Does Application Pack contain all Language Packs supported?

Language Packs need to be installed on 8.0 application packs.

Can I install an Application Pack over another Application Pack (that is same infodom or different infodom)?

Yes, you can install an Application Pack over another Application Pack in the same information domain or different 
information domain. But Behavior Detection Application Pack and Compliance Regulatory Reporting Application Pack, 
Asset Liability Management Application Pack and Profitability Application Pack are the exceptions. They need to be 
installed in a different INFODOM.

Can I use an existing manually created schema as information domain for application pack installation?

No. Schemas required by OFSAA applications have to be created using Schema Creator Utility.

Does OFSAA 8.0 support on WebLogic 10.3.6 with Oracle 12c?

Yes, OFSAA 8.0 will support on WebLogic 10.3.6 with Oracle 12c. WebLogic 10.3.6 supports oracle 12c with some 
additional configurations. See the link 
http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655 for additional configurations.

What should I do if I get the following error message while running the schema creator utility, "HostName in input xml is 
not matching with the local hostname"?

One possible reason could be the machine is configured for zonal partitioning. Ensure all the known IP Addresses of 
the machine are present in the /etc/hosts file.

What are the Java versions supported in OFS ALM Application Pack version 8.0.5.0.0?

OFS ALM Application Pack supports 1.7.x and 1.8.x.

Is this release of the OFS ALM Application Pack version 8.0.5.0.0 supported on Java 8? 

Yes. To install this release of the OFS ALM Application Pack version 8.0.5.0.0 on Java 8. For more information, refer to 
specific notes mentioned in the sections Installer and Installation Prerequisites

Configurations supported for Java 8. Configuring the Schema Creator Utility, GUI Mode Installation, SILENT Mode 
Installation.
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Forms Framework FAQs

What should I do when I have large volume of data to be exported?

It is recommended to use BIP reports or OBIEE reports if you have to export large volume of data.

How do I export the columns added to the grid by Field Chooser option?

Perform Grid Export operation to export the columns added to the grid by Field Chooser option.

'Expand All/ Collapse All' button is not visible in the Hierarchy Browser window. What should I do?

Expand All/ Collapse All button is enabled only if the number of hierarchy nodes is less than 50. If it is more than that, 
it is considered as large hierarchy and the data will be fetched dynamically when you expand each node.

Error Dictionary

This contents of this section has been created with the interest to help you resolve the installation issues if any. There is a 
compilation of all the possible errors that might arise during the installation process with the possible cause and the 
resolution to quickly fix the issue and proceed further with the installation.

This section includes the following topics:

 Accessing Error Dictionary

 Error Code Dictionary

Accessing Error Dictionary

Instead of scrolling through the document to find the error code, you can use the pdf search functionality. In the "Find" 
dialog available in any of the Adobe Acrobat version that you are using to view the pdf document, follow the below 
instructions to quickly find the error resolution.

1. With the Installation pdf open, press Ctrl+F or select Edit > Find.

33. The Find dialog is displayed as indicated.

34. Enter the error code that is displayed on screen during Infrastructure installation.

35. Press Enter. The search results are displayed and highlighted as indicated below.

View the details of the issues, its cause, and resolution specific to the error code. Repeat the step to find an answer to any 
other errors that you notice during installation. If you are not able to resolve the issue even after following the steps pro-
vided in resolution, you can contact support.oracle.com along with log files and appropriate screen shots.
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Error Code Dictionary

Error Code Cause Resolution

OFSAAI-1001 Unix shell is not "korn" shell. Change the shell type to "korn". Use chsh UNIX 
command to change SHELL type.

Shell type can also be changed by specifying shell 
path for the Unix user in /etc/passwd file.

Note: chsh command is not available in Solaris OS.

OFSAAI-1002 No proper arguments are available. Provide proper arguments. Invoke Setup.sh using 
either SILENT or GUI mode.

Example: ./Setup.sh SILENT or ./Setup.sh GUI

OFSAAI-1004 File .profile is not present in 
$HOME.

Create .profile in $HOME, i.e. in the home directory 
of user.

OFSAAI-1005 File OFSAAInfrastructure.bin is not 
present in current folder.

Copy OFSAAInfrastructure.bin into installation kit 
directory.

OFSAAI-1006 File CustReg.DAT is not present in 
current folder.

Copy CustReg.DAT into installation kit directory.

OFSAAI-1007 File OFSAAI_InstallConfig.xml is not 
present in current folder.

Copy OFSAAI_InstallConfig.xml into installation kit 
directory.

OFSAAI-1008 File validateXMLInputs.jar is not 
present in current folder.

Copy validateXMLInputs.jar into installation kit 
directory.

OFSAAI-1009 File log4j.xml is not present in 
current folder.

Copy log4j.xml into installation kit directory.

OFSAAI-1010 Unknown error occurred. Make sure to provide proper argument (SILENT or 
GUI) to the Setup.sh file.

OFSAAI-1011 XML validation failed. Check InfrastructurePreValidations.Log for more 
details.

OFSAAI-1012 Property file with locale name does 
not exist.

Copy MyResources_en_US.properties to the setup 
kit directory and keep en_US in LOCALE tag of 
OFSAAI_InstallConfig.xml.

OFSAAI-1013 File 
OFSAAI_InstallConfig.xml/OFSAAI_P
ostInstallConfig.xml not found.

Copy 
OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.
xml to the setup kit directory.

OFSAAI-1014 XML node value is blank. Make sure all node values except SMTPSERVER, 
PROXYHOST, PROXYPORT, PROXYUSERNAME, 
PROXYPASSWORD, NONPROXYHOST, or RAC_URL 
are not blank.

OFSAAI-1015 XML is not well formed. Execute the command dos2unix 
OFSAAI_InstallConfig.xml to convert plain text file 
from DOS/MAC format to UNIX format.

OR

Make sure that OFSAAI_InstallConfig.xml is valid. Try 
to open the file through Internet Explorer for a quick 
way to check validity. If it is not getting opened, 
create new OFSAAI_InstallConfig.xml using the 
XML_Utility.jar.
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OFSAAI-1016 User installation directory contain 
blank spaces.

Provide an installation path that does not contain 
spaces. Check the tag USER_INSTALL_DIR in 
OFSAAI_InstallConfig.xml file. This path should not 
contain any spaces.

OFSAAI-1017 User installation directory is invalid. Provide a valid installation path. Check if you are 
able to create the directory mentioned in 
USER_INSTALL_DIR tag value of 
OFSAAI_InstallConfig.xml file.

Error Code Cause Resolution
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APPENDIX A Installation of R and Oracle R 
Enterprise (ORE)

This is an optional step and required only if you intend to use Term Structure Parameter Estimation functionality under 
Rate Management - Interest Rates, for computing term structure parameters. Both Funds Transfer Pricing and Asset 
Liability Management applications require term structure parameters for all Monte Carlo engine based calculations (OAS, 
VaR and EaR). 

Following are the prerequisites:

 Install R and Oracle R Enterprise Server on the Oracle Database server. See 

https://docs.oracle.com/cd/E57012_01/doc.141/e57007.pdf

 ORE version supported - Oracle R Enterprise (Server) version 1.4.1

Dependencies

R code of the application requires dependent packages to be installed before the Reporting Line Forecast batch is 
executed. Usage of the predictive model requires installation of packages - tseries, lattice, and R Oracle. Verify that lattice 
and R Oracle are compatible with each other.

Package installation instructions can be found at: 
http://cran.r-project.org/doc/manuals/r-release/R-admin.html#Installing-packages

Configuration for Oracle R Enterprise

Grant the RQADMIN role to atomic schema.

You can grant the rqadmin role in SQL*Plus by logging in to the database with DBA privileges and provide the following 
privilege to Atomic Schema:

RQADMIN by executing the command:

GRANT RQADMIN TO < atomic_schema>;

Configuration for Oracle R distribution and Oracle R Enterprise (ORE)

This is an optional step. Skip and proceed with the next steps if OFS Enterprise Modeling Application with R scripting is not 
enabled during installation.

1. Install OFSAAIRunner Package. For more information, see Installing OFS AAAI Runner Package. If you have already 

installed OFSAAIRunner package (as part of a previous installation), uninstall it (For more information, see Uninstalling 

OFS AAAI Runner Package section), and reinstall the latest available OFSAAIRunner package.

2. Log in to the database with dba privileges and provide the following privilege to Configuration Schema:

 RQADMIN by executing the command:

GRANT RQADMIN TO <config_schema>;

3. Log in to the database with dba privileges and provide the following privileges to Atomic Schema:
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 CREATE UNLIMITED TABLESPACE privilege by executing the command:

GRANT CREATE UNLIMITED TABLESPACE TO <atomic_schema>;

 CREATE MINING MODEL privilege (to execute the Data Mining models) by executing the command:

GRANT CREATE MINING MODEL TO <atomic_schema>;

Installing OFS AAAI Runner Package

OFSAAIRunner is an R package built by the OFS Enterprise Modeling Application. It is a prerequisite for executing models 
developed using R scripts. This package helps in:

 Initializing inputs

 Mapping framework variables to R objects

 Configuring possible outputs of the script

 Storing results back to the Database

OFSAAIRunner package (OFSAAIRunner_1.0.0.tar.gz) is available under $FIC_DB_HOME/lib.

Prerequisite

Oracle R & ORE should be installed on the Oracle Database server before installing OFSAAIRunner package.

Refer to the following instructions to install OFSAAIRunner package:

1. Log in to the OFSAA Server. Navigate to the folder $FIC_DB_HOME/lib.

2. Copy the file OFSAAIRunner_1.0.0.tar.gz in Binary mode to the Oracle Database Server.

3. Log in to the Oracle Database Server with the user using which Oracle Database Server installation is done.

4. Navigate to the directory where the file OFSAAIRunner_1.0.0.tar.gz is copied.

5. Install the package by executing the command:

ORE CMD INSTALL OFSAAIRunner_1.0.0.tar.gz

Successful installation is indicated in the installation log as:

* DONE (OFSAAIRunner)

Making packages.html ... done

Note: The OFSAAIRunner package is installed in /usr/lib64/R/library.

6. Navigate to the directory $ORACLE_HOME/R/library and check whether OFSAAIRunner package is listed there by 

executing the command:

ls -l

Uninstalling OFSAAIRunner Package

Refer to the following instructions to uninstall the OFSAAIRunner package:

1. Log in to the Oracle Database Server with the same username, using which Oracle Database Server installation is 

done.

2. Enter ORE in command prompt and execute the command:
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#ORE

3. Enter the following command to save workspace image:

>remove.packages("OFSAAIRunner")

4. Enter y when prompted to save the workspace image.

q()

5. Navigate to the directory $ORACLE_HOME/R/library and verify the package is not listed there by executing the 

command:

6. Save workspace image? [y/n/c]: y

ls -l

Configurations for ORE Execution

Follow this step:

1. Add a TNS entry in tnsnames.ora file with tns name same as that of value set for ORACLE_SID in database server.

Note: For RAC database, follow the aforementioned configuration in all machines.
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APPENDIX B FTP Web Service Configuration

The following installation activity describes how to setup FTP web services to support the Breakage Charge Economic Loss 
calculation. The calculation logic is the same as the FTP Adjustment Rule Breakage Charge calculation. This FTP Economic 
Loss Web Service is now independent of EXEWebService. Note, other FTP web services are installed automatically and 
require no further setup.

Approach

The FTP Web services are designed as a wrapper which will call the FTP Engine for the calculation of Economic Loss. The 
FTP Web Service is available in its own context and has a specific WSDL for that context.

Architecture

Prerequisites

 For WebLogic and WebSphere, Data source should be present with JNDI name as jdbc/FTPWS.

 For Tomcat a separate context entry should be present in server.xml file.

Log4j configuration

log4j.properties file is already present inside WEB-INF/classed folder of the war file. Logs will be generated inside 
$root_directory_of_war/logs/webservice.log file. 
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Setup Environment variable - ofsaaws.properties

ofsaaws.properties file is available in WEB-INF/classes folder. Specify the cpp_component name. Place the 
component libbcservices.so under /ficdb/lib/libFSGBU. Add the library location to LD_LIBRARY_PATH.

Note: If Web-services are deployed in an environment other than where OFSAA is deployed, then copy 
/ficdb/lib/libFSGBU to web-services environment and set in LIBRARY path.

 cpp_component= libbcservices.so(libbcservices.o) - for AIX

 cpp_component=bcservices - for Solaris 

 cpp_component=bcservices - for Linux

Creating FTPWebServiceAXIS.war

1. Go to the server path in which the application is running.

For Example: $FIC_HOME/FTPWebService

2. Run "ant.sh" in this folder. FTPWebServiceAXIS.war will be created in the same folder.

Deploying FTPWebServiceAXIS.war

For Tomcat:

1. Copy the above WAR file to the webapps folder of apache tomcat directory.

2. Go to conf folder of apache tomcat and add a separate context entry in server.xml file with resource name as 

jdbc/FTPWS.

Example:

<Context path="/FTPWebServiceAXIS" docBase="/<Tomcat_webapps> /FTPWebServiceAXIS" 
debug="0" reloadable="false" crossContext="true">

<Resource auth="Container"

name="jdbc/FTPWS"

type="javax.sql.DataSource

driverClassName="oracle.jdbc.driver.OracleDriver

username="username"

password="password" url="jdbc:oracle:thin:@db-ip:dp-port:dbname"

maxActive="100"

maxIdle="30"

maxWait="10000"

removeAbandoned="true" 

removeAbandonedTimeout="60"

logAbandoned="true"/>

</Context>

3. Restart the server. 
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For Weblogic and WebSphere:

1. Deploy FTPWebServiceAXIS.war from admin console.

2. Create data source for database connection with JNDI name as jdbc/FTPWS.

3. WSDL is present at following URL.

http://ipaddress:port/FTPWebServiceAXIS/services/OFSAAFTPService?wsdl

Additional Steps for Configuring the FTP Ad hoc Pricing Web Services

Ad hoc pricing web-services (getpricing) are deployed along with OFSAA FTP. Configuring these web services require some 
minor configuration after installation, steps are mentioned below:

1. Goto $FIC_HOME/ficweb/webroot/WEB-INF/classes.

2. Open ofsaaws.properties, replace <infodom name> and <userid>(with admin access) and save it.

3. Open ofsaawsClient.properties, give OFSAA URL.

4. Rebuild the war and deploy.

URL pattern for ad hoc web-services are:

http://<ip>:<port>/<context>/services/DailyQueriesService?wsdl

http://<ip>:<port>/<context>/services/ PricingService?wsdl

Note: See the Oracle Financial Services Funds Transfer Pricing User Guide for usage of the FTP Ad hoc 
Pricing Web Services.
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APPENDIX C Additional Configuration

The following topics provide detailed module specific post installation configurations.

This section includes the following topics:

 FTP/SFTP Configuration for File Transfer

 Configuration for Dimension and Hierarchy Management

 Configure Infrastructure Server Memory

 Internet Explorer Settings

 Retrieving Patch Information

 OLAP Data Server Configuration

 Changing IP/ Host name, Ports, Deployed Paths of the OFSAA Instance

 OFSAAI Setup Information Fetching Tool

 Encryption Changer

 Infrastructure LDAP Configuration

 Configure OFSAAI Web Services

 Deploy OFSAAI Web Services

 Configuration to Enable Parallel Execution of DML Statements

 Configure Message Details in Forms Designer

 Clearing Application Cache

 Configuring Password Changes

 Configuring Java Virtual Machine

 Configure Internal Service (Document Upload/ Download)
Oracle Financial Services Profitability Management Application Pack Installation Guide 205



FTP/SFTP Configuration for File Transfer
Appendix C—Additional Configuration
FTP/SFTP Configuration for File Transfer

In OFSAA, certain modules require transfer of files from the web application server to the OFSAA server over SSH.

Follow these steps to ensure the OFSAA server recognizes the web application server during file transfers.

1. Login to the web application server.

2. Type sftp <user>@<OFSAA Server>

3. Specify Yes when prompted for permission.

Are you sure you want to continue connecting (Yes/No)?

4. This will add an entry into the "known_hosts" file.

5. A confirmation message is displayed:

Permanently added <OFSAA Server> RSA) to the list of known hosts.

Configuration for Dimension and Hierarchy Management

These configuration changes are applicable when Dimension Management features provided in OFSAAI are used. You can 
open AMHMConfig.properties file present in the $FIC_WEB_HOME/webroot/conf directory to set the properties for the 
following:

This section includes the following topics:

 Configure Member Deletion

 Configure Attribute Default Date Format

 Configure Members Reverse Population

 Configure Hierarchy Reverse Population

 Configure Maximum Levels allowed in Hierarchies

 Configure Node Limit for a Hierarchy Tree

Configuration for Dimension and Hierarchy Management has to be done only after the application/solution installation is 
done. The properties specific to Information Domain are:

 $INFODOM$=<Name of the Information Domain>

 $DIMENSION_ID$=<Dimension ID for which the property to be set>

Configure Member Deletion

This property should be set to allow the user to delete the Members for the Dimension.

Value Code Example

# Member Deletion Configuration - 
VALUE- Y/N

MEMBER_DEL-$INFODOM$-$DIMENSIO
N_ID$=$VALUE$

MEMBER_DEL-ORAFUSION-1=Y
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Configure Attribute Default Date Format

This property should be set to display the Default Date Format for Date type Attribute in Attributes window.

Value Code Example

# Attribute Default Date Format - 
DB_DATE_FORMAT:DD-MON-YYYY

ATTR_DEF_DATE_FORMAT-$INFODOM$=
$DB_DATE_FORMAT$

ATTR_DEF_DATE_FORMAT-ORAFUSION=D
D/MON/YYYY

Configure Members Reverse Population

This property should be set for reverse population of Members for the Dimensions in required Information Domains.

Value Code Example

# Members Reverse population - VALUE- 
Y/N

MEMBER_REVERSE_POP-$INFODOM$-$D
IMENSION_ID$=$VALUE$

MEMBER_REVERSE_POP-ORAFUSION-1=
Y

Configure Hierarchy Reverse Population

This property should be set for reverse population of Hierarchies for the Dimensions in required Information Domains.

Value Code Example

#Hierarchy Reverse population - VALUE- 
Y/N

HIERARCHY_REVERSE_POP-$INFODOM$-
$DIMENSION_ID$=$VALUE$

HIERARCHY_REVERSE_POP-ORAFUSION-1
=Y

Configure Maximum Levels allowed in Hierarchies

This property is required to set the maximum levels allowed to build the Hierarchies tree structure.

Value Code Example

#Hierarchy Maximum level allowed for 
the hierarchy in particular Information 
Domain - VALUE - Integer number

MAX_DEPTH-$INFODOM$=$VALUE$ MAX_DEPTH-FUSION=15

Hierarchies greater than 15 levels are not supported within OFSAA EPM applications (ALM, FTP, PFT, and HM). If the hier-
archy data contains more than 15 levels, OFSA_IDT_ROLLUP will not be populated. The number of hierarchy levels allowed 
for OFSAA EPM key dimensions must be less than or equal to 15.

 If the Hierarchy Reverse Population setting is set to "Y" and more than 15 levels exist in the data, then the following 
alert is displayed "The number of levels exceeds the limit". 

 If the maximum level allowed setting is set greater than 15 and Hierarchy Reverse Population is set to "Y", then 
following error is displayed "Error occurred in Reverse Populating the hierarchy".
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Configure Node Limit for a Hierarchy Tree

This property is required to display the Hierarchy as a small or a large hierarchy. If the tree node limit exceeds the set limit, 

the Hierarchies are treated as large Hierarchy.

Value Code Example

#Tree node limit for the hierarchy - Values 
is Integer number

TREE_NODE_LIMIT=$VALUE$ TREE_NODE_LIMIT=30

Configure Infrastructure Server Memory

The memory settings for Infrastructure Application Server, Tomcat, WebSphere, and WebLogic can be edited for 
customizing memory settings and garbage collector settings depending on the available hardware configuration as 
explained below. These settings are base minimum and has to be incremented considering the deployment metrics into 
account. The increments are usually handled in multiples of 128mb for heap and 64mb for stack.

Infrastructure Application Server Memory Settings

You can configure the Infrastructure Application Memory settings as follows:

1. Locate .profile file.

2. Edit X_ARGS field in this file for customizing memory settings and garbage collector settings depends on the hardware 

configuration.

This has a default value X_ARGS="-Xms200m"

X_ARGS=" "$X_ARGS" $DELIM -Xmx2048m"

Note: Modify X_ARGS_APP variable in the .profile file to customize Java Memory Settings for Model Upload 
based on the Data Model size.

For Run and Rule executions, the following value is recommended:
X_ARGS_RNEXE="-Xms1g -Xmx1g
XX:+UseAdaptiveSizePolicy -XX:MaxPermSize=512M -XX:+UseParallelOldGC -XX:+DisableExplicitGC"

X_ARGS_RLEXE="-Xms1g -Xmx1g -XX:+UseAdaptiveSizePolicy -XX:MaxPermSize=512M 
XX:+UseParallelOldGC -XX:+DisableExplicitGC"
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Internet Explorer Settings

Note: OFSAAI supports only default zoom setting in Internet Explorer, that is, 100%. Cookies should be 
enabled.

The following browser settings have to be specified at every client machine prior to accessing the Infrastructure 
application.

1. Open Internet Explorer. Select Tools > Internet Options. The Internet Options window is displayed.

2. Click the Settings button. The Settings window is displayed.

3. Select the option Every time I Visit the webpage and click OK.

4. In the Internet Options window, select the Security tab and select the Internet option under Select a zone to view or 

change the security settings.

5. Click Default Level under Security level for this zone.
Oracle Financial Services Profitability Management Application Pack Installation Guide 209



Internet Explorer Settings
Appendix C—Additional Configuration
6. Click OK to save.

7. In the Internet Options window, select the Privacy tab and select the Turn on Pop-up Blocker option under Pop-up 

Blocker settings.
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8. Click Settings. The Pop-up Blocker Settings window is displayed.

9. Enter the URL of the OFSAA Application in the Address of Website to Allow: field.

10. Click Add. The OFSAA URL is displayed in the Allowed Sites section.

11. Click Close.

12. Click OK in the Internet Options window.

Retrieving Patch Information

To identify the list of patches installed on your OFSAA setup, follow these steps:

1. Login to the OFSAA application as a user with Object AdminAdvanced Role.

2. Navigate to Object Administration tab, expand Utilities and click Patch Information.

3. The window displays the list of patches installed on the OFSAA setup across Applications/ Platform.
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OLAP Data Server Configuration

This section is applicable if you are using the OLAP feature of OFSAAI.

The following parameters must be set to ensure that the system limitations are not exceeded at any stage. The values for 
these OS parameters should be specified based on the expected load at each implementation site.

Example:

Process Memory Limit

Max Thread Stack Size

Max Number of Threads per Process

 Sort Buffer settings: This must be set at the Essbase application level appropriate to the anticipated load.

 Shutdown and Restart: During shutdown of OFSAAI Server that has an instance of Data Services that is 
communicating with an OLAP Data Server, it is imperative to ensure that the cleanup of the old instance is completed 
on the OLAP Data Server before restarting the OFSAAI Server. Pause for a period of time based on the load the system 
was subjected to, before restarting the Data Services subsystem.

Changing IP/ Host name, Ports, Deployed Paths of the OFSAA Instance

For information on this section, see the OFS Analytical Applications Infrastructure Administration User Guide.

OFSAAI Setup Information Fetching Tool

Executing the SetupInfo.jar file available in the FIC_HOME path will help you retrieve the related information about the 
OFSAAI Set up such as Operating System Name and version, Database Type and Version, OFSAAI architecture, Log file 
locations and so on.

To execute SetupInfo.jar in console:

1. Navigate to the path $FIC_HOME.

2. Enter the command:

java -jar SetupInfo.jar

After execution, the output file location is displayed in the console.

Encryption Changer

This utility helps you to regenerate the new AESCryptKey.ext file and encrypt all the encrypted values of the OFSAAI setup 
according to the new key.

To execute EncryptC.jar in console:

1. Navigate to the path $FIC_HOME.

2. Enter the command:

java -jar EncryptC.jar

A confirmation message is displayed after execution.
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Once executed, you need to create and deploy the EAR / WAR file depending on the configured Web Application Server. 
For more information, see Creating and Deploying EAR/WAR File.

Infrastructure LDAP Configuration

For more information on LDAP configuration, see the OFS Analytical Applications Infrastructure Administration User 
Guide.

Configure OFSAAI Web Services

Web Services in OFSAAI is meant for exposing a web service to "asynchronously" or "synchronously" execute requested 
tasks offered by OFSAAI. The configuration steps given below are to be done only if you are using the Web Services feature 
of OFSAAI.

Configure DynamicWSConfig.xml File

For each third party web service that needs to be accessed using the OFSAAI Web services framework and the operations 
to be invoked, corresponding entries are to be made in the DynamicWSConfig.xml template file.

The variable <WebServer> denotes any one of the application server, i.e. WebSphere, WebLogic, or Tomcat.

The DynamicWSConfig.xml file will be available in the <OFSAAI Installation Directory>/EXEWebService/ 
<WebServer>/ROOT/conf directory. This file can be placed in any directory that is accessible by the application and this 
location must be specified in the web.xml file, as WSCONFIGFILE parameter.

The DynamicWSConfig.xml template file will be in <WebServer Deployment Path>/ 
EXEWebService.ear/EXEWebService.war/conf directory.

This template is given below:

<XML>

<WEBSERVICES>

<WEBSERVICE CODE="$CODE"

ENDPOINT="$ENDPOINT" TARGETNAMESPACE="$TARGETNAMESPACE"

XMLNS_XSD="$XMLNS_XSD" ENCODINGSTYLE="$ENCODINGSTYLE"

SERVICENAME="$SERVICENAME" PORTTYPENAME="$PORTTYPENAME"

SESSION_MAINTAIN_PROPERTY="$SESSION_MAINTAIN_PROPERTY"

USERNAME="$USERNAME"

PASSWORD="$PASSWORD" STYLE="$WEBSERVICESTYLE"

STUBIMPLEMENTATION="$STUBIMPLEMENTATION">

<OPERATION CODE="$CODE"

NAME="$NAME"

SOAPACTION="$SOAPACTION"

STYLE="$STYLE"

PACKAGENAME="$PACKAGENAME">

<INPUT ORDER="$ORDER"

PARAMNAME="$PARAMNAME"

ARGTYPE="$ARGTYPE"
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CLASSNAME="$CLASSNAME"/>

<OUTPUT PARAMNAME="$PARAMNAME"

RETURNTYPE="$RETURNTYPE"

CLASSNAME="$CLASSNAME"/>

</OPERATION>

</WEBSERVICE>

</WEBSERVICES>

</XML>

The DynamicWSConfig.xml has the placeholders as tabulated below. These have to be updated depending on the web 
service chosen and the mode of accessing it. For each Web service to be accessed, the entire web service tag in the 
DynamicWSConfig.xml file must be repeated. The placeholders tabulated below should be set in accordance to the 
parameters published in the third party wsdl files (web-services) to be accessed. The stub class specified must implement 
the "com.iflex.Oracle Reveleus.execution.webservice.EXEWebIF" interface.

Attributes for WEBSERVICE tag

Placeholder Description

$CODE Unique number within the xml file and cannot be 999 or 0.

$ENDPOINT soap: address location in the wsdl: service name tag of the wsdl file.

$TARGETNAMESPACE The attribute value for the targetNamespace of the wsdl: definitions tag.

$XMLNS_XSD The attribute value for the xmlns:s of the wsdl:definitions tag

$ENCODINGSTYLE The attribute value for the xmlns:soapenc of the wsdl:definitions tag.

$SERVICENAME Name of the service found under the wsdl:service name tag of the wsdl file.

$PORTTYPENAME wsdl port type name as mentioned in the wsdl file.

$SESSION_MAINTAIN_PROPERTY This could be given as "" also.

$USERNAME User name to access the web services. Enter "" if no user name is required.

$PASSWORD Password to access the web services. Enter "" if no password is required.

$WEBSERVICESTYLE This can take either "rpc" in case of DII mode of invoking web services or "stub" in case of 
static mode. This is a mandatory parameter.

$STUBIMPLEMENTATION Fully qualified class name (package name.classname).

Attributes for OPERATION tag

Ensure that the "operation tag attributes" are repeated for each of the operation tags.

Placeholder Description

$CODE Should be unique within the Web service tag.

$NAME The name of the Function that is to be called by the wsdl file.

$SOAPACTION The URL for the Operation to access. This is associated with the Operation tag of the wsdl 
file.

$STYLE This can take "rpc" if the web services invoking is in DII mode or "stub" if it is in static 
mode. This is a mandatory parameter.

$PACKAGENAME Represents the JAXB package of input object.
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Attributes for INPUT tag

Placeholder Description

$ORDER The sequential number of the INPUT tag. Should start from 0. This is in line with the input 
order of the arguments that the API accepts which is called by this operation.

$PARAMNAME Input parameter name to be called by the wsdl file.

$ARGTYPE Input Parameter Data Type. If the input argument type is complex object, specify 
$ARGTYPE as "xmlstring".

$CLASSNAME Represents class name of input object parameter.

Attributes for OUTPUT tag

Placeholder Description

$PARAMNAME Output parameter name to be returned by the web service.

$RETURNTYPE Output parameter Data Type. If the web service response is a complex object, then specify 
$RETURNTYPE as "object".

$CLASSNAME Represents class name of output object parameter.

web.xml Entries

1. This step is optional and required only if the web application server used is Tomcat. In case of any other application 

server, skip and proceed with next step.

Navigate to $FIC_HOME/webroot/WEB-INF/ and edit the web.xml file. Set parameter value DOCSERVICEAPP to 
EXEWebServiceAXIS.

2. Navigate to <OFSAAI Installation Directory>/EXEWebService/<WebServer>/ROOT/WEB-INF/ and edit the web.xml file 

as explained below.

Note: In case of Java 7 when WebLogic is used as web application server replace following line of <OFSAAI 
Installation Directory>/EXEWebService/Weblogic/ROOT/WEB-INF/web.xml file that is

<?xml version='1.0' encoding='UTF-8'?> 
<web-app id="WebApp_ID" version="3.0" 
xmlns="http://java.sun.com/xml/ns/javaee" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:schemaLocation="http://java.sun.com/xml/ns/javaee 
http://java.sun.com/xml/ns/javaee/web-app_3_0.xsd" metadata-complete="true">

with


<?xml version='1.0' encoding='UTF-8'?> 
<web-app xmlns="http://java.sun.com/xml/ns/j2ee" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
Oracle Financial Services Profitability Management Application Pack Installation Guide 215



Configure OFSAAI Web Services
Appendix C—Additional Configuration
Entry for WSConfig File

The WSCONFIG file (DynamicWSConfig.xml) is available in the <WebServer Deployment Path>/ 
EXEWebService.ear/EXEWebService.war/conf directory. This file can be placed in any directory that is accessible by the 
application.

The path where the WSCONFIG file is placed must be specified in place of $WSCONFIGFILELOCATION$ in the below block 
of text in web.xml.

<context-param>

<description>WebServices Configuration File</description>

<param-name>WSCONFIGFILE</param-name>

<param-value>$WSCONFIGFILELOCATION$</param-value>

<!--Specify the Location of DynamicWSConFig.xml-->

</context-param>

Proxy Settings

Replace the following <param-value> given in bold in the following block of text in web.xml file, with appropriate 
values.

If no values are required, leave the <param-value> blank.

<context-param>

<description>http Proxy Host</description>

<param-name>http.proxyHost</param-name>

<param-value>$PROXYHOST$</param-value>

<!-- Specify the IP address or hostname of the http proxy server-->

</context-param>

<context-param>

<description>http Proxy Port</description>

<param-name>http.proxyPort</param-name>

<param-value>$PROXYPORT$</param-value>

<!--Port Number for the Proxy Server-->

</context-param>

<context-param>

<description>http proxy UserName</description>

<param-name>http.proxyUserName</param-name>

<param-value>$PROXYUSERNAME$</param-value>

<!-- User ID To get authenticated by proxy server-->

</context-param>

<context-param>

<description>http proxy Password</description>

<param-name>http.proxyPassword</param-name>

<param-value>$PROXYPASSWORD$</param-value>

<!-- User Password To get authenticated by proxy server-->

</context-param>
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<context-param>

<description>http non-ProxyHosts</description>

<param-name>http.nonProxyHosts</param-name>

<param-value>$NONPROXYHOST$</param-value>

<!--Hosts for which the proxy settings should get by-passed (Note: Separate them by 
"|" symbol) -->

</context-param>

OFSAAI Home Entry

This entry should point to the Application layer / Web layer of the OFSAAI installation and should be accessible.

Replace $FIC_HOME$ in the following block of text in web.xml with <WebServer Deployment 
Path>/EXEWebService.ear/EXEWebService.war.

<context-param>

<description>OFSAAI Web Home</description>

<param-name>FIC_HOME</param-name>

<param-value>$FIC_HOME$</param-value>

<!--OFSAAI Installation Folder-->

</context-param>

<context-param>

<description>OFSAAI Web Home</description>

<param-name>FIC_PHYSICAL_HOME</param-name>

<param-value>$FIC_HOME$</param-value>

<!--OFSAAI Installation Folder-->

</context-param>

DynamicWSConfig.xml

For each third party web service that needs to be accessed using the OFSAAI Web services framework, and the operation 
to be invoked, make corresponding entries into this file. This file is to be placed in the location that is specified in the 
web.xml, as WSCONFIGFILE parameter.

Deploy OFSAAI Web Services

You can deploy OFSAAI Web Services separately if you had not configured OFSAAI Web Services as part of the installation.

1. Complete the manual configuration of OFSAAI Web Services.

2. Navigate to <OFSAAI Installation Directory>/EXEWebService/<WebServer> and execute the command:

./ant.sh

3. This will trigger the EAR/WAR file creation, which is required for the deployment. 

4. Deploy the generated EXEWebService.EAR/EXEWebService.WAR file into the Web Server.

If you have already configured OFSAAI Web Services as part of the installation, deploy the generated 
EXEWebService.EAR/ EXEWebService.WAR file into the OFSAAI Deployment area in Web Server profile.
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Configuration to Enable Parallel Execution of DML Statements

A configuration file, OracleDB.conf has been introduced to accommodate any configurable parameter related to 
operations on oracle database. If you do not want to set a parameter to a specific value, then the respective parameter 
entry can be removed/commented off form the OracleDB.conf file which resides in the path $FIC_DB_HOME/conf.

As of now, the OracleDB.conf file has only one parameter namely CNF_DEGREE_OF_PARALLELISM. This parameter 
indicates the degree of parallelism to be used for a DML operation if parallel DML is explicitly enabled in the session with 
the ENABLE PARALLEL DML clause of the ALTER SESSION statement. The default mode of a session is DISABLE 
PARALLEL DML.If CNF_DEGREE_OF_PARALLELISM is not set, then the default degree, as decided by Oracle will be used.

Configure Message Details in Forms Designer

You can configure the Message Details in Forms Designer under Data Entry Forms and Queries module by updating the 
details of mail server in the "NotificationConfig.cfg" file which resides in the path 
$FIC_APP_HOME/common/FICServer/conf.

Ensure that the "authorized User details" for whom you need to configure the Message details are included in 
Administration > Security Management > User Administrator > User Maintenance window.

Update the following parameters in the "NotificationConfig.cfg" file:

Parameter Description

SMTP_SERVER_IP Specify the host name or IP address of SMTP Server.

SMTP_DEBUG_MODE To run SMTP service in Debug mode, set value to 'true', otherwise set value to 'false'.

SMTP_AUTHORIZATION Set to 'true' if SMTP server requires the client to be authenticated, otherwise set to 'false'.

SMTP_USERNAME Username required for logging into SMTP server, if authentication is not required use a dummy 
value.

SMTP_PASSWORD Password required for logging into SMTP server, if authentication is not required use a dummy 
value.

SMTP_MAILID If the Messages has to go from a Particular ID that ID need to be added. Exchange server forces 
you set a valid ID that is there in the exchange server (Based on Security settings). 

Ensure that the authorized User details are included in Administration > Security Management > User Administrator > User 
Maintenance window.

Clearing Application Cache

This is applicable to all Web Servers (i.e. WebSphere, WebLogic, and Tomcat).

Prior to the deployment of Infrastructure or Application Service Packs / One-off patches, navigate to the following path 
depending on the Web Server configured and clear the cache:

 Tomcat: <Tomcat installation folder>/work/Catalina/localhost/<Application name>/org/apache/jsp

 WebLogic: <Weblogic installation location>/domains/<Domain name>/servers/<Server 
name>/tmp/_WL_user/<Application name>/qaelce/jsp_servlet

 WebSphere: <Websphere installation directory>/AppServer/profiles/<Profile name>/temp/<Node 
name>/server1/<Application name>/<.war file name>
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Configuring Password Changes

This section explains about how to modify the OFSAA Infrastructure Config Schema and Atomic Schema passwords.

OFSAA Infrastructure Config Schema Password Modification

To change the Config Schema password, perform the following steps:

1. Change the Config schema User Password in the database.

2. Delete the $FIC_HOME/conf/Reveleus.SEC file.

3. Shutdown the OFSAAI App service:

cd $FIC_APP_HOME/common/FICServer/bin

./stopofsaai.sh

4. Start the Infrastructure Server in foreground directly on the server or through X-Windows software using the 

command:

./startofsaai.sh

At the prompt, enter System Password. Enter the "new Config schema" password. The service will start and initialize 
itself if it is able to successfully connect to the DB.

5. Post successful startup of the service, if required, the Infrastructure server may be shut down and restarted in the 

background using nohup mode.

OFSAA Infrastructure Atomic Schema Password Modification

To change the Atomic Schema password, perform the following steps:

1. Change the Atomic schema User Password in the database.

2. Login to the application from the browser using SYSADMN account or any user id, which has System Administrator 
role mapped.

3. Navigate to System Configuration > Database Details window. Modify the password as explained in the following 

steps:

a. From the Database Master window, select the connection whose password you want to modify and click   

button from the tool bar.

 Click  button corresponding to the Alias Name. The Alias Details window is displayed.

 Modify the password in the Auth String field.

4. If you are using Apache Tomcat as Web server, update the <Context> -> Resource tag details in Server.xml file from the 

$CATALINA_HOME/conf folder. (In case of Tomcat only Atomic <Resource> will exist).

5. If you are using WebSphere as Web server:

a. Login to the WebSphere Administration Console, from the left side menu.

b. Navigate to Resources >JDBC >Data Sources. A list of data sources will be populated on the right side.

c. Select the appropriate Data Source and edit the connection details. (In this case, both Config and Atomic data 
sources will need to be modified).
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If you are using WebLogic as Web server:

a. Login to the WebLogic Administration Console, from the left side menu.

b. Under Domain Structure list box, expand the appropriate Domain and navigate to Services > JDBC >Data Sources. 
A list of data sources will be populated on the right side.

 Select the appropriate Data Source and edit the connection details. (In this case, both Config and Atomic data 
sources need to be modified).

6. Restart the OFSAAI services.

Configuring Java Virtual Machine

While running several database intensive tasks in parallel, fetching the database connection from connection pool may 
face an error. To ensure no such error is encountered, add the line securerandom.source=file:/dev/./urandom in 
the java.security configuration file available in $JAVA_HOME/jre/lib/security/ path.

This needs to be configured on all the machines or virtual machines where the OFSAAI database components (ficdb layer) 
are installed.

Configure Internal Service (Document Upload/ Download)

This step can be ignored if it has already been configured as part of any previous IR/ML installation.

The Document Upload/Download feature has undergone a change and can now be configured to use Internal service for 
document upload/ download instead of the earlier ExeWebService.

To facilitate Internal service for document upload/ download, perform the following configurations:

1. Create the folders download, upload, TempDocument and Temp in the local path of Web application server and 

provide Read/Write permission.

 To find the exact location, execute the following query in CONFIG schema:

select localpath from web_server_info

 To create folders with Read/Write permission, execute the command:

mkdir -m 777 download upload TempDocument Temp

2. Create DocStorage folder in the FTPSHARE location of APP tier and provide Read/Write permission.

 To find the exact location, execute the query in CONFIG schema:

select ftpdrive from app_server_info

 To create folder with Read/Write permission, execute the command:

mkdir -m 775 DocStorage

By default, the parameter DOCUMENT_SERVICE_TYPE_EXTERNAL value is set to FALSE in the Configuration table in CON-
FIG schema and hence the application "ExeWebService" will not be used. It is recommended that the value to be set to 
FALSE and use the Internal service for document upload/ downloads. If you intend to continue using the External ExeWeb-
Service, set the value to TRUE.

Navigate to $FIC_HOME/EXEWebService/<WEBSERVER_TYPE> directory of WEB tier and type ./ant.sh. This triggers the 
creation of EAR/WAR file EXEWebService.ear/.war. The EAR/WAR file EXEWebService.ear/.war will be created in 
$FIC_HOME/EXEWebService/<WEBSERVER_TYPE> directory of WEB tier. Redeploy the generated EAR/WAR file onto your 
configured web application server.
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There is a consistent need for a faster and effective approach of replicating an existing OFSAA instance for further project 
developments, that is, setting up OFSAA instances that are exact copies of the current OFSAA instance. For more 
information on cloning, see OFSAA Cloning Reference Guide.
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APPENDIX E Migration for Excel Upload

This appendix provides detailed instructions to migrate for excel upload.

Prerequisites

The following are the prerequisites for migration:

 Data model in ATOMIC schemas should be same on the source and target setups.

 OFS AAI (platform) patch level version should be same on the source and target setups.

 PL/SQL Developer to connect and query the database.

 WinSCP to connect and access server file system.

Migration for Excel Upload

To migrate, follow these steps:

1. Open PL/SQL Developer and log in to the source setup's configuration (CONFIG) schema by entering the appropriate 

username and password.

2. In a new SQL window query the data of table EXCEL_MAPPING_MASTER.

3. Open a new session in PL/SQL developer and log in to the target setup's configuration (CONFIG) schema by entering 

the appropriate username and password.

4. Insert the records from Step 1 above in to this table.

5. In V_INFODOM column of EXCEL_MAPPING_MASTER table update the infodom name with the target infodom name.

Note: If all the mappings can work out of the single target Infodom, update same Infodom value across all 
rows. If only few mappings will work out of the target infodom, update the infodom value for selective 
records. Excel upload mappings will work only if the target infodom has same data model entities as used 
in the mappings defined on source setup.

6. Update V_CREATED_BY column with the name of any user present in the target setup that has appropriate roles to 

perform Excel Upload tasks.

Note: It is mandatory to update values for V_INFODOM and V_CREATED_BY columns.

7. Open WinSCP and login a new session by entering the host name, port number, user name and password to access 

the source setup. 

8. Navigate to the folder referred as FTPSHARE.

9. Copy the excel-entity mapping xml file(s) which are located in this folder according to their folder structure on to your 

desktop. For example: /ftpshare /STAGE/ExcelUpload/$SOURCE_INFODOM_NAME/$EXCEL_FILE_NAME.xml
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Note: Actual file name of Excel Sheet is mentioned in the V_EXCEL_NAME column of 
EXCEL_MAPPING_MASTER table.

10. Copy the excel templates (.xls/ .xlsx) file(s) which are located in this folder according to their folder structure on to 

your desktop. For example: /ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx

Note: Ignore this step if files are not present at the location.

11. Login a new session in WinSCP by entering the host name, port number, user name and password to access the target 

setup.

12. Copy the xml file(s) from Step3 to the below location in the target setup. For example: 

/ftpshare/STAGE/ExcelUpload/$TARGET_INFODOM_NAME/$EXCEL_FILE_NAME.xml

Note: $TARGET_INFODOM_NAME should be target setup infodom in which you have uploaded the 
appropriate data model and the name should be same as the V_INFODOM column value updated in 
EXCEL_MAPPING_MASTER table.

13. Copy the xls/ xlsx file(s) from Step 3 to the below location in target setup. For example: 

/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx

Note: Ignore this step if files are not present at the location.
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Data Visibility

Data visibility refers to the data control established on the results fetched by reports depending on the user logged in.

For each user, only those accounts which are directly handled or are handled by a subordinate are visible.

If the logged in user is an RM, then only those accounts which are associated to that user's organizational hierarchy will be 
fetched. This is achieved through FSI_M_USER_MANAGER_MAP table.

If a user is Relationship Manager (RM), then the particular log in ID and the manager code from DIM_MANAGEMENT table 
have to be populated into FSI_M_USER_MANAGER_MAP table. Also, the table FCT_ACCOUNT_MGR_REL should have the 
necessary details for the relationship manager to account mapping.

A user logging in without any associated Manager code should have access to the entire data available.

The entries to FSI_M_USER_MANAGER_MAP table have to be manually inserted. It has two columns, V_USERNAME and 
V_MANAGER_CODE. The V_USERNAME has to be inserted with the login username created in OBIEE and V_MANGER_CODE 
has to be inserted with the manager code of the corresponding user from DIM_MANAGEMENT table. 

Example

The following diagram depicts a hierarchy of Relationship Managers:

The data visibility for each of the Relationship Managers, starting from the top of the hierarchy is as follows: 

 RM1 user has control over the data associated to that user along with the data associated to the immediate 
subordinates, that is, RM2, RM5, and their subordinates till the end of the hierarchy. 

 RM2 user has control over the data associated to that user along with the data associated to the immediate 
subordinates, that is, RM3, RM4, and their subordinates till the end of the hierarchy. 

 RM5 user has control over the data associated to that user along with the data associated to the immediate 
subordinate, that is, RM6 and his subordinates till the end of the hierarchy. 

If the logged in user is a Sales Representative (SR), the data associated with the opportunities managed by the respective 
Sales Representatives are visible. Each Sales Representative will have unique skey values and accounts related to those 
skeys are displayed in reports.
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Report Visibility

The Report's visibility are restricted as per below.

Application Role Dashboards Available

Business Analyst Summary

Customer Summary

Cross-Sell

Top 10 Opportunities

Opportunities

Activities

Customer Performance

Product Performance

Line of Business Performance

Balance Sheet

Relationship Manager Opportunities

Activities

Relationship Manager Performance

Sales Representative Opportunities

Activities

Administrator All Reports

The Reports visibility for the different roles has to be handled by setting proper catalog Permissions. The steps to setup 
these permissions are described in Setting Up Dashboard Visibility under Configure Roles and Groups of this document. 
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Metadata Visibility

Accessibility to presentation layer objects for creating ad-hoc reports varies from user-to-user depending on the 
application role the user is allocated.

The following are the requirements for viewing the Metadata in RPD:

Application Role Tables for Ad-hoc Reporting

Business Analyst role Fact-Account Summary

Fact Account Profitability

Fact Opportunity

Fact Opportunity Activity

Fact Management Forecast

Fact Customers

Relationship Manager role Fact Relationship Manager Contribution

Fact Relationship Manager Profitability

Fact Opportunity

Fact Opportunity Activity

Sales Representative role Fact Opportunity

Fact Opportunity Activity

Fact Sales Representative Compensation

Administrative role (WebLogic) All tables
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APPENDIX G Removing OFSAA

This chapter includes the following sections:

 Uninstalling OFSAA Infrastructure

 Uninstalling EAR Files in WebSphere

 Uninstalling EAR Files in WebLogic

 Uninstalling WAR Files in Tomcat

Uninstalling OFSAA Infrastructure

This section will guide you through the necessary steps to uninstall the OFSAA Infrastructure product.

Before you start the uninstallation process, ensure that no open connections exist to the OFSAA Infrastructure Config and 
Atomic Schemas and Infrastructure services are brought down.

To uninstall OFSAA Infrastructure:

1. Log in to the system as non-root user.

2. Navigate to the $FIC_HOME directory and execute the command:

./Uninstall.sh

3. Enter the password for OFSAAI Configuration Schema when prompted as shown in the following figure.

Figure 3. Uninstalling OFSAA Infrastructure

Note: Uninstallation does not remove the Infrastructure application from the Web Application Server. This 
has to be done manually.

The entries in the .profile file will have to be removed manually.

The files/ folders under the file system staging area (ftpshare) have to be deleted manually.

All the Database objects from Atomic Schemas have to be dropped manually.
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Uninstalling EAR Files in WebSphere

Following are the steps to uninstall any previously deployed application:

1. Open the URL in the browser window: http://<ipaddress>:<Administrative Console Port>/ibm/console (https if SSL is 

enabled). The Login window is displayed.

2. Login with the user id that has admin rights.

3. Expand Applications > Application Types > WebSphere enterprise applications from the LHS. The Enterprise 

Applications window is displayed with all the deployed applications.

Figure 4. Enterprise Applications

4. Select the check box adjacent to the application to be uninstalled and click Stop.

5. Click Uninstall to display the Uninstall Application window.

Figure 5. Uninstall Application

6. Click OK to confirm.

7. Click Save to save the master file configuration.
230 Oracle Financial Services Profitability Management Application Pack Installation Guide



Uninstalling EAR Files in WebLogic
Appendix G—Removing OFSAA
Uninstalling EAR Files in WebLogic

On the machine that hosts WebLogic, perform the following steps to uninstall any previously deployed application:

1. Open the URL in the browser window: http://<ipaddress>:<admin server port>/console (https if SSL is enabled). The 

Login window of the WebLogic Server Administration Console is displayed.

2. Login with the WebLogic user credentials having administrator privileges.

3. From the Domain Structure LHS menu, click Deployments to display the Summary of Deployments screen.

Figure 6. Summary of Deployments

4. Select the check box adjacent to the application to be uninstalled and click Stop > Force Stop Now.

5. Click Yes in the confirmation dialog to stop the selected deployment.

Figure 7. Summary of Deployments- Messages

6. Select the check box adjacent to the application and click Delete to delete the selected deployment.

7. Click Yes in the confirmation dialog to remove the selected deployment from the domain configuration.
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Uninstalling WAR Files in Tomcat

On the machine that hosts Tomcat, perform the following steps to uninstall any previously deployed application:

1. Comment out Context path section from server.xml file in $CATALINA_HOME/conf directory to avoid conflict during 

undeploy and re-deploy of the WAR file.

Place comment <!-- --> in between the context path section. For example:

<!--

<Context path ="/pr2test" docBase="/home/perfuser/tomcat-7.0.19/webapps/pr2test" 
debug="0" reloadable="true" crossContext="true">

<Resource auth="Container"

name="jdbc/PR2ATM"

type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username="pr2atm"

password="pr2atm"

url="jdbc:oracle:thin:@10.184.74.99:1521:PERFTEST"

maxActive="100"

maxIdle="30"

maxWait="10000"/>

</Context>

-->

Restart the Tomcat service by doing the following:

a. Login to the "Unix server" through a terminal emulator.

b. Navigate to $catalina_home/bin directory.

c. Stop the tomcat services using the following command:

./shutdown.sh

d. Start the tomcat services using the following command:

./startup.sh

2. Open the URL in a browser window: http://<IP address>:<Tomcat server port>. (https if SSL is enabled). The Tomcat 

home window is displayed.

3. Click the Manager App. The Connect to window is displayed.

4. Login with the user credentials having admin rights. The Tomcat Web Application Manager window is displayed with 

the list of all applications deployed in Tomcat.
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Figure 8. Tomcat Web Application Manager

5. Click the Undeploy link against the deployed Infrastructure application. A confirmation message is displayed on the 

application /Infrastructure being uninstalled.
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APPENDIX H Upgrading an Existing OFSAA 
8.0.x Java 7 Instance to Java 8

This appendix explains the configurations required to upgrade an existing OFSAA 8.0.x Java 7 instance to Java 8. It consists 
of the following topics:

 Prerequisites

 Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8

 Web Application Server Configurations

 OFSAA Generic Configurations

 OFSAA Configurations for New Web Application Server Installation

Prerequisites

The following are the prerequisites for upgrading OFSAA 8.0.x Java 7 instance to Java 8:

 Java 8 should be installed on the OFSAA server and Web Application Server.

 Oracle WebLogic Server should be 12.1.3.0 or above. Download and install patch 18729264 from 
http://support.oracle.com/.

Note: IBM WebSphere 8.5.x (Full Profile) on Java 8 is not available.

Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8

To upgrade OFSAA 8.0.x Java 7 instance to Java 8, follow these steps:

1. Configure Web Application Server to Java 8. For more information, see Web Application Server Configurations.

2. Configure the OFSAA instance to Java 8. For more information, see OFSAA Generic Configurations. For a newly 

installed Web Application Server, see OFSAA Configurations for New Web Application Server Installation.

3. Restart the OFSAA services. For more information, see Start/Stop OFSAA Infrastructure Services section.

4. Generate the application EAR/WAR file and redeploy the application onto your configured web application server. For 

more information on generating and deploying EAR / WAR file, see Creating and Deploying EAR/WAR File.
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Web Application Server Configurations

This section describes the changes to be made in the Web Application Server. Following are the two options to perform 
Web Application Server Configurations which are listed as follows:

 Upgrade the existing Web Application Server installation to Java 8

 Install a new instance of the Web Application Server with Java 8

This section consists of the following topics:

 Oracle WebLogic Server Updates

 Apache Tomcat Server Updates

Oracle WebLogic Server Updates

Perform the following configurations to upgrade the existing WebLogic server instance to Java 8:

1. Navigate to <WLS_HOME>/Middleware/Oracle_Home/wlserver.

2. Edit the product.properties file. Set JAVA_HOME, WLS_JAVA_HOME, JAVAHOME properties to the new Java path 

and java.vm.version to the new Java version. For example:

JAVA_HOME=/usr/java/jre1.8.0_45

WLS_JAVA_HOME=/usr/java/jre1.8.0_45

JAVAHOME=/usr/java/jre1.8.0_45

java.vm.version=1.8.0_45

3. Navigate to <WLS_HOME>/Middleware/Oracle_Home/user_projects/domains/<domain>/bin. Update 

SUN_JAVA_HOME, DEFAULT_JAVA_HOME, JAVA_HOME in the setDomainEnv.sh file to point to the new Java path. 

For example: 

SUN_JAVA_HOME="/usr/java/jre1.8.0_45"

DEFAULT_SUN_JAVA_HOME="/usr/java/jre1.8.0_45"

JAVA_HOME="/usr/java/jre1.8.0_45"

4. Clear the Application cache. Navigate to the following path and delete the files:

<Weblogic installation location>/domains/<Domain name>/servers/<Server name>/tmp/_WL_user/<Application 
name>/qaelce/jsp_servlet

If you want to install a new instance of the Oracle WebLogic Server, follow these steps:

1. Install Oracle WebLogic Server 12.1.3.x on Java 8.

2. Perform the configurations for the newly installed WebLogic server. For more information, see Configure Resource 

Reference in WebLogic Application Server.

Note: While creating WebLogic Domain, the Listen Port should be set same as that of the existing Domain.
Note down the new Domain path to perform OFSAA Configurations.

Apache Tomcat Server Updates

Perform the following configurations to upgrade the existing Apache Tomcat Server from Java 7 to Java 8:
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1. Login to the Apache Tomcat Server as a non-root user.

2. Edit the user .profile. Update the value for JAVA_HOME from JRE 1.7 to JRE 1.8. For Example:

JAVA_HOME=/usr/java/jre1.8.0_45

3. Clear the Application cache. Navigate to the following path and delete the files:

<Tomcat installation folder>/work/Catalina/localhost/<Application name>/org/apache/jsp

If you wish to install a new instance of the Apache Tomcat Server, follow these steps:

1. Install Apache Tomcat Server 8 with Java 8.

2. Perform the configurations for the newly installed Tomcat server. For more information, see Configure Resource 

Reference in Tomcat Application Server.

Note: Update the Connector Port in /apache-tomcat-8.0.21/conf/server.xml file to that of the existing 
Tomcat instance. Note down the new deployment path to perform OFSAA Configurations.

OFSAA Generic Configurations

User .profile Settings

Perform the following configurations:

1. Login to the OFSAA Server as a non-root user.

2. Edit the user .profile. Update the value for PATH variable from JRE 1.7 to JRE 1.8. For Example,

PATH=/usr/java/jre1.8.0_45/jre

JAVA_BIN=/usr/java/jre1.8.0_45/jre/bin

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/usr/java/jre1.8.0_45/jre/lib/amd64/server
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OFSAA Configurations for New Web Application Server Installation

This configuration is required only if you have freshly installed Oracle WebLogic 12.1.3 or Apache Tomcat Server 8.0. 
Follow these steps:

1. Modify the following parameters in the Configuration table present in the Config Schema with the new Domain Path 

in case of WebLogic or with the new deployment path in case of Tomcat:

 DeFiHome

 REV_IMG_PATH

 EMBEDDED_JSP_JS_PATH

2. Login to the OFSAA Server as a non-root user.

3. Navigate to $FIC_HOME/ficweb/webroot/WEB_INF and update the following parameters in the web.xml file with the 

new Domain path in case of WebLogic or with the new deployment path in case of Tomcat:

 FIC_PHYSICAL_HOME_LOC

 FIC_HOME

 ICC_SERVLET_LOG_FILE

4. Navigate to $FIC_HOME/ficweb/webroot/conf and update the Domain path in case of WebLogic or with the new 

deployment path in case of Tomcat:

 OFSAALogger.xml

 MDBLogger.xml

 RevLog4jConfig.xml

 RFDLogger.xml

 ExportLog4jConfig.xml

 RFDLogger.xml

 PR2Logger.xml
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APPENDIX I JDBC Jar Files

The ojdbc<version>.jar file should be copied based on Database and Java version. Refer to the following table for 
details:

Oracle Database version JDK/JRE Version supported JDBC Jar files specific to the release

12.1 or 12cR1 JDK 8, JDK 7 and JDK 8 ojdbc7.jar for JDK 7/JDK 8

11.2 or 11gR2 JDK 7 supported in 11.2.0.3 and 11.2.0.4 ojdbc6.jar for JDK 7
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APPENDIX J Configuring Application Pack XML 
Files

OFS_PFT_PACK.xml

The OFS_PFT_PACK.xml file holds details on the various products that are packaged together in Profitability Application 
Pack.

This section details the various tags/ parameters available in the file and the values that need to be updated. Prior to 
installing the Profitability Application Pack in SILENT mode, it is mandatory to update this file.

Note: If you are installing in the GUI mode, then this file need not be updated.

Tag Name/ Attribute 
Name Description

Mandatory 
(Y/ N)

Default Value/ 
Permissible Value Comments

APP_PACK_ID Unique Application 
Pack Identifier

Y Unique Seeded Value DO NOT modify this value.

APP_PACK_NAME Unique Application 
Pack Name

Y Unique Seeded Value DO NOT modify this value.
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APP_PACK_DESCRIPTIO
N

Unique Application 
Pack Description

Y Unique Seeded Value DO NOT modify this value.

VERSION Unique release version Y Unique Seeded Value DO NOT modify this value.

APP Unique Application 
Entries

Y Unique Seeded Value DO NOT remove these tags.

APP_ID Unique Application 
Identifier

Y Unique Seeded Value DO NOT modify this value.

APP_ID/ PREREQ Prerequisite 
Application/ Product

Y Unique Seeded Value For most applications 
Infrastructure would be the 
prerequisite set. For certain other 
applications, an appropriate 
Application ID would be set.

DO NOT modify this value.

APP_ID/ DEF_SEL_FLAG Default Selected Flag Y Default - YES In all Application Packs, 
Infrastructure would have this 
value set to "YES". 

DO NOT modify this value.

APP_ID/ ENABLE Enable Application/ 
Product

YES if 
installing in 
SILENT 
mode.

Default - 

YES for Infrastructure

NO for Others

Permissible - YES or NO

Set this attribute-value to YES 
against every APP_ID which is 
licensed and should be enabled for 
use.

Note: Application/ Product once 
enabled cannot be disabled. 
However, Application/ Product not 
enabled during installation can be 
enabled later through the 
Administration UI.

APP_NAME Unique Application/ 
Product Name

Y Unique Seeded Value DO NOT modify this value.

APP_DESCRIPTION Unique Application/ 
Product Name

Y Unique Seeded Value DO NOT modify this value.

VERSION Unique release version Y Unique Seeded Value DO NOT modify this value.

Tag Name/ Attribute 
Name Description

Mandatory 
(Y/ N)

Default Value/ 
Permissible Value Comments
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Configuring OFS_PFT_SCHEMA_IN.xml

Creating database schemas, objects within schemas and assigning appropriate grants are the primary steps in the 
installation process of OFSAA Applications. The OFS_PFT_SCHEMA_IN.xml file contains details on the various application 
schemas that should be created prior to the Application Pack installation.

Note: This file should be configured only if OFS Profitability Application Pack installation for RDBMS ONLY 
target.

The following table gives details about the various tags/ parameters available in the file and the values that need to be 
updated. Prior to executing the schema creator utility, it is mandatory to update this file.

Tag Name/ 
Attribute Name Description

Mandatory 
(Y/ N) Default Value/ Permissible Value Comments

<APP_PACK_ID> Seeded unique ID for 
the OFSSAA Application 
Pack

Y Seeded DO NOT modify this value.

<JDBC_URL> Enter the JDBC URL.

Note: You can enter 
RAC/ NON-RAC 
enabled database 
connectivity URL.

Y Example:

jdbc:oracle:thin:@<HOST/IP>:<P
ORT>:<SID>

or

jdbc:oracle:thin:@/ 
/[HOST][:PORT]/SERVICE

or 

jdbc:oracle:thin:@(DESCRIPTION=
(ADDRESS_LIST=(ADDRESS=PROT
OCOL=TCP)(HOST=[HOST])(port=[
PORT]))(ADDRESS=(PROTOCOL=T
CP)(HOST=[HOST])(PORT=[PORT])
)(LOAD_BALANCE=yes)(FAILOVER
=yes))(CONNECT_DATA=(SERVICE
_NAME=

For example:

jdbc:oracle:thin:@//dbhost.serve
r.com:1521/scan-1

or

jdbc:oracle:thin:@(DESCRIPTION=
(ADDRESS_LIST=(ADDRESS=(PROT
OCOL=TCP)(HOST=dbhost1.server
.com)(port-1521))(ADDRESS=(PR
OTOCOL=TCP)(HOST-dbhost2.serv
er.com)(PORT-1521))(LOAD_BALA
NCE=yes)(FAILOVER=yes))(CONNE
CT_DATA=(SERVICE_NAME=servic
e1)))

Ensure to add an entry (with 
SID/ SERVICE NAME) in the 
tnsnames.ora file on the 
OFSAA server. The entry 
should match with the SID/ 
SERVICE NAME used in the 
JDBC URL.
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<JDBC_DRIVER> By default this driver 
name is seeded.

Note: Do not edit this 
attribute value.

Y Example:

oracle.jdbc.driver.OracleDriver

Only JDBC Thin Driver is 
supported.

DO NOT modify this value.

<HOST> Enter the Host name/ 
IP Address of the 
system on which you 
are installing the 
OFSAA components.

Y Host Name/ IP Address

<SETUPINFO>/PREF
IX_SCHEMA_NAME

Identifies if the value 
specified in 
<SETUPINFO>/NAME 
attribute should be 
prefixed to the schema 
name.

N YES or NO

Default value is YES.

<SETUPINFO>/NAM
E

Enter the acronym for 
the type of 
implementation. This 
information will be 
displayed in the OFSAA 
Home Page.

Note: On executing the 
schema creator utility, 
this value will be 
prefixed with each 
schema name. For 
example: 
dev_ofsaaconf, 
uat_ofsaatm.

Y Accepts strings with a minimum 
length of two and maximum of 
four.

Example: DEV, SIT, PROD

This name would appear in 
the OFSAA Landing Page as 
"Connected To: xxxx".

The schemas being created 
would get this prefix. For 
example, dev_ofsaaconf, 
uat_ofsaaconf, etc.

<PASSWORD>/DEF
AULT*

Enter the password if 
you want to set a 
default password for all 
schemas.

Note: You also need to 
set APPLYSAMEFORALL 
attribute as Y to apply 
the default password 
for all the schemas.

N The maximum length allowed is 
30 characters. Special characters 
are not allowed.

Tag Name/ 
Attribute Name Description

Mandatory 
(Y/ N) Default Value/ Permissible Value Comments
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<PASSWORD>/APPL
YSAMEFORALL

Enter as Y if you want 
to apply the password 
specified in DEFAULT 
attribute for all the 
schemas. 

If you enter as N, you 
need to provide 
individual passwords 
for all schemas.

Note: In case you have 
entered Y in 
APPLYSAMEFORALL 
attribute and also have 
specified individual 
passwords for all the 
schemas, then the 
specified individual 
passwords will take 
precedence.

Y Default - N

Permissible - Y

Note: Setting this attribute 
value is mandatory, if 
DEFAULT attribute is set.

<SCHEMA>/TYPE The different types of 
schemas that are 
supported in this 
release are ATOMIC, 
CONFIG, SANDBOX, and 
ADDON.

By default, the schemas 
types are seeded based 
on the Application 
Pack.

Note: Do not edit this 
attribute value.

Y ATOMIC/CONFIG/SANDBOX/ADD
ON

Note: SANDBOX and ADDON 
schemas are not applicable for 
OFS PFT Application Pack.

Only One CONFIG schema 
can exist in the file.

This schema identifies as the 
CONFIGURATION schema 
that holds the OFSAA setup 
detains and other Metadata 
information.

Multiple 
ATOMIC/SANDBOX/ADDON 
schemas can exist in the file.

ATOMIC schema refers to 
the Information Domain 
schema. SANDBOX schema 
refers to the SANDBOX 
schema. ADDON schema 
refers to other 
miscellaneous schema (not 
applicable for this 
Application Pack).

Note: The Profitability Pack 
supports only one Atomic 
Schema.

Tag Name/ 
Attribute Name Description

Mandatory 
(Y/ N) Default Value/ Permissible Value Comments
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<SCHEMA>/NAME Be default, the schema 
names are seeded 
based on the 
Application Pack.

You can edit the 
schema names if 
required.

Note: The Schema 
Name will have a prefix 
of the 
SETUPINFO/NAME 
attribute.

SCHEMA NAME must 
be same for all the 
ATOMIC Schemas of 
the applications within 
an Application Pack.

Y The permissible length is 15 
characters and only alphanumeric 
characters are allowed. No special 
characters allowed except 
underscore '_'.

SETUPOINFO/NAME 
attribute value would be 
prefixed to the schema 
name being created.

For example, if name is set 
as 'ofsaatm' and setupinfo 
as 'uat', then schema being 
created would be 
'uat_ofsaatm'.

NAME should be same 
where APP_GRP=1 for all 
SCHEMA tags (Not 
applicable for this 
Application Pack).

<SCHEMA>/PASSW
ORD

Enter the password of 
the schema to be 
created.

Note: If this attribute is 
left blank, then the 
password specified in 
the 
<PASSWORD>/DEFAULT 
attribute is applied as 
the Schema Password.

N The maximum length allowed is 
30 characters. Special characters 
are not allowed.

Note: You need to 
mandatorily enter the 
password if you have set the 
<PASSWORD>/APPLYSAMEF
ORALL attribute as N.

<SCHEMA>/APP_ID By default, the 
Application ID is seeded 
based on the 
Application Pack.

Note: Do not edit this 
attribute value.

Y Unique Seeded Value Identifies the Application/ 
Product for which the 
schema is being created.

DO NOT modify this value.

<SCHEMA>/DEFAUL
TTABLESPACE

Enter the available 
default tablespace for 
DB User.

Note: If this attribute is 
left blank, then USERS 
is set as the default 
tablespace.

N Default - USERS

Permissible - Any existing valid 
tablespace name.

Modify this value to 
associate any valid 
tablespace with the schema.

<SCHEMA>/TEMPT
ABLESPACE

Enter the available 
temporary tablespace 
for DB User.

Note: If this attribute is 
left bank, TEMP is set 
as the default 
tablespace.

N Default - TEMP

Permissible - Any existing valid 
temporary tablespace name.

Default - TEMP

Permissible - Any existing 
valid temporary tablespace 
name.

Tag Name/ 
Attribute Name Description

Mandatory 
(Y/ N) Default Value/ Permissible Value Comments
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<SCHEMA>/QUOTA Enter the quota to be 
set on 
DEFAULTTABLESPACE 
attribute for the 
schema/ user. By 
default, the quota size 
is set to 500M.

Minimum: 500M or 
Unlimited on default 
Tablespace.

N Example:

600M/ m

20G/ g

UNLIMITED/ unlimited

Modify this value to grant 
the specified quota on the 
mentioned tablespace to the 
user.

<SCHEMA>/INFOD
OM

Enter the name of the 
Information Domain to 
associate this schema.

The schema creator 
utility automatically 
derives an Information 
Domain Name based 
on the Application Pack 
if no value is specified 
for this attribute.

N Permissible length is 16 
characters and only alphanumeric 
characters are allowed. No special 
characters are allowed.

Tag Name/ 
Attribute Name Description

Mandatory 
(Y/ N) Default Value/ Permissible Value Comments
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APPENDIX K Configuring 
OFSAAI_InstallConfig.xml File

To configure the OFS_InstallConfig.xml file:

1. Navigate to OFS_PFT_PACK/OFS_AAI/conf/ folder.

2. Open the file OFSAAI_InstallConfig.xml in text editor.

3. Configure the OFSAAI_InstallConfig.xml as mentioned in the below table:
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You need to manually set the InteractionVariable parameter values as mentioned in the table. If a value is not 
applicable, enter NA and ensure that the value is not entered as NULL.

InteractionVariable Name Significance and Expected Value Mandatory

<Layer name="GENERAL">

WEBAPPSERVERTYPE Identifies the web application server on which the OFSAA Infrastructure 
web components would be deployed.

The below numeric value should be set depending on the type:

Apache Tomcat = 1

IBM WebSphere Application Server = 2

Oracle WebLogic Server = 3

For example,  <InteractionVariable 
name="WEBAPPSERVERTYPE">3</InteractionVari able>

Yes

DBSERVER_IP Identifies the host name or IP address of the system on which the 
Database Engine is hosted.

Note: For RAC Database, the value should be NA.

For example, <InteractionVariable name="DBSERVER_ 
IP">14.15.16.17</InteractionVariable> or

<InteractionVariable name="DBSERVER_ 
IP">dbhost.server.com</InteractionVariable>

Yes

ORACLE_SID/SERVICE_NA
ME

Identifies the Oracle DB Instance SID or SERVICE_NAME

Note: The Oracle_SID value should be exactly the same as it is 
mentioned in JDBC_URL.

For example, <InteractionVariable name="ORACLE_SID/SERVICE_

NAME">ofsaser</InteractionVariable>

Yes

ABS_DRIVER_PATH Identifies the directory where the JDBC driver (ojdbc<version>.jar) 
exists. This would typically be the

$ORACLE_HOME/jdbc/lib

For example, <InteractionVariable name="ABS_DRIVER_ 
PATH">">/oradata6/revwb7/oracle

</InteractionVariable>

Note: See JDBC Jar Files for identifying the correct "ojdbc<version>.jar" 
version to be copied.

Yes

OLAP_SERVER_ 
IMPLEMENTATION

Identifies if the OFSAA Infrastructure OLAP component needs to be 
configured depending on whether you intend to use the OLAP feature. 
The below numeric value should be set depending on the choice:

YES - 1

NO - 0

No

Note: If value for OLAP_SERVER_IMPLEMENTATION is set to 1, it checks for following environment variables are set in .profile:

ARBORPATH, HYPERION_HOME and ESSBASEPATH.
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SFTP_ENABLE Identifies if the SFTP (Secure File Transfer Protocol) feature is to be 
enabled. The below numeric value should be set depending on the 
choice:

SFTP - 1

FTP - 0

Yes

Note: The default value for SFTP_ENABLE is 1, which signifies that SFTP will be used. Oracle recommends using SFTP instead of FTP 
because SFTP is considered more secure. However, a client may choose to ignore this recommendation and to use FTP by setting 
SFTP_ENABLE to 0. This selection may be changed later by using the OFSAAI administration interface.

FILE_TRANSFER_PORT Identifies the port used for the file transfer service. The default value 
specified is 22 (SFTP). Specify value as 21 or any other PORT value if 
value for SFTP_ENABLE is 0.

For example, <InteractionVariable name="FILE_TRANSFER_ 
PORT">21</InteractionVariable>.

Yes

LOCALE Identifies the locale information to be used during the installation. This 
release of the OFSAA Infrastructure supports only US English.

For example, <InteractionVariable 
name="LOCALE">en_US</InteractionVariable>

Yes

Note: The below ports are used internally by the various OFSAA Infrastructure services. The default values mentioned below are set 
in the installation. If you intend to specify a different value, update the parameter value accordingly and ensure this port value is in 
the range of 1025 to 65535 and the respective port is enabled.

JAVAPORT 9999 Yes

NATIVEPORT 6666 Yes

AGENTPORT 6510 Yes

ICCPORT 6507 Yes

ICCNATIVEPORT 6509 Yes

OLAPPORT 10101 Yes

MSGPORT 6501 Yes

ROUTERPORT 6500 Yes

AMPORT 6505 Yes

Note: If value for HTTPS_ENABLE is set to 1, ensure you have a valid certificate available from a trusted CA and the same is 
configured on your web application server. For more details on configuring your setup for HTTPS.

HTTPS_ENABLE Identifies if the UI should be accessed using HTTP or HTTPS scheme. The 
default value set is 0. The below numeric value should be set depending 
on the choice:

YES - 1

NO - 0

For example, <InteractionVariable 
name="HTTPS_ENABLE">0</InteractionVariable>

Yes

InteractionVariable Name Significance and Expected Value Mandatory
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WEB_SERVER_IP Identifies the HTTP Server IP/ Host name or Web Application Server IP/ 
Host name, to be used for accessing the UI. This IP would typically be the 
HTTP Server IP.

If no separate HTTP Server is available, the value should be Web 
Application Server IP/Host name.

For example, <InteractionVariable name="WEB_SERVER_ 
IP">10.11.12.13</InteractionVariable>

or

<InteractionVariable name="WEB_SERVER_ 
IP">myweb.server.com</InteractionVariable>

No

WEB_SERVER_PORT Identifies the Web Server Port. This would typically be 80 for non SSL and 
443 for SSL. If no separate HTTP Server exists, the value should be the 
port configured for Web Server.

Note: The port value will not be accepted as 80 if HTTPS_ENABLE is 1 and 
as 443, if HTTPS_ENABLE is 0.

For example, <InteractionVariable name="WEB_ 
SERVER_PORT">80</InteractionVariable>

No

CONTEXT_NAME Identifies the web application context name which will be used to build 
the URL to access the OFSAA applications. The context name can be 
identified from a URL as below:

<scheme>://<host>:<port>/<context-name>/lo gin.jsp

Sample URL:

https://myweb:443/ofsaadev/login.jsp

For example, <InteractionVariable name="CONTEXT_ 
NAME">ofsaadev</InteractionVariable>

Yes

WEBAPP_CONTEXT_PATH Identifies the absolute path of the exploded .ear file on the web 
application server.

For Tomcat, specify the Tomcat directory path till

/webapps, such as

/oradata6/revwb7/tomcat/webapps/.

For WebSphere, enter the WebSphere path as

<WebSphere profile directory>/installedApps/

<NodeCellName>. For example,

/data2/test//WebSphere/AppServer/profiles/

<Profile_

Name>/installedApps/aix-imfNode01Cell. Where aix-imf is Host name.

For WebLogic, provide the WebLogic home directory path as /<WebLogic 
home directory path>/bea/wlserver_10.3

Note: For WebLogic, value specified for this attribute is ignored and 
value provided against attribute WEBLOGIC_DOMAIN_HOME is 
considered.

Yes

InteractionVariable Name Significance and Expected Value Mandatory
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WEB_LOCAL_PATH Identifies the absolute path to any directory on the web application 
server that can hold temporary files being uploaded as part of the 
applications usage. User can set this in FTPSHARE location to avoid the 
confusion.

Note: In case of a clustered deployment, ensure this path and directory 
is same on all the nodes.

Yes

WEBLOGIC_DOMAIN_HO
ME

Identifies the WebLogic Domain Home. Specify the value only if 
WEBSERVERTYPE is set as 3 (WebLogic).

For example, <InteractionVariable name="WEBLOGIC_DOMAIN_

HOME">/home/weblogic/bea/user_ projects/domains/mydomain

</InteractionVariable>

Yes. Specify the value only 
if WEBSERVERTYPE is set 
as 3 (WebLogic)

OFSAAI_FTPSHARE_PATH Identifies the absolute path to the directory identified as file system 
stage area.

Note: The directory should exist on the same system on which the 
OFSAA Infrastructure is being installed (can be on a separate mount).

The user mentioned in APP_SFTP_USER_ID parameter below should 
have RWX permission on the directory.

For example, <InteractionVariable 
name="APP_FTPSHARE_PATH">">/oradata6/revwb7/ftpshare</Interacti
onVariable>

Yes

OFSAAI_SFTP_USER_ID Identifies the user who has RWX permissions on the directory identified 
under parameter APP_FTPSHARE_PATH above.

Yes

HIVE_SERVER_PORT Not applicable

HIVE_SERVER_FTPDRIVE Not applicable

HIVE_SERVER_FTP_USERI
D

Not applicable

HIVE_SERVER_FTP_PROT
OCOL

Not applicable

InteractionVariable Name Significance and Expected Value Mandatory
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APPENDIX L Configuring Resource Reference 
Web Application Servers

This appendix includes the following topics:

 Configure Resource Reference in WebSphere Application Server

 Configure Resource Reference in WebLogic Application Server

 Configure Resource Reference in Tomcat Application Server

Configure Resource Reference in WebSphere Application Server

This section is applicable only when the Web Application Server is WebSphere.

This section includes the following topics:

 Create JDBC Provider

 Create Data Source

 J2C Authentication Details

 JDBC Connection Pooling

Create JDBC Provider

1. Open the WebSphere admin console in the browser window: 

http://<ipaddress>:<administrative console port>/ibm/console. (https if SSL is enabled). The Login 
window is displayed. 

2. Login with the user ID that has admin rights.

3. Expand the Resources option in the LHS menu and click JDBC > JDBC Providers to display the JDBC Providers window.
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Figure 1: JDBC Providers

4. Select the Scope from the drop-down list. Scope specifies the level at which the resource definition is visible.

5. Click New to add new JDBC Provider under the Preferences section. The Create new JDBC provider window is 

displayed.

Figure 2: Create a new JDBC Provider
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6. Enter the following details:

 Database Type - Oracle

 Provider Type- Oracle JDBC Driver

 Implementation Type- Connection pool data source

 Name- The required display name for the resource

 Description - The optional description for the resource

7. Click Next. 

Figure 3: Enter database class path information

8. Specify the directory location for "ojdbc<version>.jar" file. Ensure that you do not use the trailing slash file separators.

The Oracle JDBC driver can be downloaded from the following Oracle Download site:

 Oracle Database 11g Release 2 (11.2.0.4) JDBC Drivers

 Oracle Database 12c Release 1 (12.1.0.1) JDBC Drivers

Once downloaded, you need to copy the file in the required folder on the server.

Note: See JDBC Jar Files for identifying the correct ojdbc<version>.jar version to be copied.

Once downloaded, you need to place the file in the required folder in your system. While creating the JDBC Provider, 
ensure that the path to the jar file in the folder is specified in the Classpath field in the previous window.

9. Click Next to display the Summary window.
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Figure 4: Summary

10. Verify the details and click Finish to create the JDBC Provider.

11. The options to Save and Review are displayed. Click Save.

Create Data Source

The steps given below are applicable for both CONFIG and ATOMIC data source creation.

1. Open the WebSphere admin console in the browser window: 

http://<ipaddress>:<administrative console port>/ibm/console. (https if SSL is enabled). The Login 
window is displayed.

2. Login with the user id that has admin rights.

3. Expand the Resources option in the LHS menu and click JDBC > Data sources option to display the Data sources page.

Figure 5: Data Sources
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4. Select the Scope from the drop down list. Scope specifies the level at which the resource definition is visible.

5. Click New to display the Create a Data Source window.

Figure 6: Create a data source

6. Specify the Data Source name and JNDI name for the new "Data Source".

The JNDI and Data Source name are case sensitive. Ensure that JNDI name is same as the "Information Domain" 
name. 

7. Click Next to display the Select JDBC provider window.

Figure 7: Select JDBC provider

8. Select the option Select an Existing JDBC Provider and select the required JDBC provider from the drop-down list. 

Click Next.
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Figure 8: Enter database specific properties

9. Specify the database connection URL.

For Example: jdbc:oracle:thin:@<DB_SEREVER_IP>:<DB_SERVER_PORT>:<SID>

10. Select Data Store Helper Class Name from the drop-down list and ensure that the checkbox Use this data source in 

container managed persistence (CMP) is selected. 

Note: For RAC configuration, provide the RAC URL specified during installation.

For Example: 
jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=10.11.12.
13)(port=1521))(ADDRESS=(PROTOCOL=TCP)(HOST=10.11.12.14)(PORT=1521))(LOAD_BALANCE=n
o)(FAILOVER=yes))(CONNECT_DATA=(SERVICE_NAME=pqadb)))

11. Click Next.

Figure 9: Setup security aliases
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12. Map the J2C authentication alias, if already created. If not, you can create a new J2C authentication alias by accessing 

the link given (Global J2C authentication alias) or you can continue with the data source creation by clicking Next and 

then Finish.

Figure 10: Summary

You can also create and map J2C authentication alias after creating the data source.

13. You must create another Data source by following the above procedure with jdbc/FICMASTER as JNDI name pointing 

to the "configuration schema" of Infrastructure.

J2C Authentication Details

The steps given below are applicable for creating both config and atomic J2C Authentication.

To create J2C Authentication details:

1. Select the newly created Data Source and click JAAS - J2C authentication data link under Related Items. 
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Figure 11: JAAS- J2C authentication data

2. Click New under the Preferences section.

Figure 12: JAAS- J2C authentication data- New

3. Enter the Alias, User ID, Password, and Description. Ensure the following:

 User ID is the Oracle user ID created for the respective CONFIG and ATOMIC Schema for the "Information 
Domain".

 Specify the CONFIG database user ID and password information for the jdbc/FICMASTER data source, and specify 
the ATOMIC database user ID and password information for the ATOMIC schema data source that you created 
earlier.

4. Click Apply and save the details.
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JDBC Connection Pooling

To define the JDBC connection pooling ensure that you have created JDBC Provider and Data source to access the data 
from the database.

1. Expand the Resources option in the LHS menu and click JDBC > Data sources option to display the Data sources page.

2. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path Data sources > $DATA_SOURCE$ > 

Connection pools.

Figure 13: Connection Pools

3. Set the values for the following:

 Connection timeout to 0 seconds

 Maximum connections to 100 connections

 Minimum connections to 10 connections

You can also define Reap Time, Unused Timeout, and Aged Timeout as required.
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Configure Resource Reference in WebLogic Application Server

This section is applicable only when the Web Application Server is WebLogic.

This section includes the following topics:

 Create Data Source

 Create GridLink Data Source

 Configure Multi Data Sources

 Advanced Settings for Data Source

 JDBC Connection Pooling

In WebLogic, you can create "Data Source" in the following ways:

 For a Non RAC Database instance, Generic Data Source has to be created. For more information, see Create Data 
Source.

 For a RAC Database instance, Gridlink Data Source has to be created. For more information, see Create GridLink Data 
Source.

 When Load Balancing/Fail over is required, Multi Data Source has to be created. For more information, see Configure 
Multi Data Sources.

Create Data Source

The steps given below are applicable for both config and atomic data source creation.

1. Open the WebLogic admin console in the browser window: 

http://<ipaddress>:<administrative console port>/console. (https if SSL is enabled). The Login 
window is displayed.

2. Login with the Administrator Username and Password. 

Figure 14: Welcome
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3. From the LHS menu (Domain Structure), click Services > Data Sources to display the Summary of JDBC Data Sources 

window.

Figure 15: Summary of JDBC Data Sources

4. Click New and select Generic Data Source option to display the Create a New JDBC Data Source window.

You can also select GridLink Data Source or Multi Data Source while creating a Data Source. For more information, 
see Create GridLink Data Source or Configure Multi Data Sources.

Figure 16: Create a New JDBC Data Source

5. Enter JDBC data source Name, JNDI Name, and select the Database Type from the drop-down list. Click Next.
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Ensure the following:

 The JNDI Name field should be in the format "jdbc/informationdomain"

 Same steps needs to be followed to create a mandatory data source pointing to the "configuration schema" of 
infrastructure with jdbc/FICMASTER as JNDI name. 

 JNDI Name is the same as mentioned in web.xml file of OFSAAI Application.

 Required "Database Type" and "Database Driver" should be selected.

Figure 17: JDBC Data Source Properties

6. Select the Database Driver from the drop-down list. You need to select the Database Driver depending on database 

setup, that is, with or without RAC. Click Next.

Figure 18: Transaction Options

7. Select the Supports Global Transactions checkbox and the One-Phase Commit option.

8. Click Next to display the Connection Properties window.
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Figure 19: Connection Properties

9. Enter the required details such as the Database Name, Host Name, Port, Oracle User Name, and Password. 

10. Click Next to display the Test Database Connection window.
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Figure 20: Test Database Connection

11. Verify the details and click Test Configuration and test the configuration settings.

A confirmation message is displayed stating "Connection test succeeded."

12. Click Finish. The created "Data Source" is displayed in the list of Data Sources.

Note: “User ID" is the Oracle user ID that is created for the respective "Information Domain".

"User ID" to be specified for data source with "FICMASTER" as "JNDI" name should be the Oracle user ID 
created for the CONFIG schema.

13. Select the new Data Source and click the Targets tab. 
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Figure 21: Select Targets

14. Select the AdminServer option and click Finish.

Create GridLink Data Source

If you have selected the option, New > GridLink Data Source while creating the "Data Source", you can directly specify the 
JDBC URL as indicated.

Figure 22: Create a New JDBC GridLinkData Source

1. Enter Data Source Name, and JNDI Name.

Ensure that the "JNDI Name" field is specified in the format "jdbc/infodomname" and the XA Driver checkbox is not 
selected. Click Next.
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Figure 23: JDBC GridLinkData Source- Connection Properties

2. Specify Complete JDBC URL, Database User Name, and Password. Click Finish. The created "Data Source" is displayed 

in the list of Data Sources.

Configure Multi Data Sources

A JDBC multi data source is an abstraction around a group of data sources that provides load balancing and failover 
between data sources. As with data sources, multi data sources are also bound to the JNDI tree. Applications can look up a 
multi data source on the JNDI tree and then reserve a database connection from a data source. The multi data source 
determines from which data source to provide the connection.

When the database used is Oracle RAC (Real Application Clusters) which allows Oracle Database to run across a set of 
clustered servers, then group of data sources can be created for instances running on a set of clustered servers and a JDBC 
multi data source can be created so that applications can look up a multi data source on the JNDI tree to reserve database 
connection. If a clustered server fails, Oracle continues running on the remaining servers.

1. Open the WebLogic admin console in the browser window: 

http://<ipaddress>:<administrative console port>/console. (https if SSL is enabled). The Login 
window is displayed.

2. Login with the "User ID" that has admin rights.

3. In the LHS menu (Domain Structure), select Services > JDBC > Multi Data Sources to display the Summary of JDBC 

Multi Data Sources window.
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Figure 24: Summary of JDBC Multi Data Sources

4. Click New to display the New JDBC Multi Data Source screen.

Note: Ensure that the Data Sources which needs to be added to new JDBC Multi Data Source has been 
created.

Figure 25: Configure the  Multi Data Source

5. Enter the JDBC Source Name, JNDI name, and select the Algorithm Type from the drop-down list. Click Next.

Note: The JNDI Name has to be specified in the format jdbc/infodomname.

JNDI Name of the Data Sources that will be added to new JDBC Multi data source should be different from 
the JNDI name specified during Multi Data Source.

Same steps needs to be followed to create a mandatory data source pointing to the "configuration schema" 
of infrastructure with jdbc/FICMASTER as JNDI name for Data Source.

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Same steps needs to be followed to create a mandatory data source pointing to the "configuration schema" 
of infrastructure with jdbc/FICMASTER as JNDI name for Data Source.

JNDI Name provided in multi data source should be the same name that will be mentioned in the web.xml 
file of OFSAAI Application.

You can select the Algorithm Type as Load-Balancing.

Figure 26: Select Targets

6. Select the AdminServer check box and click Next.

Figure 27: Select Data Source Type

7. Select the type of data source which will be added to new JDBC Multi Data Source. Click Next.

Figure 28: Add Data Sources

8. Map the required Data Source from the Available Data Sources. Click Finish.

The New JDBC Multi Data Source is created with added data sources.
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Advanced Settings for Data Source

1. Click the new Data Source from the Summary of JDBC Data Sources window. The Settings for <Data Source Name> 

window is displayed.

2. Select the Connection Pooling tab given under Configuration.

3. Go to the Advanced option at the bottom of the page, and check the Test Connection of Reserve checkbox (Enables 

Weblogic Server to test a connection before giving it to a client).

4. To verify if the data source is valid, select "Data Source name". For example, FICMASTER.

Figure 29: Settings for <Data Source Name>

5. Select the server and click Test Data Source.

A message is displayed indicating that the test was successful.

6. Once the "Data Source" is created successfully, the following messages are displayed:

 All changes have been activated. No restart is necessary.

 Settings updated successfully. 

If not, follow the steps given above to recreate the data source. 

JDBC Connection Pooling

To define the JDBC connection pooling, ensure that you have created JDBC Provider and Data source to access the data 
from the database.

1. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path Home >Summary of Services: JDBC 

>Summary of JDBC Data Sources >JDBC Data Source-<INFODDOM_NAME>

2. Set the values for Initial Capacity to 10, Maximum Capacity to 100, Capacity Increment by 1, Statement Cache Type to 

LRU, and Statement Cache Size to 10.

3. Click Save.
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Configure Resource Reference in Tomcat Application Server

This section is applicable only when the Web Application Server is Tomcat.

This section includes the following topics:

 Create Data Source

 JDBC Connection Pooling

 Class loader configuration for Apache Tomcat

Copy the Oracle JDBC driver file, ojdbc<version>.jar from <Oracle Home>/jdbc/lib and place it in <Tomcat Home>/lib.

Note: See Appendix S for identifying the correct ojdbc<version>.jar version to be copied.

Create Data Source

To create "data source" for OFSAA application, navigate to <Tomcat Home>/conf and edit the following block of text by 
replacing the actual values in server.xml.

Note: The User-IDs for configuration/ atomic schemas have the prefix of setupinfo depending on the value 
set for PREFIX_SCHEMA_NAME in <<APP Pack>>_SCHEMA_IN.XML file of Schema Creator Utility. 

For example:  if the value set for PREFIX_SCHEMA_NAME is DEV and the schema name was mentioned as 
ofsaaconf, then the actual schema created in the database would be DEV_ofsaaconf.

<Context path ="/<context name>" docBase="<Tomcat Installation 
Directory>/webapps/<context name>" debug="0" reloadable="true" crossContext="true">

<Resource auth="Container" 

name="jdbc/FICMASTER"

type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username="<user id for the configuration schema>" 

password="<password for the above user id>" 

url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"

maxActive="100" 

maxIdle="30"

maxWait="10000"/>

<Resource auth="Container"

name="jdbc/< INFORMATION DOMAIN NAME >"

type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username="<user id for the atomic schema>"

password="<password for the above user id>"
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url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"

maxActive="100"

maxIdle="30"

maxWait="10000"/>

</Context>

Note: The <Resource> tag must be repeated for each Information Domain created. After the above 
configuration, the "WAR" file has to be created and deployed in Tomcat.

JDBC Connection Pooling

To define the JDBC connection pooling, do the following:

1. Copy $ORACLE_HOME/jdbc/lib/ojdbc<version>.jar to the path $TOMCAT_DIRECTORY/lib/.

Note: Refer JDBC Jar Files for identifying the correct "ojdbc<version>.jar" version to be copied.

2. Edit the server.xml present under the path $TOMCAT_DIRECTORY/conf/ with the below changes, which is required 

for connection pooling.

<Context path="/ $CONTEXTNAME$" docBase=" $APP_DEPLOYED_PATH$ " debug="0" 
reloadable="true" crossContext="true">

<Resource auth="Container"

name="jdbc/ $INFODOM_NAME$"

type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username=" $ATOMICSCHEMA_USERNAME$"

password="$ATOMICSCHEMA_PASSWORD$"

url="$JDBC_CONNECTION_URL"

maxActive="100"

maxIdle="30"

maxWait="10000"

removeAbandoned="true" removeAbandonedTimeout="60"

logAbandoned="true"/>

</Context>
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Note the following:

 $APP_DEPLOYED_PATH$ should be replaced by OFSAAI application deployed path.

 $INFODOM_NAME$ should be replaced by Infodom Name.

 $ATOMICSCHEMA_USERNAME$ should be replaced by Atomic schema database user name.

 $ATOMICSCHEMA_PASSWORD$ should be replaced by Atomic schema database password.

 $JDBC_CONNECTION_URL should be replaced by JDBC connection string jdbc:Oracle:thin:<IP>:<PORT>:<SID>. For 
example, jdbc:oracle:thin 10.80.50.53:1521:soluint

 The User-IDs for configuration/ atomic schemas have the prefix of setupinfo depending on the value set for 
PREFIX_SCHEMA_NAME in <<APP Pack>>_SCHEMA_IN.XML file of Schema Creator Utility.

For example: if the value set for PREFIX_SCHEMA_NAME is DEV and the schema name was mentioned as ofsaaconf, 
then the actual schema created in the database would be DEV_ofsaaconf.

Class loader configuration for Apache Tomcat

Edit the server.xml available in $TOMCAT_HOME/conf/ folder.

Add tag <Loader delegate="true" /> within the <Context> tag, above the <Resource> tag. This is applicable only 
when the web application server is Apache Tomcat 8.

Note: This configuration is required if Apache Tomcat version is 8.
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APPENDIX M Post Deployment Configuration

This chapter covers the following topics:

 Deploying the Application

 Logging as System Administrator

 Creating Application Users

 Mapping Application User(s) to User Group

 Change ICC Batch Ownership

 Mapping ICC Batch Execution Rights to User

 Saving Post- Load Change Transformations

Deploying the Application

Deploying FTP Application

The Oracle Financial Services Analytical Applications Infrastructure Application Server is started using reveleusstartup.sh. 
This file can be edited for setting customized memory settings, garbage collector settings depending on the available 
hardware configuration. Please raise an SR in support.Oracle.com if you have any queries related to EPM applications. 

Once the installation of Oracle Financial Services Funds Transfer Pricing Management Product is completed, you must 
perform the following steps:

1. Check the Log file.

2. Add the below mentioned entries in excludeURLList.cfg file located in the path 

$FIC_WEB_HOME/webroot/conf/. These entries are required for Asset and Liability Management, Funds Transfer 

pricing, Profitability Management and Hedge Management/ IFRS: 

[SQLIA]./fsapps/common/batchCreate.action

[SQLIA]./fsapps/common/batchEdit.action

Note: Copy the above information into notepad, and then copy it from notepad into cfg file. Take extra care 
to avoid copying formatting characters into the cfg file.

3. For Administrative Reports (Admin BI) configuration follow the steps mentioned in Oracle Financial Services 

Administrative Reports on OBIEE 11g v8.0.2.0.0 - Configuration Note.docx under $FIC_HOME/adminbi/.

Note: You can also find the Oracle Financial Services Administrative Reports on OBIEE 11g v8.0.2.0.0 - 
Configuration Note on OHC.

4. The web.xml under the path $FIC_WB_HOME \webroot\WEB-INF\ should have Resource tag, if not present add the 

tag and replace ORDEMO with the INFODOM name. 
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<resource-ref>

<description>DB ConnectionORDEMO</description> 

<res-ref-name>jdbc/ORDEMO</res-ref-name> 

<res-type>javax.sql.DataSource</res-type> 

<res-auth>Container</res-auth> 

</resource-ref> 

Note: Copy the above information into notepad, and then copy it from notepad into cfg file. Take extra care 
to avoid copying formatting characters into the cfg file.

5. Execute below script as a post installation step:

 $FIC_HOME/scripts/atomic/create/indexes.sql

Note: This may display some ORA errors, those can be ignored.

6. If there are ICC batch processes created having roll_portfolio and rebalance_portfolio DTs as the tasks, the parameter 

list of the DTs are to be updated as: 

 If the parameters for roll portfolio are '70001', 'TP', 'TP USER1',change the parameters as :  '','','','','70001', 'TP', 
'TP USER1'. 

 If the parameters for re-balance portfolio are '70001', '2', 'TP USER1', 'TP' change the parameters as: 
'','','','','70001', '2', 'TP USER1', 'TP'.

An example as of Merge Portfolio is given below: 

 Run ID: when running via ICC batch and Simplified batch process, this parameter can be passed as ''.

 Process ID: when running via ICC batch and Simplified batch process, this parameter can be passed as '' 

 Execution ID: when running via ICC batch and Simplified batch process, this parameter can be passed as '' 

 Run Surrogate Key: when running via ICC batch and Simplified batch process, this parameter can be passed as '' 

 Pattern Code, for example, '70001' 

 FTP User, for example, 'TP USER 1' 
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 Application ID, for example, 'TP' (this is a static value) 

 When to merge (roll versus rebalance): when running via ICC batch and Simplified batch process, this parameter 
should always be 'N'. Maturity date identifying maturing strips to be merged on roll : when running via ICC batch 
and Simplified batch process, this parameter should always be '' 

These parameters would appear as follows in the simplified batch parameter input block: 

 '','','','','70001', 'TP USER 1', 'TP', 'N', '' 

 oThe parameter pattern to be used when RP batches are scheduling from the Run Rule Framework.   When 
executing from the Run Rule Framework, the user does not have to pass  the Run ID, Process ID, Execution ID, and 
Run Surrogate Key, as the framework itself passes these values along with the Batch ID and MISDATE. The 
parameters would appear as follows: 

"70001","TP USER 1","TP","N",""

7. Transfer the ownership of batches to the required User.

a. Login to config user.

b. Execute the Following anonymous pl/sql block to execute  procedure 
"AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP".

begin 

AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP('fromUser','toUser','infodom'); 

end; 

OR 

begin 

AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP('fromuser','touser'); 

end; 

Parameter details:

 fromUser:  indicates the user who currently owns the batch

 to User:  indicated the user to which the ownership has to be transferred. 

 infodom: optional parameter , if specified the ownership of batches pertaining to that Infodom will be 
changed.

8. If the web application server is hosted on a machine other than where pack is installed, then perform the following 

step.

 Generate RSA key for the machine where Web application server is hosted.

 Add the generated RSA key to the authorized keys list of the machine where Pack s installed.

Deploying PFT Application

The Oracle Financial Services Analytical Applications Infrastructure Application Server is started using reveleusstartup.sh. 
This file can be edited for setting customized memory settings, garbage collector settings depending on the available 
hardware configuration. Please raise an SR in support.Oracle.com if you have any queries related to EPM applications. 

Once the installation of Oracle Financial Services Profitability Management Product is completed, you must perform the 
following steps:

1. Check the Log file.

2. Add the below mentioned entries in excludeURLList.cfg file located in the path 

$FIC_WEB_HOME/webroot/conf/. These entries are required for Asset and Liability Management, Funds Transfer 

pricing, Profitability Management and Hedge Management/ IFRS: 
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[SQLIA]./fsapps/common/batchCreate.action

[SQLIA]./fsapps/common/batchEdit.action

3. For Administrative Reports (Admin BI) configuration follow the steps mentioned in Oracle Financial Services 

Administrative Reports on OBIEE 11g - Configuration Note.docx under $FIC_HOME/adminbi.

4. The web.xml under the path $FIC_WB_HOME \webroot\WEB-INF\ should have Resource tag, if not present add the 

tag and replace ORDEMO with the INFODOM name. 

<resource-ref>

<description>DB ConnectionORDEMO</description> 

<res-ref-name>jdbc/ORDEMO</res-ref-name> 

<res-type>javax.sql.DataSource</res-type> 

<res-auth>Container</res-auth> 

</resource-ref> 

Note: Copy the above information into notepad, and then copy it from notepad into cfg file. Take extra care 
to avoid copying formatting characters into the cfg file.

5. Execute below script as a post installation step:

 $FIC_HOME/scripts/atomic/create/indexes.sql

Note: This may display some ORA errors, those can be ignored.

6. Transfer the ownership of batches to the required User.

a. Login to config user.

b. Execute the Following anonymous pl/sql block to execute  procedure 
"AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP".

begin

AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP('fromUser','toUser','infodom'); 

end; 

OR

begin 

AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP('fromuser','touser'); 

end; 

Parameter details:

 fromUser:  indicates the user who currently owns the batch

 to User:  indicated the user to which the ownership has to be transerred. 

 infodom: optional parameter , if specified the ownership of batches pertaining to that Infodom will be 
changed.
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7. If the web application server is hosted on a machine other than where pack is installed, then perform the following 

step.

 Generate RSA key for the machine where Web application server is hosted.

 Add the generated RSA key to the authorized keys list of the machine where Pack s installed
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Deploying EFPA/ IPA/ RPA Applications

Ensure that the Oracle Business Intelligence version 11.1.1.7.1 is available.

Note: After Installation, patch 16556157 is recommended for all the customers who are using Oracle 
Business Intelligence Enterprise Edition 11.1.1.7.0. This patch can be downloaded from Oracle support site.

1. Set the <Oracle BI Instance Home> directory> =>. 

For example: /u01/OBIEE11G/instances/instance1 

2. Start Weblogic AdminServer. 

a. Set the < BI Domain Home> directory> => e.g. 

/u01/OBIEE11G/user_projects/domains/bifoundation_domain.

b. Navigate to < BI Domain Home >/bin and run 'nohup ./startWebLogic.sh &' 

c. Bringing up this service may take a few minutes depending on your environment.Check the logs using the 
command 'tail -f nohup.out' 

3. Start Node Manager.

a. Set the < WebLogic Server Home > directory> => e.g. 

/u01/OBIEE11G/wlserver_10.3. 

b. Navigate to <WebLogic Server Home>/server/bin and run 'nohup ./startNodeManager.sh &'. 

4. Start Weblogic Managed Server(bi_server1). 

a. Login onto http://localhost:7001/console using your Administrator credentials created during platform install 

(Replace the hostname based on your setup).

b. Under Environment block (mid of page, towards left side), click on Servers link.

c. The bi_server1 line should show as shutdown state at this point. 
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d. Click on control page tab.

e. Select the bi_server1 line by clicking on the left tick box, 

f. Click start button at the top of the list and confirm starting this service 

g. State will update to "RUNNING" mode after a few minutes.

5. Start BIEE services and login.

a. Starting services From EM screen.

i. Log in to the EM administration screen using the url http://localhost:7001/em (Replace the hostname and 

port number based on your setup). Use the login you created in BIEE installation to log in.

ii. Expand 'Business Intelligence' node on the left and choose Coreapplication.

iii. Click on the Overview Tab.
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iv. Click on blue button 'Restart' (or green button 'Start' ) under the Manage System category, middle of screen. 

v. Click yes on dialog box to confirm the move. Wait for message that confirms successful restart.

b. If starting using EM is not successful and complaining about OPMNCTL not up, Follow starting process with 
OPMNCTL.

i. Open a command prompt, navigate to <Oracle BI Instance Home>/bin.

ii. run "./opmnctl status, this will show you status of all the OBIEE core services.

iii. run "./opmnctl startall" or "./opmnctl stopall" depending on your need.

6. Deploy RPD and webcat file(s).

a. Copy OFS_PFT_PACK.rpd from $FIC_HOME/OFSPFTPACKBI/OBIEE11G of Web layer to windows machine where 

the OBIEE windows administration client is installed.

Copy these catalog files to the local folder, where OFS_PFT_PACK.rpd has been copied. 

b. Login to OBIEE - Enterprise Manager URL (http://<ip address>:<port>/em). 

i. Click on hyperlink 'coreapplication' from 'Business Intelligence' tab on left hand side.

ii. Under 'coreapplication', select the tab 'Deployment' and in that select sub-tab 'Repository'.

iii. Click 'Lock and Edit Configuration' button located below title 'coreapplication'. Following screen is displayed. 
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iv. RPD Deployment: Select 'Browse' button available under 'Upload BI Server Repository' section and select 
OFS_PFT_PACK.rpd file from the local folder. Enter Repository password Admin123.

v. Web catalog Deployment: 

 Open the analytics OBIEE URL-(http://<ipaddress>:<port>/analytics) and login with the credentials.

 Click "Catalog" link available on the top right corner.

 Click "Shared Folders" and then "Un-Archive".
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 Browse the path where "OFS_PFT_PACK.catalog" is copied in the local folder. Select the file and click 
"Open". Then click "OK". 

 Click on "Shared Folders" and then on Un-Archive. Browse the path where "OFS_PFT_PACK.catalog" is 
copied in the local folder. Select the file and click "Open". Then click "OK" as shown in below diagram. 

 Two new catalogs are available on the left hand side. 
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 Click "Dashboard" and click on any of the reports to ensure that all the reports are available. 

vi. Steps to restart all services in OBIEE "Enterprise Manager". 

Open the EM OBIEE URL- (http://<ipaddress>:<port>/em) and login with the credentials. 

 Click "coreapplication" link. 

 Click the "Restart" button.
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 Click "Yes" to restart all BI components.

A message is displayed as follows:

 Once restart is done, a confirmation message is displayed as follows:

7. Configure tnsnames.ora file. 

a. Open "tnsnames.ora" file under the folder - <Oracle Home>/network/admin/ folder.

b. Make sure an entry is made in the tnsnames.ora to connect to atomic schema of OFSAA application.
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c. Save the tnsnames.ora file.

8. Configure ODBC data source to connect to Oracle BI Server.

a. Go To Control Panel>Administrative Tools>Data Sources (ODBC).

b. Select the 'System DSN' tab and click 'Add' Button.

c. Select a driver specific to (Oracle BI Server 11g) and click 'Finish' Button.

d. Enter 'Name' and 'Server' details (Specify the Host Name or IP Address of the BI Server and click 'Next').

e. Enter Oracle BI Server login id and password (Enter User Name and Password created at the time of OBIEE 
installation). Click 'Next'.

f. Click 'Finish'.

9. Modify RDBMS connection pool and set the properties.

a. Open the OBI Administration tool.

b. Select Start > Programs > Oracle Business Intelligence > BI Administration.

c. Select File > Open > Online and select 'OFS_PFT_PACK.rpd' file from the Open dialog box.

d. Enter Repository password as 'Admin123'.

e. In the "Physical" layer, double-click the "OFSEFPA Connection Pool" to open its properties.

f. In the 'General' tab, edit/ check the following entries:

i. Call Interface: (OCI 10g/11g).

ii. Data source name: <tnsnames.ora entry created in the step 7.b connecting to OFSAA atomic schema>.

iii. User name: <enter atomic db user name>.

iv. Password: <enter atomic db user password>.

g. Confirm password and Click 'OK' to close the window and click 'Save' to save the RPD file.

h. Click 'No' for the Global Consistency Message.

i. Repeat the steps from 9.f to 9.l to set the connection properties for "OFSEFPA Init Block".

j. Close the RPD file (File / Exit). 

10. In case RPD deployment is done on Essbase then modify ESSBASE connection pool and set the properties.

Note: This is applicable only for EFPA.

a. Open the OBI Administration tool.

b. Select Start > Programs > Oracle Business Intelligence > BI Administration.

c. Select File > Open > Online and select the cube rpd file created as mentioned in the 3rd step (RPD Deployment On 
Essbase Cubes) of section Post-Deployment Activities of OFSEFPA 8.0.5.0.0, from the Open dialog box.

d. Enter Repository password as 'Admin123'.

e. In the "Physical" layer, double-click the "Connection Pool" under Essbase, to open its properties.

f. In the 'General' tab, edit / check the following entries:

i. Call Interface: (Essbase).

ii. Essbase Server: IP Address of Essbase server.

iii. User name: <enter Essbase console user name>.
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iv. Password: <enter Essbase console user password>. g. Confirm password and Click 'OK' to close the window 
and click 'Save' to save the RPD file.

g. Click 'No' for the Global Consistency Message.

h. Close the RPD file (File > Exit).

11. Login into OFSEFPA Application using the URL: http://localhost:9704/analytics. (Replace the port number based on 

your setup). 

12. Once the OBIEE Environment is up and running, the OBIEE url needs to be updated in the table 'AAI_MENU_B' for an 

end user to access the respective Business Intelligence Analytics Application.

Following update statement needs to be executed in the config schema:

UPDATE AAI_MENU_B

SET V_MENU_URL = '<URL>'

WHERE V_MENU_ID IN ('<List of enabled BI Analytical Links for a particular Media Pack 
>')

/

COMMIT

/

For PFT Media Pack as an example:

UPDATE AAI_MENU_B

SET V_MENU_URL = 'http://ofss222798:7001/analytics/'

WHERE V_MENU_ID IN ('OFS_EFPABI_LINK')

/

UPDATE AAI_MENU_B

SET V_MENU_URL = 'http://ofss222799:7001/analytics/'

WHERE V_MENU_ID IN ('OFS_RPABI_LINK','OFS_IPABI_LINK')

/

COMMIT

/

(Replace the IP address and port number based on your setup.)

13. Execute the following in atomic schema to view the T2T mappings in Metadata browser(object view):

declare

result number;

begin

result:=fn_mdb_t2t_view;

dbms_output.put_line(result);

exception

when others then

dbms_output.put_line(SQLERRM);

end;
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Jersey 2.x Package changes in web.xml File

Weblogic 12.2.x will not support jersey 1.x packages, so it is recommended to consider the following changes to those 
customers using Weblogic 12.2.x in their environment:

1. Replace the web.xml entries for Jersey 1.x with jersey 2.x

        Entry for PA Metrics Servlet should be as below:

<<servlet>

<servlet-name>PAMetricsServlet</servlet-name>

<servlet-class>org.glassfish.jersey.servlet.ServletContainer</servlet-class>

<init-param>

<param-name>jersey.config.server.provider.packages</param-name>

<param-value>com.oracle.ofsaa.pa.metric.api</param-value>

</init-param>

<init-param>

<param-name>jersey.config.server.provider.classnames</param-name>

<param-value>com.oracle.ofsaa.pa.metric.api.ProcessJSON</param-value>

</init-param>
</servlet>

2. Replace list of jersey 1.x jars used with jersey 2.x jars and it's dependencies in the following folder:

/../../webapps/ofsaa/WEB-INF/lib

Post-deployment Activities of OFSEFPA v8.0.5.0.0 

The following activities have to be done after installing and deploying OFSEFPA v8.0.5.0.0:

OBIEE Configuration:

1. Evaluate Support Level

Evaluate function is used in filters of many reports. To support the evaluate function in 
reports, the value of EVALUATE_SUPPORT_LEVEL in NQSConfig.INI file of the OBIEE server 
needs to be set as 2. 

Path for 11G

$OBIEEHOME\instances\instance1\config\OracleBIServerComponent\coreapplication_obis1

For 12C

$OBIEEHOME/user_projects/domains/bi/config/fmwconfig/biconfig/OBIS

Changes: Set EVALUATE_SUPPORT_LEVEL = 2 from EVALUATE_SUPPORT_LEVEL = 0; 

2. Session Variable Setting

'ENTITY' by default picks the lowest of Legal Entities in the alphabetical order.

select min(v_entity_name) from dim_org_structure

This query fetches the default legal entity that will be displayed in the obiee reports 
(Legal Entity drop-down) at on load of the report.

Users can also set the default value for Entity, by following these steps:

a. Open the RPD online.
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b. Under Manage Menu go to Variables and select session variable 'ENTITY'.

c. Set the default value in default initialize section with any one of the available entity name from 
DIM_ORG_STRUCTURE table in single quotes. For example: '<Entity Name>'

d. Save and check the global consistency of the RPD.

3. Repository Variable Setting

a. Open the RPD online.

b. Under Manage Menu go to Variables. Set Static Repository variables 'RV_Reporting_Currency' and 
'RV_Base_Currency'.

c. Save and check the global consistency of the RPD.

4. RPD Deployment On Essbase Cubes(Optional)

a. During deployment use "Admin123" as OFS_PFT_PACK.rpd repository password.

b. Deployment of RPD on ESSBASE cubes will be done through an xml patch (EFPA_Cube_Patch.xml). The xml has 
been provided as a part of installation and will be present at $FIC_HOME/ EFPA/repository folder.

c. Provide connection details of RDBMS in 'OFSEFPA Connection Pool' and 'OFSEFPA Init Block'. This is required to 
show LCY Label in the reports, for the legal entity selected in the prompt.

d. The steps to be followed for creating cube related RPD is mentioned in the following procedure:

i. Create a folder “xmlpatch” in your system and copy the EFPA.rpd (Its RDBMS RPD) & EFPA_Cube_Patch.xml 

files.

ii. Open the EFPA Repository (EFPA.rpd) in offline mode.

iii. Give the repository password as “Admin123”.
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iv. Choose “Merge” option from File Menu.

v. On the Merge Repository Wizard screen, choose option as “Patch Repository Merge”.
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vi. Select the Original Master Repository as “EFPA.rpd” from xmlpatch folder by clicking select option.

vii. Give “Admin123” as password for Original repository.
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viii. Select the xml patch file from the saved path (xmlpatch folder).

ix. Give “Admin123” as Patch file password.
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x. Change the name of the merged repository to “EFPA_C1.rpd”.

xi. Click on Next.
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Note: If “Merge Repository Wizard – Define Merge Strategy” window opens up then skip the below steps 
and proceed from “Step: xxiii” onwards. In this case the final Cube Rpd name will be “EFPA_C1.rpd”. 
Otherwise proceed ahead with the below steps.

xii. Check for global consistency by clicking on “Check Global Consistency Ctrl+K” under “File” menu.

xiii. It should result in no errors. Click on “OK” button.
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xiv. In “xmlpatch” folder copy “EFPA_C1.rpd” and paste so that a new duplicate rpd gets created “EFPA_C1 - 
Copy.rpd”.

xv. In the currently opened “EFPA_C1.rpd” click on “Merge…” under “File” menu.
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xvi. On the Merge Repository Wizard screen, choose option as “Patch Repository Merge”.

xvii. Select the Original Master Repository as “EFPA_C1 - Copy.rpd” from xmlpatch folder by clicking select option.
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xviii.Give “Admin123” as password for Original repository.

xix. Select the xml patch file from the saved path (xmlpatch folder).
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xx. Give “Admin123” as Patch file password.

xxi. Change the name of the merged repository to “EFPA_Cube.rpd”.
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xxii. Click on Next.

xxiii.The wizard asks for the confirmation for deletion. Please select option “Current” under Decision dropdown.
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xxiv.Click on Finish.

This creates a merged repository (EFPA_Cube.rpd) under xmlpatch folder.

Take the “EFPA_Cube.rpd” file and deploy it using EM console on the environment where Data is to be fetched from 
ESSBASE Cubes.

Note: Provide connection details of RDBMS in ‘OFSEFPA Connection Pool’ and ‘OFSEFPA Init Block’. This is 
required for LCY Label in the OBIEE reports.

5. OFSAAI Startup

OFSAAI servers need to be restarted, in order to see the transformations in the Post Load 
Transformation screen.

6. Security Roles

Security roles are created in OBIEE to allow or disallow certain users to see selective 
dashboards and data. To accomplish these user roles can be created in OBIEE. This step is 
optional and the procedure to create user roles is mentioned below (in this procedure LoB 
stands for Line of Business): 

a. Open Admin Console of OBIEE.

b. Click on Security Realms under Domain Structure.
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c. Click on myrealm under Realms.

d. Click on ‘User and Groups’ and then on ‘Groups’.
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e. Click on ‘New’ and create two new groups with the names ‘Business Analyst’ and ‘LoBManager’.

f. Click on newly created ‘Business Analyst’ group for assigning parent group.
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g. Create two new users under ‘Users’ tab of ‘Users and Groups’. One user for Business Analyst and another for LoB 
Manager.
Oracle Financial Services Profitability Management Application Pack Installation Guide 307



Deploying the Application
Appendix M—Post Deployment Configuration
h. Map the newly created users to respective groups.

i. Close the Admin Console of OBIEE.

j. Open Enterprise Manager of OBIEE.

k. Navigate to CoreApplication > Security > Singe Sign On > Configure and Manage Application Roles.
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l. Create a new application roles with the name ‘Business Analyst Role’ with display name as ‘Business Analyst Role’ 
and ‘LoBManager’ with display name as ‘LoB Manager Role’.

m. Assign Business Analyst Group to its role and similarly ‘LoB Manager’ group to its respective role.
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n. Unarchive the catalogs by selecting ACL as ‘Preserve’.

o. After un-archiving the catalogs (Financial Reporting.catalog & Management Reporting.catalog) configure the 
physical tables in database PFTBI_USER_LOB_MAP to create LoB Manager and LoB mapping.

p. Step 16: Login with corresponding LoB Manager User Id to verify if the respective LoBs are being selected. To 
verify all the reports, login with Business Analyst user id.
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Metadata Browser Batches:

UMM Metadata (Hierarchies, Datasets, Measures, Dimensions) can be seen in Metadata Browser by executing the 
Metadata Browser Batches (MDB batches) from the Batch Execution screen of OFSAAI. The batch names are mentioned 
below: 

1. <INFODOM>_MDB

2. <INFODOM>_MDB_OBJECT_APPLN_MAP

Additional Configuration:

1. After deploying the latest Web catalog and RPD from the server, the default reporting periods have to be set based on 

users requirements. The default value has to be set at the Reporting Period prompts by editing the dashboard and 

choosing a specific value for the reporting period prompt. Following are the dashboard pages where the default time 

period is to be selected: 

a. Financial Reporting>Income Statement>Time_Hierarchy Prompt

b. Management Reporting>Balance Sheet> Time Hierarchy Prompt

c. Management Reporting>FTP Reports> Time Hierarchy FTP Prompt

d. Management Reporting>Income Statement> Time Hierarchy Prompt

e. Management Reporting>Key Trends>Time Hierarchy Prompt

f. Management Reporting>KeyTrends>Balance Trends> Time_Hierarchy_Month Prompt

g. Management Reporting > Performance Measures> Time Hierarchy Prompt

2. Create an entry in Setup_Master table to configure the identity codes that are required for Financial Reporting 

dashboard reports.

V_COMPONENT_DESC as "IDENTITY_CODE_PFTBI_FR_UNALLOCATED_DATA" having Identity Code value 
in V_COMPONENT_CODE and V_COMPONENT_VALUE columns.

3. If OFSEFPA 6.1.1.0.0 is deployed on Oracle ESSBASE Cubes, then the hierarchies would need to be resaved in the 

Business Hierarchy link of OFSAAI. Subsequently, rebuild the Oracle ESSBASE Cubes.

Instrument Table Validation

Run the Instrument Table Validation. For more information, see the Doc ID 1457511.1 and Data Model Utility Guide.

Check the FSI_MESSAGE_LOG file after running Instrument Table Validation to verify that tables are classified correctly.
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Logging as System Administrator

Post installation, the first login into Infrastructure is possible only for a System Administrator through user id "sysadmn". 
This ID is created at the time of installation with the password provided during installation. Enter login id "sysadmn" and 
password that was provided during installation. Click Login.

System Administrator

System Administration refers to a process of managing, configuring, and maintaining confidential data in a multi-user 
computing environment. System Administration in Security Management involves creating functions, roles, and mapping 
functions to specific roles. System Administration also involves maintaining segment information, holiday list, and 
restricted passwords to ensure security within the Infrastructure system.

You can access System Administrator in LHS menu of Security Management. The options available under System 
Administrator are:

 Function Maintenance

 Role Maintenance

 Segment Maintenance

 Holiday Maintenance

 Restricted Passwords

Function Maintenance

A function in the Infrastructure system defines the privileges to access modules or components and to define or modify 
Metadata information associated. Function Maintenance allows you to create functions for users to ensure only those 
functions are executed which are specific to the user's role.

You can access Function Maintenance by expanding System Administrator section within the tree structure of LHS menu. 
The Function Maintenance window displays the function details such as Function Code, Function Name, Description, and 
the number of Roles Mapped to the function. The Function Maintenance window also facilitates you to view, create, 
modify, and delete functions within the system.

You can also make use of Search and Pagination options to search for a specific function or view the list of existing 
functions within the system.

Role Maintenance 

A role in the Infrastructure system is a collection of functions defined for a set of users to execute a specific task. You can 
create roles based on the group of functions to which users are mapped. 

You can access Role Maintenance by expanding System Administrator section within the tree structure of LHS menu. The 
Role Maintenance window displays the role details such as Role Code, Role Name, Role Description, and the number of 
Users Mapped to the role. The Role Maintenance window also facilitates you to view, create, modify, and delete roles 
within the system. 

You can also make use of Search and Pagination options to search for a specific role or view the list of existing roles within 
the system.

Segment Maintenance

Segment is used to control access rights on a defined list of objects. It is mapped to an information domain. 

Segment Maintenance in the Infrastructure system facilitates you to create segments and assign access rights. You can 
have different segments for different Information Domains or same segments for different Information Domains. 
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User scope is controlled by segment/ folder types with which the object is associated. 

 Objects contained in a public folder will be displayed irrespective of any user. 

 Objects contained in a shared folder will be displayed if user belongs to a user group which is mapped to an access 
type role with the corresponding folder. 

 Objects contained in a private folder will be displayed only to the associated owner. 
You can access Segment Maintenance by expanding System Administrator section within the tree structure of LHS menu. 
The Segment Maintenance window displays a list of available segments with details such Domain, Segment Code, 
Segment Name, Segment Description, Segment/Folder Type, Owner Code, and the number of Users Mapped to the 
segment. You can view, create, modify, and delete segments within the Segment Maintenance window. 

You can also make use of Search and Pagination options to search for a specific role or view the list of existing roles within 
the system.

Holiday Maintenance

Note: As part of OFSAAI 7.3.3.0.0 release, this feature will not be available if Authentication is configured to 
SSO Authentication and SMS Authorization.

Holiday Maintenance facilitates you to create and maintain a schedule of holidays or non-working days within the 
Infrastructure system. On a holiday, you can provide access to the required users and restrict all others from accessing the 
system from the User Maintenance window.

You can access Holiday Maintenance by expanding System Administrator section within the tree structure of LHS menu. 
The Holiday Maintenance window displays a list of holidays in ascending order. In the Holiday Maintenance window you 
can create and delete holidays.

Restricted Passwords

Note: As part of OFSAAI 7.3.3.0.0 release, this feature will not be available if Authentication Type is selected 
as SSO Authentication and SMS Authorization from System Configuration> Configuration.

Restricted Passwords facilitates you to add and store a list of passwords using which users are not permitted to access the 
Infrastructure system. 

You can access Restricted Passwords by expanding System Administrator section within the tree structure of LHS menu. 
The Restricted Passwords window displays a list of restricted passwords and allows you to add and delete passwords from 
the list. 

You can also make use of Search and Pagination options to search for a specific password or view the list of existing 
passwords within the system. For more information, refer Pagination and Search & Filter.

Note: While searching for any pre defined restricted password, you have to key in the entire password.
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Creating Application Users

Create the application users in the OFSAA setup prior to use. 

Note: This step may not be required if you have already setup users in the OFSAA setup.

For more information refer user creation section from the Oracle Financial Services Analytical Applications Infrastructure 
User Guide.

Mapping Application User(s) to User Group

Starting the OFSAA 8.0 release, with installation of Profitability Application Pack, pre-configured application user groups 
are seeded. These user groups are unique to every OFSAA Application Pack and have application roles pre-configured.

Map the application user(s) to the respective Application User Group(s) and subsequently authorize the entitlements by 
logging in as SYSAUTH (System Authorizer) user.

For more information on seeded User Groups, refer to User Group Mapping.

Change ICC Batch Ownership

All the seeded Batches in PFT Applications Pack will be automatically assigned to SYSADMN user during Installation. If one 
user who wants to see the Batches in Batch Maintenance Menu, He needs to execute the following Queries in Config 
Schema of the Database. 

Syntax: 

begin 

AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP ('fromUser','toUser','infodom'); 

end; 

OR 

begin 

AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP ('fromuser','touser'); 

end; 

Where from User indicates the user who currently owns the batch, to User indicated the user 
to which the ownership has to be transferred. Infodom is optional parameter, if specified 
the ownership of batches pertaining to that Infodom will be changed. 

Eg. 

begin 

AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP ('SYSADMN','PFTOP','OFSPFTINFO'); 

end;
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Mapping ICC Batch Execution Rights to User

Login as SYSADMN and navigate to Identity Management > System Administrator > Function-Role Map. Map the 
User-Batch Execution Mapping Screen function to RLPFTADMIN role.

Now any user who is mapped under PFT Admin User Group will have the access to the Batch execution rights Menu under 
Operations list.
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Saving Post- Load Change Transformations

After creating users, Login to Infrastructure as any user who is mapped to PFT Admin or PFT Analyst group. Navigate to 
Data Management Framework >> Post Load Changes.

A New window will be displayed. Click on Each Transformation from Transformations List & Click on Stored Procedure in 
the Right Panel, Click on Edit in the Top Right Menu and Click on Finish Button in Bottom.

Note: All the Transformation Stored Procedures are required to be edited and saved (Finish Button) once for 
getting it is available.
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